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About this Training
Intended audience: any user who will use FARO CAM2 Q

Length of Training: Three (3) days

Structure: Modules and Lessons.

The training does not intend to cover every menu item of CAM2 Q. We have 
taken the most common applications of CAM2 Q and developed a training 
program that teaches you core principles, measuring strategies, and tips in 
a hands-on training format. Our intent is for this training to provide a strong 
foundation for you to start using your FARO system in your environment. 
Additionally, it will prepare you to learn more advanced features of the 
software.

Definition of Terms and styles: 

 ## Information and tips

Caution and Warning statements

   General information

Bold Italic Text Indicates directory names, menu names, buttons, 
tabs, key names, acronyms, and modes.

Monospaced Text Indicates alpha/numeric characters or values you 
enter in a field on the screen. For example, “Type 
0.005 for the tolerance setting.”
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Module 1: 
Measurement System Overview

In this module, you will become familiar with how the FARO measurement device and 
CAM2 Q software interact with one another to provide accurate 3D measurements. 

Module XX Objectives
You will be able to:

Set up the FARO measurement devicezz
Navigate the CAM2 Q user interface zz
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Lesson 1: Getting Started
Setting up the Laser Tracker

The Laser Tracker head ships in a storage container by itself. The Master 
Control Unit (MCU), cables, Spherically Mounted Retroreflector (SMR), tooling, 
and mounting hardware ship in a second storage container.

The Laser Tracker mounts on an instrument stand in either the vertical or the 
horizontal positions. The Laser Tracker operates in any orientation.

To setup the Laser Tracker, follow these steps:

Place the instrument stand on a stable floor surface, away from 1.	
obstructions.  Ensure that the instrument stand rests on its adjusting 
pins.

Tighten the quick release mandrel to the instrument stand using the 2.	
supplied spanner wrench.

It is not recommended to place the Tracker on a stand that is tilted more 

than 10° from vertical.

Grasp the front handles of the Laser Tracker and remove the Laser 3.	
Tracker from the container.

Place the Laser Tracker on the instrument stand by means of the 4.	
mandrel mount inserted into the Laser Tracker base.

5.	 Turn the locking lever clockwise (when viewed from above) by hand 
until it is tight. The Laser Tracker locks in position.

6.	 Connect the air temperature sensor to the MCU.

Connect the communication cable to the socket on the back of the 7.	
Laser Tracker and to the socket on the left side panel of the MCU.

Connecting the Computer 

To connect the computer: 

Plug the port lock into any USB port (this authorizes CAM2 Q to 1.	
operate). This is not necessary if you have a printed license key. 

Connect the computer to the MCU using the Ethernet cable.2.	

Connect the power cord into the MCU and then connect to the power 3.	
source.

4.	 Apply power to the Laser Tracker by turning on the switch at the right 
side of the MCU.

When used in ##
conjunction with the Tracker Side 

Mount Fixture (optional accessory), the 

Quick Release Mandrel Mount holds 

the Laser Tracker in the upright vertical 

position or in the horizontal position. 

When mounting the Laser Tracker 

upside down, screw it directly into a 

mounting fixture.

Never grasp the beam ##
steering assembly of the Laser Tracker 

as this can cause damage.

Additional air ##
temperature sensors may be used to 

calculate an average temperature.

Make the connection in ##
this order to ensure not to damage the 

machine.
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Smart Warm-up

Immediately after applying power to your Laser Tracker, it starts performing 
a “Smart Warm-up”. The blue light on the front of the Laser Tracker blinks and 
the Azimuth and Zenith motors turn on until the Laser Tracker reaches the 
correct temperature, which relates to the ambient temperature.

After the motors raise the temperatures of the Laser Tracker, they shut off. 
The Laser Tracker spends 5 minutes allowing the internal temperature to 
equilibrate.

When the process completes, the blue light on the front of the Laser Tracker 
stops blinking and you can initialize the Laser Tracker using the Startup 
Checks.

Powering Down

Follow these steps to power down the Laser Tracker:

Exit CAM2® Q.1.	

Store the SMR and/or any other targets in their protective cases.2.	

Power down the Laser Tracker using the switch on the right side of 3.	
the MCU and disconnect the power cable from outlet.

Disconnect the communication cable from the socket on the back of 4.	
the Laser Tracker and from the socket on the side of the MCU.

Disconnect the air temperature sensor from the MCU.5.	

Disconnect the CAT5 100 MHz RJ-45 cable from the side of the MCU 6.	
and the computer.

Loosen the locking lever on the mount and carefully remove the 7.	
Laser Tracker head from the stand by grasping its handles, and store it 
in the Laser Tracker head container.

Opening CAM2 Q 

CAM2 Q may be opened using any of the following methods: 

Double left-click the zz Q icon on the Desktop; or 

Click the zz Start button, point to Programs, point to FARO, and then 
click CAM2 Q; or 

Double left-click any previously saved CAM2 Q file. zz

User Profile 

The very first time you start CAM2 you must choose a default profile. User 
profiles contain custom screen layout settings. You can change the default 
profile any time. On the Edit menu, select User Profiles.

A Laser Tracker that ##
you store in an air-conditioned 

environment and bring out to a hot 

environment, takes longer to warm-up 

than a Laser Tracker that you store in 

the hot environment to begin with.

While you can take ##
measurements immediately after 

initializing the Laser Tracker, it may 

take up to one hour for complete 

temperature equilibrium in a thermally 

stable environment. If you need to 

take measurements immediately, 

check the Backsights, using CompIT, 

after the Laser Tracker has been on for 

one hour.
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Device Control Panel

The FARO Device Control Panel shows the connected device information:

The elements of the FARO Laser Tracker Device Control Panel are: 
Add New Device zz
Selected Device zz
SMR information: zz

Current SMR ��
Current Tooling ��
Change SMR and Tooling ��

Tracker Controls: zz
Distance Mode ��
Samples Per Reading setting ��
Home ��
CompIT ��
TrackerPad ��
Drive Beam ��
Motor (On/Off) control ��
Settings ��
Environment Check ��
Disconnect ��

To open the panel, click Device Control Panel on the Device menu. or press 
the P hot key.  You can close this panel by clicking the X in the upper right 
corner of the panel.

  p
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Lesson 2: CAM2 Q Overview

Feature-Based Measurement 
CAM2 Q is feature-based measurement software. A feature is a geometric 
attribute or element of a part. You can directly measure some features (e.g. a 
circle, sphere, cylinder); others you cannot directly measure easily, accurately 
or repeatedly (e.g. an angle, bolt hole circle, length), and as a result you must 
construct or dimension them from elements that you can directly measure. 
CAM2 Q enables direct measurement, constructions, and dimensions. The 
Measure, Construct, and Dimension menus reflect these capabilities.  

Features you can directly 
measure

Features that you must 
construct
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Commands in CAM2 Q – Methods to Access

Commands in CAM2 Q can be accessed either by menus or toolbar buttons.  

    Ë
Screen Layout

Main Window 

This area of the CAM2 Q screen shows your coordinate system, the results 
of your measurements, and any imported CAD files. When you first view 
the screen, there is an XYZ axis representing the three dimensions, which 
uniquely identifies the locations of points you collect. 

You can access many ##
commands using hot keys, which are a 

single keystroke method of choosing a 

command or accessing a panel. There 

is a list of all hot keys in the Appendix 

for your convenience. 
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Pull-Down Menus 

The menu commands at the top of the screen, File, Edit, View, Measure, Key 
In, Pick from CAD, Construct, Dimension, etc. are pull-down menus which 
contain a variety of commands. 

Control Panels

Control Panels are fields that you can bring to the front of the screen 
containing a variety of information. CAM2 Q includes many panels.

On the View menu, click Panels. The following panels are the most common 
panels you will use in this training. 

Features: Displays the list of features you Measure, Key 
In, Pick from CAD, Construct or Dimension 

Tolerances: Displays the tolerances and nominals you 
input for specific features

Readings: Displays the results for features you have 
measured

Feature Creator: Enables you to select the features you want to 
measure immediately or at a later time

QuickTools: Enables you to record, edit, and play a part 
inspection program

Some of these Control Panels are attached to the screen boundaries and are 
in “Auto Hide” mode. Look for a tab with the title of the Control Panel and 
click it to show that Control Panel. The Control Panel remains visible for a 
short time and automatically collapse back to the tab as you move to another 
area of the screen. 

Click the AUTO HIDE button  in the upper right corner of the panel to 
keep the bar visible.

Click the CLOSE button  in the upper right corner to close a panel.
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Features Panel 

CAM2 Q provides a Features panel that shows all the features you measure, 
construct, or import with a CAD model. In this panel, the features are listed in 
chronological order of their creation. 

Tolerances Panel 

Click the Tolerances tab at the bottom of the screen to show the Tolerances 
panel. CAM2 Q provides a Tolerances panel that shows tolerance values for 
an individual, or selected group, of features. You can choose which value of a 
feature to tolerance and edit the tolerance values.
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Readings Panel 

Click the Readings tab at the bottom of the screen to show the Readings 
panel. CAM2 Q provides a Readings panel that shows a list of measurement 
reading and properties for a selected feature. 

Feature Creator Panel 

Click the Feature Creator tab at the right of the screen to show the Feature 
Creator panel. CAM2 Q provides a Feature Creator panel that shows  feature 
creation commands grouped by Measure, Key In, Pick From CAD, Construct, 
Dimension, and Tracker headings. This panel provides a quick method for 
creating features without using the menu commands. 

These are the key elements of the CAM2 Q screen layout. This workbook 
guides you through the most commonly used menu items and commands 
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and prepares you to explore the full capabilities of the CAM2 Q software 
using the Help menu.

Customizing the Panels Layout 

You can change the position of the panels on the screen. To move a panel, 
left-click and hold the title bar of any of the panels and drag the panel with 
the mouse. Once you start dragging a panel, the screen prompts you with 
icons to show where you can place the panel.  

Creating a User Profile (Saving a Customized Screen Layout) 

You can easily save a particular screen layout so you can easily recall it. Follow 
the instructions below: 

On the 1.	 Edit menu, click Profile.

When the 2.	 User Profile Selection dialog box appears,  
click Save New Profile.

Name your profile and click 3.	 Close.

This saves your current screen as a User Profile. You can save any number of 
user profiles. For example, you can have many users, each with their own user 
profile, using the same computer. This can save time because each user does 
not have to setup the screen layout each time CAM2 Q opens.

 Selecting/Activating a New User Profile 

To select and activate a saved User Profile, click 1.	 Profile on the Edit 
menu.

From the 2.	 User Profile Selection dialog box, select the User Profile 
you want to load, and then click Load Profile.
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CAM2 Q Help File

The CAM2 Q Help file is the first place you can look for information.

On the zz Help menu, select Contents.

Use the zz Contents, Index and Search tabs, on the left side of the 
window, to navigate around the file and select and search for topics.

Each time you receive an update to CAM2 Q, you should view the zz
What is New topic. This topic describes new functions and commands 
that have been added to CAM2 Q, as well as the enhancements made 
to existing commands. The What is New topic is located at the end of 
Chapter 1: Introduction to CAM2 Q. 
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Module 2: 
Measurement Considerations

Before you start measuring, you have to make sure outside factors such as 
temperature, vibrations, and mounting instability do not compromise your data.  

You will be able to prove that your Tracker is accurate by checking the environment 
and performing any necessary compensation. In this module, you will learn how 
to compensate for environmental factors and prepare for measurement to get the 
accurate data that you need.

Module XX Objective	
You will be able to:

Evaluate the environmental variables that impact measurement accuracy and take zz
the appropriate steps to avoid, minimize, or correct the impact.
Run the CompIT program to fully prepare the Laser Tracker for measurement.zz
Verify and improve as necessary the angular component of the Laser Tracker’s zz
accuracy.
Verify and improve as necessary the laser measurement component of the Laser zz
Tracker’s accuracy.
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In addition to the calibration accuracy of your device, environmental factors 
play a major role in the accuracy of your measurements.

Lesson 1: Environment

Temperature Effect On a Part

Changes in temperature may cause a part to expand or contract, affecting 
measurement accuracy. 

�Environment vs. Part Temperature:  If the part is warmer or cooler than the 
surrounding environment, it will expand or contract while being measured. 
Measurements taken earlier may not equal measurements taken later. To 
minimize the impact of air temperature on the part:

Let a part “soak” in the inspection environment to adjust to the air zz
temperature prior to taking measurements. Generally, the larger the 
part, the longer it will take to adjust.

Avoid taking measurements where the air temperature will vary zz
widely; e.g. don’t take measurements where doors will be opened to 
warmer or cooler air (near a furnace, garage door, etc.)

Software Temperature Compensation:  CAM2 Q can compensate for the 
temperature of a part. The ability to scale for temperature allows you to 
measure parts adjusting for thermal expansion or contraction. For details on 
how to do this, look in the CAM2 Q Help for Material Temperature.

Environment vs. Device Temperature:  Changes in room temperature affect 
the Laser Tracker. As the temperature changes, mechanical components 
inside the Laser Tracker change size. A minute difference inside the Laser 
Tracker can be a significant error at range.

�To avoid this:

As described above, avoid places where there will tend to be wide zz
temperature variations. 

Always let the Laser Tracker temperature stabilize before taking zz
measurements. 

�Light: Light, especially sunlight, generates heat. When exposed to light 
unevenly, a large part can heat up and expand or contract unevenly. To 
ensure accurate readings, make sure the part you are measuring has even 
exposure to light.

Movement

Movement always affects accuracy. Movement resulting in no change in 
the Laser Tracker position relative to the part will have the least impact 
on measurement accuracy. To avoid the impact of movement choose a 
measurement spot where the part and device can be fastened and stationary.
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Vibration Effects

Vibration can cause inaccuracies. People putting heavy parts on your surface 
plate, forklifts driving by, and stamping machines are some of the causes of 
vibration. Significant vibrations will also affect the tracking of the SMR.

Mounting Stability

Mounting stability is key to accurate measurement.

Tripods

FARO sells two types of tripods: Folding and Brunson. While tripods provide 
mobility and allow multiple device positions, you must be careful to ensure 
mounting stability. For detailed instructions, refer to the manual that came 
with the tripod you purchased.

Magnetic Mount

The Magnetic Mount is another portable option when mounting to most 
metal surfaces. To ensure proper mounting with the Magnetic Mount, follow 
the detailed instructions provided with the mount. 

Side Mount

The side mounting bracket should be used whenever mounting the Laser 
Tracker in a horizontal position.

Part Mounting for Measurement

Support the part in the same manner for measurement as its intended 
function. This ensures that the part experiences the same stress when it is 
measured as when it is in use.

For high accuracy measurements:

Power up the Laser Tracker in the environment before measuring zz
and allow it to reach thermal stability in the local environmental 
conditions. 

Use redundant readings for each measurement. This accomplishes zz
three things:

it highlights extreme errors in measuring;��

in some cases it reduces the environmental effects that you have ��
not been able to eliminate, and

it provides better statistical sampling.��

For safety reasons, do not ##
mount the Laser Tracker to a stand that 

is tilted more than 10° from vertical.
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Thermal Gradients

Thermal gradients, air turbulence, and air pockets in the path of the laser 
beam will affect the direction of the laser beam and cause errors in the 
angular measurements. Avoid these errors by measuring away from heating 
and air conditioning ducts or any other source of these thermal effects.

User Precautions

Here are some techniques for avoiding bad measurements:

Place the SMR in magnetic nests gently.  If you can hear the target snap zz
into place, you’re not being gentle enough. 

Don’t touch the collar of the SMR with your hand, and definitely don’t zz
touch the mirror surfaces! 

Don’t allow the collar of the SMR to come into contact with the nest. zz

Keep the roll angle of the SMR constant for all measurements in a test.  zz
Pick a mark on the collar and keep it pointing up. 

Make sure the reflective surfaces of the SMR are clean. zz

Make sure that you are using the correct SMR for the test you are running.  zz
Different tests require different SMR characteristics. 

Make sure that magnetic nests have no dirt or debris in them. zz

After placing the SMR in a nest, twist it back and forth slightly a couple of zz
times.   If there is any dirt between the SMR and the nest, this will move it 
out of the way.  

Don’t leave the SMR at the home position (TMR) for any length of time.  zz
We don’t want the SMR to heat up, which causes a measurable change in 
the measured distance. 
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In addition to monitoring the environment and mounting the device 
securely, proper periodic field compensation ensures Laser Tracker accuracy. 
The Laser Tracker’s built in program, CompIT, makes field compensation quick 
and simple.

Lesson 2: Device

Evaluating Environmental Stability

Operational Checks

The Operational Checks determine the operating condition of the Laser 
Tracker and verify that environmental factors such as air movement and 
vibration will not degrade measurement accuracy.

When to Perform Operational Checks

Run these checks:

After the Laser Tracker has been moved to a new operating zz
environment, 

If the current operating environment changes substantially. zz

To start the Operational Checks, open the Device Control Panel and click the 
Environment Check button. 

General Page

View the Weather information and verify the SMR Return Power on the 
General Page tab of the Operational Checks dialog box. Use the Save and 
Save As buttons to save the test results to an ASCII text file. This will provide a 
record of the environment at the time you take the measurements.

Weather

View the temperature, pressure, and humidity of the measuring environment. 
An icon indicates the source of the reading:

Lightning Bolt:zz  the reading originates from the Laser Tracker’s  
internal sensors.

Pencil: zz the reading has been manually entered.

The Static Repeatability ##
Test indicates the stability of the 

environment.

A dirty SMR is the ##
most common cause for low SMR 

return Power. If the intensity displays 

as MARGINAL or BAD, clean the 

SMR according to manufacturer’s 

instructions and re-run the test. If the 

intensity continues to read MARGINAL 

or BAD, try another SMR.
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Target Return Intensity

The SMR Return Power value is the measure of the laser intensity as it returns 
to the Laser Tracker from an SMR. 

Repeatability Page (Click the tab to get to the page)

The Position Monitor section shows the real time position of the target 
expressed in the Laser Tracker’s spherical coordinate system: Azimuth 
angle (Az), Zenith angle (Ze), and Radial distance (D). The “dT” value shows 
the variation between the most recent measurement and the established 
baseline measurement.

The Tests section contains buttons to activate one of the three repeatability 
tests, Closure, Static, and Dynamic.

The Tests show the distance measurement, “D”, and encoders, and indicate 
the level of repeatability of the Laser Tracker measurements.  

The Start Test and Measure buttons are used to carry out the specific tests, 
while the Home button must be used to reset the laser should a beam break 
occur.

Static Repeatability

The Static Repeatability check determines whether the Laser Tracker can 
repeat the measured position of the SMR in a fixed position. The SMR remains 
at the reference position and does not move at all during the test. 

The repeatability of ##
the measurements depends on 

the mounting of the Laser Tracker, 

the stability of the Target, and the 

environment.

This check is critical ##
for determining whether the Laser 

Tracker, part, and drift points are 

stable. (A drift point is a reference point 

used to monitor the relative position 

between the part and the Laser 

Tracker. Normally a set of points is 

identified using magnetic nests glued 

to the part.) 
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ACTIVITY:  Environment Checks

For this activity, you will perform an environmental check.

Target Return Intensity Check 
Start1.	  Environment 
Check

Click the Environment Check button in the Device 
Control Panel. 

Select Target Type2.	 On the Operational Checks dialog box, click Set 
Target Type.

Select SMR3.	 Select the appropriate SMR.
Accept SMR4.	 Click OK.
Measure Intensity at 5.	
the Home position

Place the SMR at the Home position (Tracker 
Mounted Reset or TMR) on the Laser Tracker and 
click Home. Intensity will show as:

GOODzz

MARGINALzz

BADzz

If the intensity shows as MARGINAL or BAD, it is indicating the SMR may 
need cleaning. Follow the instruction in the 922-01933 Optical Target Care 
Guide and retry the test. 

Repeatability Checks

Repeatability1.	  tab In the Operational Checks dialog box, select the 
Repeatability tab.

The Tests & Detailed Results section appears the results of each test in detail.
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Static Repeatability Check

SMR to home position1.	 Place the SMR in the home position 
(Tracker Mounted Reset or TMR).

Laser to home position2.	 From the Repeatability tab of the 
Operational Checks dialog box, click the 
Home button to reset the laser.

Set a reference position3.	 Set a reference position for the test:

Position the tripod or an available nest zz
at a distance from the Laser Tracker 
that approximates the distance of the 
part you will be measuring. (Angular 
position is not critical to this check.)

SMR to reference position4.	 Remove the SMR from the home position 
and move it to the reference position.

Start the test5.	 Click on Start Test. 

Click zz OK when prompted for a time 
delay between measurements.

The Laser Tracker first measures the reference position, then after the time 
delay, measures the reference position again. Allow the Laser Tracker to 
collect (10) measurements for about 30 seconds. (As the measurements are 
taken, they appear in the Test and Detailed Results section.

Stop the Test6.	 Click Stop Test and review the results.

Look at the zz 3D values in the Test 
Results section. The total error should 
be less than what is acceptable for the 
part you are measuring.

Analyze the total error7.	 If the total error is greater than what is 
acceptable, repeat this check at two other 
locations.

If the total error is consistently greater ☛☛
than acceptable, check the Laser Tracker 
mounting; mandrel tightness; and stand, 
tripod and target nest to ensure all are 
stable. Additionally, check the area for 
temperature gradients. Air handlers, 
machinery and sunlight can cause these. 
Eliminate the sources of the temperature 
gradients and try the test again. If 
you cannot remove the temperature 
gradients, use higher sampling in 
the application software to reduce 
repeatability issues due to environmental 
effects.



08m13e15 - CAM2 Q v1.5 - FARO Laser Tracker Training Workbook - October 2010.pdf  Part# 12053-001

2 . 1 1

M
o

d
u

l
e

 
2

:
M

e
a

s
u

r
e

m
e

n
t

 
C

o
n

s
i

d
e

r
a

t
i

o
n

s 

Optional Steps

Remove any results1.	 Click the Clear button to remove any 
results, in case you want to re-run the 
check.

Save results2.	 Use the Save and Save As buttons to save 
the results to a text file in the location of 
your choice in case it is needed later.

Close3.	 Click Close.

Following the Checks

The Static Repeatability check, verifies stability of the environment. To verify the Laser 
Tracker accuracy, complete Angular Accuracy Checks and Self Compensation (if 
necessary) and prior to any measurement session.

Validating System Accuracy – CompIT

CompIT is a toolkit which includes a series of tests to validate the Laser 
Tracker system’s Angular Accuracy and Distance Accuracy.

Angular Accuracyzz , one of two components of Laser Tracker 
accuracy, describes how accurately the Laser Tracker measures the 
horizontal and vertical angles from the Laser Tracker to the point 
being measured.

Distance Accuracyzz , the second component of Laser Tracker 
accuracy, describes how accurately the Laser Tracker measures the 
distance to the point being measured.

To start the CompIT, open the Device Control Panel and click the CompIT 
button. 

Standard Tab

The Standard tab of the CompIT dialog box contains the two most 
frequently used functions: Angular Accuracy Checks and Self 
Compensation.

Clicking the Angular Accuracy Checks button starts the Angular Accuracy 
test. 

Clicking the Self Compensation button: starts the Self Compensation test. 
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Angular Accuracy Checks

These checks should be performed:

After initializing the Laser Tracker;zz

Before each measurement session;zz

If the temperature has changed more than 5˚ Fahrenheit. zz

You can perform Angular Accuracy checks during a measurement session to 
verify the Laser Tracker’s accuracy.

If necessary, CompIT will guide you to use a Self Compensation procedure to 
maintain Laser Tracker Accuracy.

ACTIVITY:  Angular Accuracy Checks

For this activity, you will perform an angular accuracy check.

Start 1.	 CompIT Click the CompIT button in the Device Control 
Panel. (Be patient—the Laser Tracker is loading the 
CompIT program)

SMR to Home2.	 Place the SMR in the Home position

Choose 3.	 Angular 
Accuracy 
Checks

In the CompIT dialog box, click Angular Accuracy 
Checks. The Select Mode dialog box appears.

User Selected 4.	
Points

Click User Selected Points.

Move SMR5.	 Click OK. CompIT prompts you to move the SMR to a 
specific location. 

If “User selected points” is checked, CompIT ☛☛
prompts you to move the SMR to any location at a 
distance approximating the distance at which you 
will be taking measurements. 
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Once the SMR is in the correct location, CompIT automatically monitors the 
target for stability. 

Once the target is stable, CompIT measures the SMR and calculates the 
Angular Accuracy

Move SMR 6.	
to two more 
locations

As prompted by CompIT, move the SMR to two more 
locations and allow CompIT to calculate the Angular 
Accuracy.

Review Results7.	 After three measurements, click Continue.
End the angular 8.	
accuracy check

Click Done.

Depending on the stability of the environment, this ☛☛
Angular Accuracy test should be performed at the 
beginning of each day and every 3-4 hours during 
the day to determine continued accuracy.
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Compensation Routines

There are two compensation routines, the Self Compensation routine and 
the Pointing Compensation routing. 

The Self Compensation routine, which ensures that the Laser Tracker meets 
specifications throughout its full measurement range, is what you will use for 
most applications. It is an automatic process that enables the Laser Tracker to 
guide itself through a compensation process. This takes about five minutes.

The Pointing Compensation routine, which takes five to 10 minutes, requires 
your active involvement and includes two parts: The Pointing Interim Test, 
a preliminary check of the deviations around the Laser Tracker’s working 
volume; The Pointing Compensation, a procedure to improve the deviations. 
Run this routine in place of the Self Compensation routine for applications 
that require long range (20 plus meters) measurement and the highest 
possible accuracy. Pointing Compensation is divided into two parts.

Use these routines at the beginning of a measurement session—or—if 
the Angle Accuracy Check indicates a change in the accuracy value. If 
compensations are run during the course of a measurement session a device 
position is required before measurement continues.

The results of the ##
Pointing Interim Test determine 

whether the Standard Pointing 

Compensation starts.
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ACTIVITY  Self Compensation

For this activity, you will perform a self compensation.

Start 1.	 Self 
Compensation

In the CompIT dialog box, click Self Compensation. 
CompIT begins an automatic Self Compensation 
routine.

After completing the routine, the results display in the Self Compensation 
Results dialog box.

Results2.	 Click Details to display detailed results.
Update3.	  Click Update to save the results to the Laser Tracker.

If you do not click the Update button, the ☛☛
parameters will not update.

Quit 4.	 Self 
Compensation

Click Done to exit the Self Compensation routine.

Save a Report5.	 Click Report to create a text file, which you can save 
and/or print.
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Compare 6.	
Results

Click the Self Compensation tab to view the Before, 
After, and Change in parameters.

After completing the Self Compensation you will be prompted to run the 
Angular Accuracy Checks. This is to verify that the Angular Accuracy now 
falls within acceptable parameters.

Run 7.	 Angular 
Accuracy 
Checks

Click Yes to run the Angular Accuracy Checks. (For 
information on how to complete, see the Angular 
Accuracy Checks section, above) 

Pointing Compensation

Select 1.	
Advanced tab

Click the Advanced tab in the main CompIT dialog 
box,

Pointing 2.	
Compensation

Click the Pointing Compensation button.

 
CompIT prompts you to move the SMR to the home position, and then to 
various default positions.

Set up nest3.	 Set up a nest on a tripod at the height and distance 
provided on the screen prompt.
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Track SMR to 4.	
nest

Track the SMR to the nest and place it there. The height 
and distance values should be green.

Rotate Laser 5.	
Tracker

Rotate the Laser Tracker on the mandrel mount to 
adjust the Azimuth angle to the target until the value 
is green.

Once the SMR is in the correct location, CompIT automatically monitors 
the target for stability. After five seconds of stability, the Laser Tracker will 
measure the SMR and calculate the Angular Accuracy.

If the SMR does not stabilize within 60 seconds, an error appears. If this ☛☛
happens, ensure the stability of the SMR and that the mandrel is tight, then 
retry. 

The numbers below Desired value are the target values for Azimuth, Zenith, 
and Radial Distance of the SMR.

The numbers below Actual value are the current values. 

The values are red when out of acceptable range, yellow when close to 
range, and green when within range. When all of the values are green, the 
Laser Tracker waits five seconds for stability before measuring the SMR.

Show previous 6.	
measurements

Click the Show Table button to display a list of any 
previous measurements.

Clicking Cancel enables you to exit the Interim Test ☛☛
without saving any data or parameters.

Two other 7.	
locations

Guided by the screen prompts, continue the above 
process for two more locations:

degrees azimuth, 90 degrees zenith, 2 meters zz
distance.

degrees azimuth, 135 degrees zenith, 2 meters zz
distance  
(SMR will usually need to be placed on the 
ground).

Continue8.	 Click Continue after completing the third location.
Pointing 9.	
Compensation

Click Compensation to exit this dialog box and 
continue with the Pointing Compensation routine. 
The Standard Pointing Compensation dialog box 
appears.

Clicking Cancel at this point will exit Pointing ☛☛
Compensation without saving data.
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Place SMR10.	 Place the SMR in the calibration tripod or in another 
stable nest. The first desired location is:

Any azimuth position, 90 degrees zenith, 2 zz
meters distance.

Move the SMR11.	 Move the SMR and/or rotate the Laser Tracker until 
the actual numbers for all three values are green.

The Laser Tracker will measure automatically ☛☛
when the target has been stable for more than five 
seconds.

The remaining desired locations are:
Any azimuth position, 90 degrees zenith, 3.6 zz
meters distance.

Any azimuth position, 90 degrees zenith, 5.2 zz
meters distance.

Any azimuth position, 90 degrees zenith, 6.8 zz
meters distance.

Any azimuth position, 90 degrees zenith, 8.4 zz
meters distance.

Any azimuth position, 90 degrees zenith, 10 zz
meters distance.

Pass/Fail12.	 After completing the last measurement, click the 
Continue button. You will see the results of this test 
in the Pointing Compensation Results dialog box.

Results13.	 Pointing Compensation Results: The results of the 
Pointing Compensation (Pass or Continue).

Recommendation14.	 Recommendation: Detailed recommendation on the 
next step for the user.

Show Details15.	 Click Details: Displays the details of the results, 
which you can save to a text file.
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Update the 16.	
parameters

Click Update: Updates the compensation parameters 
and exits Pointing CompIT.

If you do not click the “Update” button, the ☛☛
parameters will not update.

Exit17.	 Click Cancel to exit CompIT without updating any 
parameters. 

ADM Checks (IT)

The ADM Interim Test tests the accuracy of XtremeADM (Absolute Distance 
Measurement). There are two different procedures, depending on Laser 
Tracker model. The model Xi procedure compares XADM measurements to 
Interferometer (IFM) measurements. The model X procedure compares XADM 
measurements to angular measurements. The tests take only a few minutes 
and may be run weekly.

ACTIVITY:  ADM IT - Model Xi

For this activity, you will perform a model Xi ADM Interim Test.

The model Xi ADM Interim Test (IT) procedure compares XADM measurements to 
Interferometer (IFM) measurements. This test completes in a few minutes and should be 
run once a week.

Procedure

Advanced1.	  tab. Click CompIT dialog box Advanced tab.
Start ADM 2.	
Checks

Click ADM Checks in the CompIT dialog box Advanced 
tab. 

The Select Mode dialog box appears.

SMR to Home3.	 Click Guided Points.

Since CompIT is comparing IFM to ADM ☛☛
measurements, Auto Home is active; if the beam 
breaks (loss of IFM count), return the SMR to the 
home position for an automatic reset.

CompIT moves the laser beam to Home. 
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Track to point 24.	 Track the SMR in a nest to a point 3 meters away from 
the Laser Tracker (point 2). 

Use a stable nest for the SMR. You can use the Laser ☛☛
Tracker’s calibration tripod.

The Laser Tracker will measure automatically when the 
target has been stable in the green zone for 5 seconds.

Track to point 35.	 Track the SMR in the nest to the next point 7 meters 
away from the Laser Tracker (point 3).

Track to Home6.	 If any point is out of tolerance CompIT will prompt you 
to Track Home to check for Closure.

View results7.	 Click the Details button after completing the last 
measurement, 

You will see the results of this test in the ADM Interim 
Test Results dialog box. 
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Analyze results8.	 Click the ADM Interim Test Results tab to view the 
ADM-IFM values.

 The numbers in the IFM column are the results of the 
Interim Test.

Exit the test9.	 Click Close to close the ADM Interim Test Results.
Exit the Checks10.	 Click Done to exit the CompIT ADM Checks procedure.

ACTIVITY:  ADM IT - Model X 

For this activity, you will perform an ADM Interim Test.

ADM Interim Test

We have discussed measuring the Angular Accuracy of the Laser Tracker. The ADM 
Interim Test (IT) provides a procedure to evaluate the Distance Accuracy of XtremeADM 
(XADM), the Laser Tracker’s measuring system.

The routine compares the Tracker’s Angular Accuracy to its Distance Accuracy by 
measuring the distance between two targets from two Laser Tracker positions. 

Alternatively, the test can be run using a bar with two fixed targets. The bar can then be 
measured in two orientations by the Laser Tracker in a single position while following the 
same procedure.

Procedure

Set up Laser 1.	
Tracker

Set up the Laser Tracker three meters away from two 
points (point 1 and point 2) that are one or more 
meters apart.



2 . 2 2

M
o

d
u

l
e

 
2

:
M

e
a

s
u

r
e

m
e

n
t

 
C

o
n

s
i

d
e

r
a

t
i

o
n

s 

Start 2.	 ADM 
Checks

Click ADM Checks In the CompIT dialog box under the 
Advanced tab. 

The first position for the interim test is with the Laser 
Tracker set up to measure two points from the side. 
This setup should maximize the use of the Laser 
Tracker’s angular encoders. 

Move Laser 3.	
Tracker to S1

Move the Laser Tracker to Station S1 (between the 
points) and click Continue.

Home the SMR4.	 Home the SMR. 

You will be prompted to place the SMR at the Home 
position. Select Home. 
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Track to 5.	 point 1 Track the target to point 1. 

Measure 6.	 point 1 Click the Measure button to measure point 1. 

The Laser Tracker waits five seconds to ensure the 
target is stable and then takes a measurement.

Track to 7.	 point 2 Track the target to point 2. 

A note will prompt you where to move the target to ☛☛
ensure the check is valid.

Measure 8.	 point 2 Click the Measure button to measure point 2.

If the percentage is less than 80%, move the Laser 
Tracker and click the Retry button to re-measure the 
two points with a setup that yields greater than 80 %.
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Move Laser 9.	
Tracker to S2

Move the Laser Tracker to Position 2. 

 At Position 2, the Laser Tracker’s beam should be in 
line with the two points being measured . 

Track to 10.	 point 1 Track the target to point 1.
Measure 11.	 point 1 Click the Measure button to measure point 1. 

The Laser Tracker waits five seconds to ensure the 
target is stable and then takes a measurement.

Track to 12.	 point 2 Track the target to point 2 . 

A note will prompt you where to move the target to 
ensure the check is valid.
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Measure 13.	 point 2 Click the Measure button to measure point 2. 

If the percentage is less than 80%, move the Laser 
Tracker and click the Retry button to re-measure the 
two points with a setup that yields greater than 80%.

The Results dialog shows the distance between the 
two points measured from the two setups; 

The difference between the two measurements 
is shown along with the Maximum Permissible 
Error (MPE), which is derived from the Laser Tracker 
angular specifications. A result (Pass/Fail) will also be 
displayed. If Fail redo the test. If Fail a second time, 
call FARO Customer Support.

View 14.	
measurements

The percentage of angular and distance 
measurements is again displayed summarizing the 
measurements from two points. 

View results15.	 Click the Report button to open a dialog to save the 
results.

Save results16.	 Name the file “ADM – Test 01”.

A check box is available to add the results to ☛☛
a previously saved report. This enables you to 
maintain a running log of test results. 

Close results17.	 Click Done to close the results page. 

The  screen provides two options:  Measure More 
Points and Exit.
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Exit 18.	 ADM 
Interim Test

Click Exit.

The ☛☛ Measure More Points button returns you to the 
Move screen and prompts you through additional 
XADM testing if you desire.

FARO Laser Tracker Help File

You can access the FARO Laser Tracker Help file by clicking the Help button in 
any FARO Laser Tracker driver command. These commands are found in the 
Device Control Panel.

On the zz Device Control Panel, click the Settings button, or any other 
command button.

In the zz FARO Laser Tracker Settings  dialog box, click the Help button.

This opens the FARO Laser Tracker help file and automatically jumps to 
the Probes section of the file. Use the Contents, Index and Search tabs to 
navigate around the file.
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Lesson 3: Laser Tracker Device Setup Checklist
Temperature Effect On A Part

Part has been allowed to soak in the inspection environment to ❐❐

adjust to the air temperature.

Measurements will be taken where the air temperature is relatively ❐❐

constant.

CAM2 Q is set to appropriately adjust for part expansion/contraction ❐❐

(see software user guide). 

The part is evenly exposed to light.❐❐

Measurements are being taken away from heating/ventilation ducts ❐❐

or any other potential source of air turbulence.

Temperature Effect On The Device 

The device temperature has been allowed to stabilize.❐❐

Movement

The device and part are fastened and stationary.❐❐

Vibration Effects

Vibrations (forklifts driving by, stamping machine movement etc.) ❐❐

have been avoided.

Mounting Stability

Detailed instructions provided with mount (tripod, magnetic) were ❐❐

carefully followed.

If mounting the device horizontally, the side mounting bracket has ❐❐

been used.

The part being measured is supported in the same manner as it ❐❐

would be in its intended function.
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Module 3: 
Basic Measurement

In this module, you will become familiar with the CAM2 Q Measure, Construct, 
Dimension, and Report menus—the four steps common to every CAM2 Q measuring 

job.

You will also be introduced to a Basic Measurement Strategy, which will get you 
thinking about what you need to include in the final report and how you can obtain 
that information before you begin measuring. You will see the process of how you think 
about a project vs. how you actually do a project.

This module will first focus on each of the key menus. After you learn how to use each 
menu, you will apply the Basic Measurement Strategy to put them all together in the 
proper order to complete a measurement job.

Let’s begin!

Module XX Objective
You will be able to:

Use the Basic Measurement Strategy to plan and complete a measurement job using zz
the Measure, Construct,  Dimension, and Report menus.

LessonsXX
Lesson 1: Measure............................................................................................................3.5
Lesson 2: Construct....................................................................................................... 3.27
Lesson 3: Dimension.................................................................................................... 3.41
Lesson 4: Report............................................................................................................. 3.47
Lesson 5: Review Activities ....................................................................................... 3.59
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Scenario: First Article Inspection

You enter the boss’ office. The boss says, “We have the new FARO Laser Tracker 

and CAM2 Q. I need you to do a first article inspection on this part. We need 

to finish our part inspection by the end of the day if we are going to meet 

our delivery schedule. Here is the blueprint… get to work.” You return to your 

workstation, look at the blueprint and the part, and think about how to tackle 

this job.

Strategy: Basic Measurement

Look at what you need to measure and consider the following 
questions:

What should you include in the formal zz Report?

Which features (geometric elements) do you need to capture?zz

Which features can you �� Measure directly (e.g. planes, circles, 
cylinders, lines, etc.)?

Which features do you need to �� Construct (e.g. bolt hole circle)?

Which zz Dimensions do you need? (e.g. circle center to circle center)

What logical sequence should you use to move around the part and zz
capture the features? (i.e., left to right, top to bottom, or measure all 
planes first, then circles, etc.)

“What is the most effective way to provide what the boss is 

asking for? I need to think about the measurement strategy 

and begin with the end in mind.”
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Report  
Requirements

Features  
to Capture

Measureablezz

Need to zz
Construct

How you Think About your measurement project
(Basic Measurement Strategy)

Dimension

How you DO your measurement project

Measure Construct Dimension

Report
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Lesson 1: Measure

Measure Construct Dimension

Report

Before you can apply the Basic Measurement Strategy to a complete 
measurement job, you need to know the capabilities of the CAM2 Q menus 
(Measure, Construct, Dimension, Report). The first menu we will present is 
Measure. You will learn to measure features correctly, analyze the data for the 
feature, and find and edit feature readings and names.

Lesson Objective

With the assistance of the Help menu, you will be able to use all of the 
functions within the Measure menu. This means you will be able to:

Use the zz Measure menu to capture data.

Review and evaluate measurement quality and edit data.zz

Define projection planes for 2D measurements.zz

Save and open files.zz

Rename features.zz

Determine the optimal number of points to collect and distribution of zz
those points on a feature.

Before Measuring

Before you begin measuring features, make certain that you use the correct 
SMR. On the Device menu, click Device Control Panel. Check the Current 
SMR listed in the SMR section. If you need to change the SMR, click the Probe 
Management button.
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How To Measure Features

Choose a Part Measurement Workflow1.	

Add Feature(s) to your file2.	

Record Measurements3.	

Part Measurement Workflow: Measure or Template Mode

There are two workflows for measuring your part in CAM2 Q. Sometimes you 
may want to take measurements immediately as you are inspecting a part 
(Measure Mode); other times you may want to plan an entire measurement 
process before you actually take any measurements (Template Mode).

Measure/Template Mode Icon

In CAM2 Q, you can choose either approach by selecting or deselecting the 
Measure/Template Mode command.  Select (highlight) the icon, or Measure 
menu command, for Measure Mode, and deselect for Template Mode. When 
Template Mode is active, a red border and "Template Mode" text appears on 
the Main Window.

Measure Mode

To measure features in Measure mode:

On the toolbar, select the 1.	 Measure/Template Mode icon.

On the 2.	 Measure menu, or from the Feature Creator, click the feature 
you want to measure (e.g. a plane).

The 3.	 Measurement Window appears and you can start adding 
readings (measurements).

Template Mode

In Template mode, you first create the features that you will want to measure. 
To create these features:

On the toolbar, deselect the 1.	 Measure/Template Mode icon.

On the 2.	 Measure menu, or in the Feature Creator panel, select the 
feature you want to measure (e.g. a plane). The feature is added to the 
Features panel. The feature name appears in gray, indicating that the 
feature has not been measured and is not "solved" yet.

To measure in the Template mode:  

In the 1.	 Features panel, select an existing feature to measure.

The default mode is ##
Measure Mode.

The sequence in which ##
you click the features is the sequence 

in which you are prompted to measure 

the features.

The sequence in which ##
you click the features is the sequence 

in which you are prompted to measure 

the features.
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You can select features one at a time, or, to select multiple features, 2.	
press the CTRL key on the keyboard while clicking each feature with 
the mouse.

On the toolbar, click the 3.	 Add Readings  icon.

The 4.	 Measurement Window appears and you can add readings 
(measurements) to each feature.

Measurement Window

The Measurement Window panel appears each time you choose a 
measurement command either from the Feature Creator panel, the drop-
down menus, or by right-clicking a feature in the Features panel and 
selecting Add Readings. 

The Measurement Window consists of three panels:
Promptzz —displays prompts in conjunction with the DRO.

Device’s Digital ReadOut (DRO)zz —displays the position of the SMR at 
any point in space using a three dimensional coordinate system and 
displays the Form.

Imagezz —displays the image for the current measurement.

The Measurement Window panel consists of Setup, Measure, Sizing, and 
Scanning commands:

Setup

! Show Options: Allows you to select the coordinate system axes you 
want to display.

" Geometric Data: Geometric data and statistics associated with the 
current measurement.

# Digital ReadOut (DRO): The current location of the measurement 
device’s SMR that updates as the SMR moves through space. If there 
is a communication or device error, or you interrupt and break the 
laser beam to the SMR,  all of the coordinate values display as a line of 
asterisks (*****).

$ Measurement Image: The image for the current measurement 
(QuickTools only).
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% Show Prompt: The text area that contains informational messages 
relating to the current measurement.

Measuring

& Record Measurement: Enables you to take a single point reading.

' Record End Click: Completes the collection of readings.

( Remove Last Reading: Enables removal of the last reading taken.

Sizing

) Full Screen:  Maximizes the Measurement Window to fill the entire 
computer screen.

Geometry Override

* Geometry Override:  Allows you to override CAM2 Q’s Automatic 
Feature Recognition by manually selecting a geometry type.

Scanning

+ Mode: Determines the way in which you collect readings. Single 
Point (the default setting) collects one reading per click of the  G key. 
Time Interval and Distance Interval are different methods of scanning 
points, which means that points are continuously taken as long as the  
G key is pressed.

Recording Readings

Press the  G key to collect point readings. Press the  H key to accept the 
collected readings, which is the End Click. 

The position of the SMR ##
at the End Click is critical for accurate 

readings.
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Probe Compensation

When measuring with an SMR !, the location of the center of the SMR 
records as a point each time you press the  G key. Because each SMR has 
a known diameter, there is a known distance between the center of the 
SMR and the outer edge of the SMR. This distance needs to be specified 
(projected) for the point to record in the correct location.

The distance between the SMR point of contact "with the surface being 
measured and the center of the SMR #is known as SMR Offset $. This 
transfer of the point from the center of the SMR to the correct location is 
known as probe compensation.

4

1

3

2

To make sure the ##
compensation for the SMR radius 

calculates correctly, the location of the 

SMR is extremely important when you 

press the  H key. 
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Plane Compensation

In this example, you are taking three points to identify a plane on a part. 
This plane can compensate in one of two opposite directions. The correct 
compensation depends on where you press the  H key. In this case, press the  
H key above the plane. The plane then compensates in a downward direction 
the distance equal to the SMR radius.

In this example, the correct location to accept points is above the plane.

ACTIVITY: Measure A Plane In The Measure Now Mode

For this activity, you will measure a plane on the top of the demo part with at least three 
points and review the Form data.

Select Workflow 1.	
Mode

If necessary, click the Measure/Template Mode icon so 
that you are in Measure mode.

Select 2.	 Plane On the Measure menu, click Plane.
Collect readings3.	 Use the G key to collect at least three readings.
Compensate 4.	
SMR

Pull the SMR up and away from the part when you 
finish collecting readings.
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Accept readings5.	 Press the H key to accept readings.
Cancel the 6.	
measurement 
command

Press the H key again to cancel the Plane command. 

When measuring a plane, SMR location during the End Click is critical for 
correct placement of the plane.

View screen7.	 On the View menu, click Zoom, and All. Or press the 
E hot key. 

Now, remeasure the plane with more than three readings and review the 
Form data in the Measurement window.

Remeasure8.	  
command

On the Measure menu, click Remeasure. Use the G key 
to collect more than three readings

Compensate 9.	
SMR

Pull the SMR up and away from the part when you 
finish collecting readings. 

Accept readings10.	 Press the H key to accept readings.

Percentage Of Measured Feature Vs. Total Feature Size

Measuring a small percentage of a feature does not provide the most 
accurate representation of the feature. Since CAM2 Q constructs a best-fit 
feature from the points you collect, the number of points collected and the 
spacing of those points directly impact the accuracy of the measurement 
result. 

A common principle applies regardless of the feature you measure. The more 
points you collect, and the more evenly you distribute them over the part, 
the more repeatable your measurement result will be. For optimal results, we 
recommend collecting two times the minimum points plus one. (Minimum 
number of points x 2 + 1).

When considering the distribution of the points over the part, remember that 
even distribution is best. If there are times when only a portion of the feature 
is accessible, then take as many points as you can on that portion. While this 
is not the ideal situation, taking as many points as you can will help ensure a 
better representation of the feature.

Feature
To solve the feature:  
minimum number of 

points to collect

For optimal results:  
suggested minimum 

number of points to collect

 Plane 3 7

 Line 2 5
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 Circle 3 7

 Sphere 4 9

 Cylinder 6 13

 Cone 6 13

Examples: 
Minimum Minimum: For Optimal Results

  

ACTIVITY: Add Features To The Features Panel In The Template Mode

For this activity, you will add the following features to the Features panel to measure 
later:

Four circleszz

One spherezz

Select 1.	
Workflow 
Mode

Click the Measure/Template Mode icon to switch to 
Template mode.

 

For the next steps, either click each feature on the Measure menu or click a 
feature from the Feature Creator panel.

##
Hot Keys
F10: 
Measure Circle
F11: 
Measure Cylinder
F12: 
Measure Sphere 
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Add circles2.	 Click Circle four times to add these features to the 
Features panel.

3.	 Collect 
readings

Use the G key to collect at least three readings on 
Circle 1.

Compensate 4.	
SMR

Pull the SMR to the center of the Circle 1 when you 
finish collecting readings. 

Collect 5.	
readings

Use the G key to collect at least three readings on 
Circle 3.

Compensate 6.	
SMR

Pull the SMR to the center of the Circle 3 when you 
finish collecting readings. 

Collect 7.	
readings

Use the G key to collect at least three readings on 
Circle 5.

Compensate 8.	
SMR

Pull the SMR to the center of the Circle 5 when you 
finish collecting readings. 

Collect 9.	
readings

Use the G key to collect at least three readings on 
Circle 7.

Compensate 10.	
SMR

Pull the SMR to the center of the Circle 7 when you 
finish collecting readings. 

Cancel Circle 11.	
Command

Press the H key to cancel the Measure Circle command.

Select 12.	 Sphere On the Measure menu, click Sphere.
Collect 13.	
readings

Use the G key to collect at least three readings on 
Sphere 1.

Compensate 14.	
SMR

Pull the SMR away from the surface of Sphere 1 when 
you finish collecting readings. 

Cancel 15.	
Sphere 
Command

Press the H key to cancel the Measure Sphere 
command.

 ##
Make sure you 

select the right 

target and adapter 

combination.
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ACTIVITY: Add Features To The Features Panel In The Template Mode

For this activity, you will add the following features to the Features panel to measure 
later:

One cylinderzz

Select 1.	
Workflow 
Mode

Click the Measure/Template Mode icon to switch to 
Template mode.

 

For the next steps, either click each feature on the Measure menu or click a 
feature from the Feature Creator panel.

Add 2.	
cylinder

Click Cylinder once to add this feature to the Features 
panel.

##
Hot Keys
F11: 
Measure Cylinder
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ACTIVITY: Measure Feature From The Features Panel

For this activity, you will now add measurements to the cylinder features you just added 
on the Features panel:

zz Cylinder 1

Select feature 1.	
names

On the Features panel, click Cylinder 1 added in 
Template mode.

Select 2.	 Add 
Readings

Right-click on the highlighted features, and click Add 
Readings. 

Measure Mode3.	 Click the Yes button to change to Measure mode. 

Measure the cylinder when prompted in the Prompt panel of the 
Measurement Window (i.e., "Collecting readings on Cylinder 1"). 

Measure 4.	
cylinder

For the cylinder, use the G key to collect at least six 
readings.

Compensate 5.	
and accept 
readings

Pull the SMR to the center of the cylinder. Press the H 
key to accept the readings.

##
When measuring 
a cylinder, the 
first two readings 
determine the 
direction of the 
cylinder. 

2

1

+
 V

ec
to

r

ACTIVITY: Renaming A Feature

For this activity, you will rename the features in the Feature Properties panel:

Circles 1, 3, 5, 7, Cylinder 9, and Sphere Azz

Select 1.	 Circle 4 Double-click Circle 4 in the Features panel.
Type new name2.	 With the feature name highlighted, type Circle 7 

and click Modify.
Select 3.	 Circle 3 Double-click Circle 3 in the Features panel.
Type new name4.	 With the feature name highlighted, type Circle 5 

and click Modify.
Select 5.	 Circle 2 Double-click Circle 2 in the Features panel.
Type new name6.	 With the feature name highlighted, type Circle 3 

and click Modify.

Renaming a Feature

To rename a feature:

Double-click a feature on the zz Features panel.

In the zz Feature Properties panel, rename the feature by highlighting 
the name and typing in a new name. Click the Modify button to 
continue.
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Select 7.	 Sphere 1 Double-click Sphere  1 in the Features panel.
Type new name8.	 With the feature name highlighted, type Sphere A 

and click Modify.
Select 9.	 Cylinder 1 Double-click Cylinder  1 in the Features panel
Type new name10.	 With the feature name highlighted, type Cylinder 9 

and click Modify. Click Close to complete the feature 
renaming..

Projection Plane

Plane of Projection for 2D features

In order for the CAM2 Q to determine a 2D feature’s relative position in space, 
these features must lay on a plane. This plane is the plane of projection.

�The following 2D features must lay on a plane of projection:

Circlezz

Line (2D line)zz

Slot (Round and Rectangular)zz

Ellipsezz

2D polylinezz

PLANE OF PROJECTION

Defining a Plane of Projection

Before measuring a 2D feature, you must first measure a plane to define the 
plane of projection.

Setting the Plane of Projection

After measuring the plane, you measure the 2D feature, and then set the 
plane of projection. To set the correct plane of projection:
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On the zz Projection Plane toolbar, in the Active Projection Plane drop-
down box, select the correct plane.

Plane of Projection: None

In some instances, the points collected for a feature will also define the plane 
of projection for that feature. In these instances, you want to select None for 
the plane of projection:

On the zz Projection Plane toolbar, in the Active Projection Plane drop-
down box, select None.

ACTIVITY: Measure Features On A New Plane

For this activity, you will measure features, set the plane of projection, and rename the 
feature.

Measure Mode1.	 If necessary, click the Measure/Template Mode icon so 
that you are in Measure mode.

Measure Plane2.	 Measure Plane. on Circle 11 side.

 ##
The plane of 

projection for 

Circle  11, in the 

Active Projection 

Plane drop-down 

box, now shows as 

Plane  2.
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Measure 3.	
Circle 11

Measure Circle 11.

Select 4.	 Circle 2 Double-click Circle 2 in the Features panel.
Type new name5.	 With the feature name highlighted, type Circle 11. 

Click Modify and then Close to finish.

Measuring a 2D Line

When measuring a 2D line, SMR location during the End Click is critical for 
correct placement of the line. You should correctly pull the SMR away from 
the surface that represents the line.
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Measuring a Round Slot

When measuring a round slot, SMR location during the End Click is critical 
for calculating the correct diameter. You should correctly pull the SMR to 
the center of the slot, or away from the outside of the slot in the case of an 
outside diameter round slot.

Measuring a Point with No Plane of Projection

When measuring a point, SMR location during the End Click is not critical. The 
FARO Laser Tracker collects the reading for the point at the center of its SMR, 
and the End Click simply concludes the taking of readings.
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ACTIVITY: Set The Plane Of Projection And Measure Basic 
Features

For this activity, you will set the plane of projection and measure more basic features in 
Measure Now mode.

Select 1.	 Active 
Projection 
Plane

On the Projection Plane toolbar, in the Active 
Projection Plane drop-down box, select Plane 1.

Measure 2.	
2D Line

On the Measure menu, click 2D Line and measure the 
line.

Measure 3.	 Round 
Slot

On the Measure menu, click Round Slot and measure 
the round slot.

Measure 4.	 Point On the Measure menu, click Point and measure the 
four points by seating the 6mm probe firmly in each 
5mm hole. 

1

2

3

4

 ##
Hot Keys
F4: 
Measure 2D Line 
F2: 
Measure Point 
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ACTIVITY: Save a File

You will use the measurements you have taken to learn about the Construct and 
Dimension menus. To make this information easily accessible, you can save a file with 
your data.

Save As1.	 On the File menu, click Save As. The Save As dialog box 
appears.

Browse to 2.	
CAM2 Q

In the Save In list, using the drop-down menu, select 
My Documents, and click on the CAM2 Q folder.

Create new 3.	
folder

In the CAM2 Q folder, click the Create New Folder icon. 
Name the folder [your name]. Then, double-click your 
folder to open it.

Type file name4.	 In the File name box, type Measure.fcd.
Save5.	 Click Save.
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Feature Color

Each type of feature that you add to the measurement file has a unique color 
that matches the menu color from the Feature Creator panel. When you 
move the mouse pointer over a feature in the Main Window or the Features 
panel, the color changes to red. When you select feature from the Main 
Window or the Features panel, the color changes to a bright yellow. 

Feature Status Icons

To the right of each feature in the Features panel is a status icon. The status 
icon changes color as you take measurements to indicate: 

You have not taken enough points to define a feature (gray flag icon)zz

You have taken enough points to define the feature and it is in zz
tolerance (green checkmark icon)

You have taken enough points to define the feature and it is out of zz
tolerance (red flag icon /blue flag icon)
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Show and Hide Features

To the extreme right of all features is the Feature Visibility icon (eye icon). 
Click the Feature Visibility icon to hide a feature. Once hidden, the icon 
appears gray. Click the Feature Visibility icon again to show the feature.

When hidden, features remain in the feature tree but are not shown in the 
Main Window.

Evaluate Measurement Data

A number of screen elements assist you in assessing the quality of the part or 
feature you are measuring.

Formzz  is a measure of the geometric accuracy of the feature. Examples 
are the circularity of a circle, the straightness of a line, and the flatness 
of a plane. The measured feature's label shows the form value of the 
feature. 

zz In Tolerance is defined when you establish your nominals and 
tolerances. If a feature is in tolerance, the icon next to the feature in 
the Features panel will be a green check.

Out of Tolerancezz  is defined when you establish your nominals and 
tolerances. If a feature is out of tolerance, the icon next to the feature 
in the Features panel will be a red or blue flag.

Graphical tolerances use ##
color gradients to show more detail 

about the actual number in a tolerance 

band. Blue and Red become lighter as 

the value approaches the-tolerance 

band edge. Green becomes darker as 

the actual number approaches the 

exact nominal value.
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Readingszz  shows the deviation from fit for each point taken.

Adding/Removing Readings

Removing Readings from a Feature's Calculation

To remove a reading from a feature's calculation:

On the zz Readings panel, clear the check box in the On column. Click 
the Apply button to re-calculate the feature with the remaining 
readings.  

Adding Readings To An Existing Feature

To add readings to a feature:

Right-click the feature on the zz Features panel or the on the image in 
the Main Window, then click Add Readings.

Press the zz G key and take more readings.

Permanently Removing Readings from a Feature

To permanently delete a reading from a feature:

Press the zz Backspace key while measuring that feature. One reading is 
removed each time you press the Backspace key; or

On the zz Readings panel, select the reading you want to remove, and 
press the Delete key. 

Make sure that you do ##
not remove a reading need to solve 

the feature.

After removing a ##
reading, you may want to remeasure 

that specific area of the part to rule out 

user, device, or part error.
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Measuring Mode: Scan Mode

So far, when measuring, you have taken single points. Another way to take 
points is by scanning, which takes points continuously while you press the G 
key.

You can enable scanning by selecting a mode in the Measurement Window 
panel which appears when selecting a measurement command. The three 
modes are: 

Single Pointzz : press the G key to collect a single reading. 

Time Intervalzz : press the G key to start the time interval. Collects single 
readings over time. 

Distance Intervalzz : press the G key to start the distance interval. Collect a 
single reading when the SMR moves a distance. 
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Lesson Objective

With the assistance of the Help menu, you will be able to use all of the 
functions within the Construct menu. You will be able to: 

Identify point-, line-, and plane-reducibility for each feature type.zz

Identify why constructions are needed.zz

Locate, review, and evaluate feature construction quality.  zz

Lesson 2: Construct

Measure Construct Dimension

Report

Now that you know how to measure features, let’s learn how to construct a 
feature. A construction allows you to create features that you cannot measure 
directly. Sometimes points or other features are specified on a drawing, but 
do not actually exist on the part, e.g. a bolt-hole circle.

Why are Constructions Needed?

Constructions allow you to create features that you cannot directly measure, 
such as a bolt-hole circle.

The activities in this Lesson allow you to practice some commonly used 
construction commands.

As we discuss and practice using the Construct menu, you will use features 
you saved in the Measure lesson. 

Module 3: 
Basic Measurement
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Feature Reducibility

Feature Reducibility means that a part of a feature can be used for 
constructions and dimensions. For example, a circle has three reducible parts.

A circle is Point-Reducible, which means it can be used like a point for 
constructions, or dimensions. The point of a circle is its center point.

A circle is Line-Reducible. The line of a circle is perpendicular to the circle's 
plane through the center point. 

A circle is Plane-Reducible. The plane of a circle is its plane of projection.  
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ACTIVITY: Feature Reducibility Exercise

Look at each feature and determine if it is point-, line-, or plane-reducible.  Some features 
may be reducible to more than one type of feature.

Point Line Plane
Circle

Cylinder

Cone

Ellipse

Line

Plane

Point

Rectangular Slot

Round Slot

Sphere
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Point Constructions

Four of the most commonly used point constructions are Intersection, 
Projection, Bisection and Key-In.

Intersectionzz  allows you to construct a point from the intersection of 
two features or three planes. 

Projectionzz  allows you to construct a point and project it onto a 
feature. 
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Bisectionzz  allows you to construct a point in the center of two  
point-reducible features.

 
�Key-Inzz  allows you to construct a point by entering the  
location of the point.  

Key-in requires the input of nominals which we will discuss later in the 
workbook.

ACTIVITY: Open A Saved File

File 1.	 Open On the File menu, click Open.
My Documents2.	 In the Look In drop-down list, select My Documents.
Select 3.	 your 
folder

Double-click on the CAM2 Q folder, and then double-
click the your folder.

Select 4.	 Measure.
fcd

Select Measure.fcd 

Open5.	 Click Open.

ACTIVITY: Construct Point By Intersection Of Two Features

For this activity, you will construct a point from the intersection of Plane 1 and Cylinder 9.

By Intersection1.	 On the Construct menu, click Point, then click By 
Intersection. The Construct Point By Intersection 
dialog box appears.

Name the point2.	 In the Name box, enter Intersection Point.
Click 3.	 Two Features Click the Two Features option button.
Select first feature4.	 In the first Feature list, select Plane 1.
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Select second 5.	
feature

In the second Feature list, select Cylinder 9. 

Treat as 6.	 Line In the treat as list, select Line.
Create7.	 Click Create to view the result.
Close8.	 Click Close to close the dialog box.

ACTIVITY: Construct Point By Projection

For this activity, you will construct a point from the projection of Sphere A to Plane 1.

By Projection1.	 On the Construct menu, click Point, then click By 
Projection.  The Construct Point By Projection 
dialog box appears.

Name the point2.	 In the Name box, enter Projection Point.
Select point3.	 In the Point list, select Sphere A.
Select feature to 4.	
project to

In the Project To list, select Plane 1.

Create5.	 Click Create to view the result.
Close6.	 Click Close to close the dialog box.

ACTIVITY: Construct Point By Bisection

For this activity, you will construct a point halfway between two points.

By Bisection1.	 On the Construct menu, click Point, then click By 
Bisection. The Construct Point By Bisection dialog 
box appears.

Name the point2.	 In the Name box, enter Bisection Point.
Select first feature3.	 In the Feature 1 list, select Point 1.
Select second 4.	
feature

In the Feature 2 list, select Point 2.

Create5.	 Click Create to view the result.
Close6.	 Click Close to close the dialog box.
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Line Constructions 

One of the most commonly used line constructions is Intersection of Two 
Planes.

ACTIVITY: Construct Line By Intersection Of Two Planes

For this activity, you will construct a line using the intersection of Plane 1 and Plane 2.

By Intersection 1.	
of Two Planes

On the Construct menu, click Line, then click By 
Intersection of 2 Planes. The Construct Point By 
Intersection of Two Planes dialog box appears.

Name the line2.	 In the Name box, enter Constructed Line 1.
Select first 3.	
feature

In the Feature 1 list, select Plane 1.

Select second 4.	
feature

In the Feature 2 list, select Plane 2.

Create5.	 Click Create to view the result.
Close6.	 Click Close to close the dialog box.
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To edit any of these features, select the feature in the Features panel, 
double-click, make changes in the Feature Properties panel, and click 
Modify. 

Plane Constructions

Three of the most commonly used plane constructions are Best Fit, By Offset 
and Perpendicular.

zz Best Fit enables you to construct a plane by fitting it through point-
reducible features. 

By Offsetzz  enables you to construct a plane at a known distance 
parallel to an existing plane. You can locate the plane by either:

Moving the plane by an absolute offset.��

Placing it through another point.��

Offsetting the plane along a normal (line).��

Perpendicularzz  enables you to construct a plane perpendicular to a line. 

Best Fit By Offset Perpendicular

You can preview a “By ##
best Fit” feature before you create it, 

using a graphic feature in the Main 

window, and feature data in all of the 

By Best Fit dialog boxes. 

ACTIVITY: Construct A Best Fit Plane

For this activity, you will construct a best fit plane using the previously measured four 
circles.

By Best Fit1.	 On the Construct menu, click Plane, then click By 
Best Fit. The Construct Plane By Best Fit dialog box 
appears.

Name the plane2.	 In the Name box, enter Best Fit Plane.
Select 3.	 Circles 1, 
3, 5, and 7

In the Select Entities to Fit Through list, hold down 
the Ctrl key and select Circle 1, Circle 3 , Circle 5, and 
Circle 7.

Create4.	 Click Create to view the result.
Close5.	 Click Close to close the dialog box.
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ACTIVITY: Construct Plane By Offset

For this activity, you will construct a plane parallel to the best fit plane.

By Offset1.	 On the Construct menu, click Plane, then click By 
Offset. The Construct Plane By Offset dialog box 
appears.

Name the plane2.	 In the Name box, enter Offset Plane.
Select base 3.	
feature

In the Base Feature list, select Best Fit Plane.

Select 4.	 Offset 
Along Normal  
and select 
feature.

Select the Offset Along Normal option button. Select 
Best Fit Plane from the drop-down list.

Enter distance5.	 In the Distance box, enter either 20.00 (mm)  
or 0.7874 (in)

Create6.	 Click Create to view the result.
Close7.	 Click Close to close the dialog box.

ACTIVITY:  Construct Plane Perpendicular

For this activity, you will construct a plane perpendicular to the front edge.

Perpendicular1.	 On the Construct menu, click Plane, then click 
Perpendicular. The Construct Plane Perpendicular 
dialog box appears.

Name the plane2.	 In the Name box, enter Perpendicular Plane.
Select 3.	 Line and 
select feature

Select the Line option button. Select Line 1 from the 
drop-down list.

Select point4.	 In the Point box, select Circle 3.
Create5.	 Click Create to view the result.
Close6.	 Click Close to close the dialog box.
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Circle Constructions

Three of the most commonly used circle constructions are Plane Intersect, 
Best Fit and Key In.

Plane Intersectzz —allows you to construct a circle from the 
intersection of a plane and a feature, such as a cone or cylinder.

Best Fitzz —allows you to construct a bolt circle pattern from previously 
measured circles. 

Key-Inzz —allows you to construct a circle by entering the name, 
location, diameter and normal vector.

Next, we will discuss Plane Intersect and Best Fit. Since Key-In uses nominals, 
we will discuss that in the Nominals lesson.

Plane Intersect

Best Fit
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ACTIVITY: Circle Intersect

For this activity, you will construct a circle using the intersection of a plane and a feature.

By Intersection 1.	
of Plane and a 
Feature

On the Construct menu, click Circle, then click By 
Intersection of Plane and a Feature. The Construct 
Circle By Intersection of Plane and a Feature dialog 
box appears.

Name the circle2.	 In the Name box, enter Circle by 
Intersection.

Select first 3.	
feature

In the Feature 1 list, select Plane 1.

Select second 4.	
feature

In the Feature 2 list, select Cylinder 9.

Lock Plane of 5.	
Circle

Select To Plane.

Create6.	 Click Create to view the result.
Close7.	 Click Close to close the dialog box.

ACTIVITY: Best Fit

For this activity, you will construct a best fit bolt-hole pattern using three of the 
previously measured four circles.

By Best Fit1.	 On the Construct menu, click Circle, then click By 
Best Fit. The Construct Circle By Best Fit dialog box 
appears.

Name the circle2.	 In the Name box, enter Bolt Circle.
Select entities to 3.	
fit through

In the Select Entities to Fit Through list, hold down 
the Ctrl key and select Circle 1, Circle 3, and Circle 5.

Click 4.	 Use Plane 
and select 
Plane 1

Make sure the Use Plane check box is selected and in 
the Use Plane list, select Plane 1.

Create5.	 Click Create to view the result.
Close6.	 Click Close to close the dialog box.
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ACTIVITY: Review And Evaluate Data  
(Form And Diameter Of Constructed Features)

Now, let us review the data of the Bolt Circle.

Select Bolt Circle1.	 Select the Bolt Circle in the Features panel.
Feature 2.	
Information 
panel

At the bottom of the CAM2 Q window, click the 
Feature Information tab to open the Feature 
Information panel.

Review data3.	 Note the data of the Bolt Circle in the Feature Label 
column.

The ☛☛ Circularity (Form) will be “0” - because three 
points are all that is required to define a circle, the 
form of a circle defined by three points will always 
be perfect.

Note the 4.	
diameter

Note the Diameter for reference when you add 
another circle in the next activity.

Form: _____________

Diameter: _____________

ACTIVITY: Edit The Data For Best Fit Constructed Circle

Edit the Bolt Circle.

Bolt-Circle 1.	
Properties

In the Features panel, double-click Bolt Circle.

Select entities to 2.	
fit through

In the Select Entities to Fit Through list, Ctrl + click 
Circle 7.

Modify3.	 Click Modify to view the result.
Close4.	 Click Close to close the dialog box.



08m13e15 - CAM2 Q v1.5 - FARO Laser Tracker Training Workbook - October 2010.pdf  Part# 12053-001

3 . 3 9

M
o

d
u

l
e

 
3

:
 

B
a

s
i

c
 

M
e

a
s

u
r

e
m

e
n

t

ACTIVITY: Review The Data For The Best Fit Constructed Circle

For this activity, you will compare the data of the edited Bolt Circle to the previous Bolt 
Circle data.

Form: _____________

Diameter: _____________

Select 1.	 Bolt 
Circle

On the Features panel, click Bolt Circle.

Feature 2.	
Information 
panel

Open the Feature Information panel.

View data3.	 Note the updated data of the edited Bolt Circle.

Since the circle is defined by a best fit using more ☛☛
than three points, it will most likely show less than 
perfect form. Additionally, the diameter of the circle 
will be slightly different due to the change in form.
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ACTIVITY: Save A File

You should save your work to this point.

Save As1.	 On the File menu, click Save As. The Save As 
dialog box appears.

My Documents 2.	
folder

In the Save In drop-down list, select My 
Documents.

Your folder3.	 Double-click on the CAM2 Q folder and browse to 
your folder.

Enter  4.	
Construct.fcd

In the File name box, type Construct.fcd.

Save5.	 Click Save.
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Lesson 3: Dimension

Measure Construct Dimension

Report

The third part of the Basic Measurement Strategy is Dimension. A dimension 
describes the relationship between two or more features, e.g. the distance 
between or the angle between features. 

Lesson Objective

With the assistance of the Help menu, you will be able to use all of the 
functions within the Dimension menu. You will be able to:

Identify why dimensions are needed. zz

Locate dimension data for evaluation. zz

Edit features used to create a dimension. zz

Types of Dimensions

There are two types of dimensions available in CAM2 Q: Length and Angle.

Length Dimensions

Two of the most commonly used length dimensions are Point to Line and 
Point to Point.

Point to Line zz calculates the relationship between a point and a line. 
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ACTIVITY: Open A Saved File

File 1.	 Open On the File menu, click Open.
My Documents2.	 In the Look In drop-down list, select My Documents.
Select 3.	 your 
folder

Double-click on the CAM2 Q folder, and then double-
click the your folder.

Select 4.	
Construct.fcd

Select Construct.fcd 

Open5.	 Click Open.

Point to Pointzz  calculates the relationship between a point and a 
point.

ACTIVITY: Dimensioning a Length from Features

For this activity, you will obtain the length between two features, a point (Sphere A) and a 
line (2D Line 1).

Length from 1.	
Features

On the Dimension menu, click Length From 
Features. The Dimension Length From Features 
dialog box appears.

Open Help2.	 Click the Help button. The CAM2 Q help file opens to 
the Length: from Features topic. Review the length 
examples and close the help file.

Enter name3.	 In the Name box, enter Point to Line.

Select 4.	 Sphere A 
and treat as 
Point

In the first feature list, select Sphere A. Then in the 
treat as list, select Point.

5.	 Select 2D Line 1 
and treat as Line

In the second feature list, select Line 1. Then in the 
treat as list, select Line.

Create6.	 Click Create to view the result.

Close7.	 Click Close to close the dialog box.
View results8.	 In the Features panel, select Point to Line and open 

the Feature Information panel. Note the length.

Length: _____________

   
You are using 

the concept 

of feature 

reducibility to 

determine how 

to "treat" the 

feature.
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ACTIVITY: Dimensioning Length from Features

For this activity, you will obtain the length between two features, a point (Circle 1) and a 
point (Circle 3).

Length from 1.	
Features

On the Dimension menu, click Length From 
Features. The Dimension Length From Features 
dialog box appears.

Enter name2.	 In the Name box, enter Point to Point.
Select 3.	 Circle 1 
and treat as 
Point

In the first feature list, select Circle 1. Then in the 
treat as list, select Point.

Select 4.	 Circle 3 
and treat as 
Point

In the second feature list, select Circle 3. Then in the 
treat as list, select Point.

Create5.	 Click Create to view the result.

Close6.	 Click Close to close the dialog box.
View results7.	 In the Features panel, select Point to Point and open 

the Feature Information panel. Note the length.

Length: _____________

Editing Features

Sometimes when you will want to change the features you have selected to 
create a dimension. Rather than reconstruct all of the feature selections, you 
can do this using an editing dialog box. 



3 . 4 4

M
o

d
u

l
e

 
3

:
 

B
a

s
i

c
 

M
e

a
s

u
r

e
m

e
n

t

Angle Dimensions

Two of the most commonly used angle dimensions are Line to Line and Apex.

Line to Linezz  calculates the angular relationship between two lines.

ACTIVITY: Editing Features To Create A Line

For this activity, you will edit features to create a line.

Select feature1.	 In the Features panel, double-click Point to Point. 
Edit 2.	 Properties The Feature Properties dialog box appears.
Select 3.	 Circle 5 Using the drop-down menu, replace Circle 3 with 

Circle 5.
Complete the 4.	
change

Click Modify. 

Close5.	 Click Close to close the dialog box.
View results6.	 In the Features panel, select Point to Point and open 

the Feature Information panel. Note the length 
changes as a reflection of the change in features 
selected. 

Length: _____________
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Apexzz  calculates the angular relationship between two points with a 
point-reducible feature as the apex.

ACTIVITY: Dimensioning Angles

For this activity, you will dimension an angle from features.

Dimension 1.	
Angle From 
Features

In the Dimension menu, click Angle From Features. 
The Dimension Angle From Features dialog box 
appears.

Open Help2.	 Click the Help button. The CAM2 Q help file opens 
to the Angle: from Features topic. Review the 
differences between the two feature and three 
feature examples, and close the CAM2 Q help file.

Enter name3.	 In the Name box, enter Line to Line.
Two Features 4.	
option

Click the 2 Features option button.

Select 5.	 2D Line 1 In the Feature 1 list, select Line 1.
Select 6.	
Constructed 
Line 1

In the Feature 2 list, select Constructed Line 1.

Create7.	 Click Create to view the result.
Close8.	 Click Close to close the dialog box.
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ACTIVITY: Save A File

To make this information easily accessible, save a file with the data you have collected.

Save As1.	 On the File menu, click Save As. The Save As dialog 
box appears.

My Documents 2.	
Folder

In the Save In drop-down list, select My Documents.

Your3.	  folder Double-click on the CAM2 Q folder and browse to 
your folder.

Enter name4.	 �In the File name box, type Dimension.fcd.
Save5.	 Click Save.

ACTIVITY: Dimensioning Angles

For this activity, you will obtain the angle between Circle 1 and Circle 3 using Bolt Circle 
as the apex.

Dimension 1.	
Angle From 
Features

In the Dimension menu, click Angle From Features. 
The Dimension Angle From Features dialog box 
appears.

Enter name2.	 In the Name box, enter Apex.
Click 3.	 3 Points Click the 3 Points option button.
Select first point4.	 In the first Point list, select Circle 1.
Select second 5.	
point

In the second Point list, select Circle 3.

Select apex6.	 In the Apex list, select Bolt Circle.
Create7.	 Click Create to view the result.
Close8.	 Click Close to close the dialog box.
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Lesson 4: Report

Measure Construct Dimension

Report

Now that you have captured all of your data, the reporting function is an easy 
way to select, display, and save your data.

Lesson Objective

With the assistance of the Help menu, you will be able to create standard 
reports. You will be able to: 

Customize report content.zz

Save a report. zz

Locate and open saved reports.zz

Some of the common report customizations you will use are:

Add or Remove Featureszz

Add or Remove a Picturezz

Save a customized list of featureszz

Choose a report stylezz
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Reporting: Text Reports, Logos, Available Customizations

You access Reports using the Report tab located above the Main window. 
The Report Window appears and the Active Report List opens in the Feature 
panel. You can customize, export, or e-mail CAM2 Q reports in a variety of file 
types.

Double-click any feature in the Not In Report list to move it to the In Report 
list.  Double-click any feature in the In Report list to move it to the Not In 
Report list.  

There are several actions which you can access using the Report Window 
icons. (from left to right)

1. Search: Searches the report for key words.

2. Printer Preferences: Sets printer preferences.

3. Print: Sends the report to the printer.

4. Page Setup: Changes the paper size, margins, and 
whether the printout will be in portrait or 
landscape.

5. Scale: Sets the size of the data on a printed page.

6. Hand Tool: Grabs the report and moves it in the 
window.

7. Magnifier: If the view is set to see all pages of a 
multiple page report, this selects one of 
the pages for a close up view.

8. Zoom Out: Zooms out each time you select the icon.

9. Zoom %: Selects a percentage to increase or 
decrease the screen size.

Automatically add ##
features to the In Report list by 

selecting features in the Features panel 

before  clicking the Report tab
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10. Zoom In: Zooms in each time you select the icon.

11. First Page: Scrolls to the first page of the report.

12. Previous Page: Scrolls to the previous page of the report.

13. Next Page: Scrolls to the next page of the report.

14. Last Page: Scrolls to the last page of the report.

15. Multiple Page: Sets the number of pages that display.

16. Color: Sets the background or page color of the 
report.

17. Watermark: Overlays an image, text, or both onto a 
report. 

You can add text to be watermarked. You zz
can also choose the text direction, font, 
color, size, and bold or italic.
You can add a picture or graphic to zz
be watermarked. Use the Load Image 
button to browse for a picture file. Use 
the size mode, horizontal and vertical 
alignment to set the position of the 
picture.
Both zz Text Watermark and Picture 
Watermark have a slider bar that 
allows for the adjustment of the 
transparency of the watermark.
Select or clear the zz Position radio 
buttons to position the watermark in 
front or behind the report text.
Paper Rangezz  Selects the pages on 
which the watermark will appear.

18. Export Document: Saves the report in specific file formats.

19. Send via E-mail: Sends a report via e-mail in specific file 
formats.



3 . 5 0

M
o

d
u

l
e

 
3

:
 

B
a

s
i

c
 

M
e

a
s

u
r

e
m

e
n

t

Add or Remove Features on a Report

You can add any measured feature to the report. On the Features panel's 
Active Report List, add or remove  features in the report by using the Add or 
Remove arrows.

Document Header Information

To create and add header information, which appears as Session Information, 
to a report:

On the zz Edit menu, click Document Header Information.

On the zz Document Header Information dialog box, type the desired 
information into the Value fields.

Uncheck fields that you do not want to include on your report.zz
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Add or Remove a Picture Preview from a Report

The Report function takes a picture of what is currently showing on the Main 
Window. To add or remove this picture from the report, use the CAD Picture 
button on the bottom of the Report Window.

ACTIVITY: Create A Report With Customized Content

For this activity, you will create a report including custom content.

Open file1.	 On the File menu, click Open.
Select 2.	
Dimension.fcd

Browse to your folder and double-click Dimension.
fcd.

Before clicking the ☛☛ Report tab, make sure the view 
on the Main Window is how you would like it to 
appear on the report. Zoom in on the entire part or 
the area of the part you want to include in the report. 
A good way to zoom in on and orient the part is to 
use the hot keys. The E key zooms all and 6 orients 
the part to a top view.

Report3.	  tab Click the Report tab.
Add features to 4.	
report

On the Features panel's Active Report List, double-
click on the features to add to the report in the Not In 
Report section. You can also use the Add arrows.

Select features 5.	
to add to report

Select the following features to be added to the 
report:  Bolt Circle, Circle 1, Circle 3, Circle 5, Circle 7.

Remove 6.	
features from 
report

On the In Report section at the top of the list, select 
the Down arrow to the left of World to remove it 
from the In Report section. You do not need to add 
World to this report because it represents the device’s 
coordinate system.

Preview report7.	 Scroll through the report using the slider bar on the 
right side of the report page.

View circle data8.	 Notice how the data for the circles is reported. Once 
nominals have been entered, the report will display 
deviation and whether the feature is in or out of 
tolerance. For more information on nominals, see the 
Nominals and Tolerances module.
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Saving a Customized List of Features

You can save the customized data list that you create, so you can recall the 
report you created without having to recreate the customized list.

To do this, use CAM2 Q’s Active Report List feature.

ACTIVITY:  Saving A Customized List Of Features

For this activity, you will save a customized list of features.

New report list1.	 On the Features panel, on the Active Report List, 
select New List from the drop-down list.

Enter name2.	 Highlight New List and type in My Report.
Press 3.	 Enter Press the Enter key.
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View Report Style Options

Click the Report tab to see a preview of your current report. There are several 
available styles of reports: Simple, Tabular, and others.

When not using nominals, a Simple style report may be preferable. When 
nominals are present, a Tabular style report may be preferable. By auto-
hiding, or pinning, the Feature Information panel you can scroll down and 
see the results of the inspection routine.

Save a Report

To save a report, click the Export Document drop-down icon.

From the Export Document icon drop-down list, you can save reports as PDF, 
HTML, MHT, Rich Text , Excel, CSV, Plain Text or a Graphics document (.jpeg, 
.bmp, .gif, .tiff, .png, .emf, or .wmf files).

Opening a Saved Report

To open a saved report, double-click the file name.



3 . 5 4

M
o

d
u

l
e

 
3

:
 

B
a

s
i

c
 

M
e

a
s

u
r

e
m

e
n

t

E-mail a Report

To e-mail a report, first export the report. From the Export Document icon 
drop-down list, you can pick the format of the report. You can e-mail reports 
in all of the available formats (PDF, HTML, MHT, Rich Text , Excel, CSV, Plain 
Text or a Graphics document).

ACTIVITY:  Changing The Report View Style

For this activity, you will change the layout of the report.

Report1.	  tab Click the Report tab.

Select report 2.	
style

In the Edit Layout drop-down box, select Tabular. The 
report now shows the data in tabular view.

Go to page 2 of the report and select ☛☛ Simple to view the differences between 
the two report styles.
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ACTIVITY:  Saving The Report

For this activity, you will save the report.

Save report1.	 From the Export Document icon drop-down list, 
select the HTML Document option.

Export options2.	 In the HTML Export Options dialog box, click OK (We 
will use the default setting for this activity). 

Your folder3.	 Browse to your folder in /My Documents/CAM2 Q.
Enter name4.	 Save the report with the name My Report. If 

prompted to overwrite the existing file, click Yes.
Automatically 5.	
open file

When prompted “Do you want to open this file?” click 
Yes. You can now view the file and close when done.

The file is now saved on the computer in the My Documents/CAM2 Q/
[your name] folder.

ACTIVITY:  Opening A Saved Report

For this activity, you will open a saved report.

Open 1.	 My 
Computer

Click the Windows Start button, and click My 
Computer.

My Documents 2.	
folder

On the left side, in the Other Places section, select 
My Documents.

Your folder3.	 In My Documents, double-click the CAM2 Q folder, 
then double-click your folder.

Open report4.	 Double-click My Report to open it.

ACTIVITY:  Saving The File

For this activity, you will save a CAM2 Q file.

Save As1.	 On the File menu, click Save As.
Your folder2.	 Using the drop-down menu, click My Documents, 

click CAM2 Q, then your folder.

Enter name3.	 In the File name box, type in Report.fcd
Save4.	 Click Save.
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Creating a Report Template

The default report template shows FARO's company information at the top of 
each report. You can create a customized report template with your company 
information.

Select a report format from the combo box at the bottom of the zz
Report panel and click the Edit Layout button. This starts the 
DevExpress template editor.

Select zz File, then  Save As to save the template with a new name . This 
ensures that you do not replace the default CAM2 Q report template.

Save the new template in the zz CAM2 Q, Templates, Reporting folder.

Edit the fields in the zz Report section of the editor.

Savezz  the template.

ACTIVITY:  Creating A Report Template

For this activity, you will create a report template with your company information.

Edit Layout1.	 Select a report format and click the Edit Layout 
button.

Save As2.	 On the File menu, click Save As.
Reporting 3.	
folder

Using the drop-down menu, click My Documents, 
CAM2 Q, Templates, then click Reporting.

Enter name4.	 In the File name box, type [your name].
Save5.	 Click Save.
Edit the 6.	 Report 
fields

Type your company information in the report fields.

Save7.	 Click Save.

Close 8.	 Report 
Designer

Close the Report Designer by clicking the X in the 
upper right corner.

To view your template, select your report template in the Edit Layout drop-down 
box.

Feature Grouping

When you work with a large number of features, it can be helpful to organize 
them using a Group Folder. 

You can use these folders to report features in multiple coordinate systems 
within the same report. You can assign a coordinate system, coordinate 
system type, and unit of measurement for the contents of the folder, and a 
unique screen view for the folder that appears in the report just above the 
features. 
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ACTIVITY:  Creating A Feature Group

For this activity, you will create a feature group folder, edit its properties, capture a view, 
and review your current report template.

CAD tab1.	 Click the CAD tab to return to the Main Window.  

Create a New 2.	
Group Folder

Click the Folder icon in the upper left corner of the 
Features panel.

Name the Group3.	 Select the Group 1 folder, double-click and type 
Circles for the name of the folder. Click Modify 
and then Close to continue.

Add Features4.	 Select the four circles (1,3,5,7) and drag them onto 
the Circles folder.

Set Top View5.	 Press the 4, 5, or 6 hot key to set the top view. Zoom 
In (I hot key) and Pan (Arrow keys) so that the four 
circles fill the Main Window.

Set the Screen 6.	
View

Select the Circles folder. Right-click and select 
Capture View Data from the menu.

Review the 7.	
Report

Click the Report tab and look at the updated report. 
Notice the addition of the screen view of the four 
circles. 

Save Report8.	 From the Export Document icon drop-down list, 
select the HTML option.

Export options9.	 In the HTML Export Options dialog box, click OK (We 
will use the default setting for this activity). 

Your folder10.	 Browse to your folder in My Documents/CAM2 Q.

Enter name11.	 Save the report with the name My Report 2. If 
prompted to overwrite the existing file, click Yes.

Automatically 12.	
open file

When prompted “Do you want to open this file?” click 
Yes. You can now view the file and close when done.

Save As13.	 On the File menu, click Save As.

Your folder14.	 Using the drop-down menu, click My Documents, 
click CAM2 Q, then your folder.

Enter name15.	 In the File name box, type in Report 2.fcd.

Save16.	 Click Save.
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Lesson 5: Review Activities 
Objective: Apply the Basic Measurement Strategy
Complete each of the Review Activities. When you are finished, have your instructor review and initial your 
work. If you have any questions, first refer to the previous modules, next use the Help menu. If neither of 
these provide the information you need, ask the instructor. 

ACTIVITY:  Construct Point

Open a new file and measure the features you need to construct a point for each corner of the zz
demo part appropriately naming each:  Back Right Corner, Back Left Corner, Front Right Corner, 
and Front Left Corner. 

Front Left Corner
Back Left Corner

Back Right Corner

Front Right Corner

ACTIVITY:  Dimension Point To Point

Determine the length from the zz Front Right Corner to the Back Left Corner 
of the demo part. Name it Length 1.
Determine the length from the zz Front Left Corner to the Back Right Corner 
of the demo part. Name it Length 2.

ACTIVITY:  Report

Add zz Length 1 and Length 2 to the Report section.
Export and save a PDF of the report. Name it zz My First Report.

All Activities Complete

Instructor initials: _____________

Date: _____________
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Module 4: 
Move Device

The CAM2 Q software and your measurement device give you many possibilities for 
measuring parts. The Move Device function was designed with complete portability 

in mind. You may not always have the same size part to measure; you may have to 
measure a small part one day and a large part the next; or your device or your part may 
move in between or during a measurement session. In this module, you will learn how 
to move your measurement device and continue measuring.

Prerequisite: Basic Measurement.

Module XX Objectives
You will be able to:

You will be able to move the device and continue to measure a part.zz
Determine how many device positions are needed.zz
Determine appropriate locations for the device.zz
Verify the hardware setup.zz
Determine appropriate action to take when relocation results are not within the zz
required accuracy of the measurement job.
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Scenario: �Move Device

Now we need to measure a bigger part. You are going to have to move the 

measurement device to get all of the measurements we need. If you need help, 

try looking for the information in the CAM2 Q Help menu or on FARO’s website.

I have measured from only one device position so far , and I have to move the 

measurement device to continue measuring my part. What are the things I 

need to think about before I move the measurement device?

Strategy: Move Device

Before measuring, how do you determine the best positions for the zz
device?

Can you ensure a stable mounting at every device position?zz

How many device positions do you need?zz

Will you be able to reach all the features to be measured?zz

Which features will be re-measured from each device position?zz

Move Device 

Move Device is a function that allows you to move the device around the part 
while maintaining the working coordinate system. 
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When To Use Move Device

When a feature on your part is out of the Laser Tracker’s line of zz
sight, this function allows you to move the Laser Tracker to a 
location where the feature is visible to the Laser Tracker then 
measure the remainder of the part.

zz You want to move the device if the relationship between the part 
and the device changes. For example, the device or part may move 
(bumping etc.) or the part may experience change in size due to 
change in temperature (temperature drift). In these instances, you 
can use Move Device to quickly reposition the device into a known 
orientation relative to the part.

An exception: When using the Laser Tracker in large volume applications, 
it might be more accurate to use two device positions. You should check 
the accuracy at both the half-length and the full-length using the Static 
Repeatability Test (as described in Measurement Considerations). If the 
full-length result is acceptable, use one device position.

Feature Window

Monitoring the Relationship Between the Part and the Device

The Feature window shows a Digital ReadOut of a specific feature you 
choose. The DRO in this window shows you where the feature is compared 
to where the SMR is at that time. You can use the feature’s DRO to detect 
changes in the position of the part relative to the measurement device. 

This is accomplished as follows:

On the zz Features panel, click a sphere or point you have measured.

On the zz View menu, click Show Feature Window. The Feature window 
appears.

When you place the SMR at the point location or on the sphere’s surface, the 
values in the window will be “0”.

Placement of the ##
device is important. If possible, it 

is best to measure from only one 

device position. Use the Move Device 

command only when necessary.

Use the ## Feature window 

frequently during a measurement 

session to check for movement, 

especially when working from a tripod.
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It is good practice to periodically place the SMR at the point location or on 
the sphere’s surface If the values are not “0”, it means the relative position of 
the feature/part to the device has changed. 
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Move Device:  Basic Concepts

You need a minimum of three points, or three “point-reducible” zz
features, to complete the Move Device function. This means you can 
use points, circles, or spheres, or any combination.

The three features you choose to measure cannot lay in a straight zz
line. There must be some spacing between the features; think 
triangle.

The features you choose should encompass at least 75% of the zz
part. For example, if your part is 48 x 22 x 18 inches, features that 
encompass only 5 x 5 x 5 inches of the part are not an ideal choice. 

The area local to those points will mathematically fit well, but the zz
locations of any features you measure far away from the relocation 
points will have a greater uncertainty. The right edge of the part is 
also not a point-reducible feature.
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PRE-ACTIVITY:

Option 1
If training files are available

Option 2
If starting with a new file

Open Report.fcd Open a new file

Measure all features Add and measure: 

Point 1zz
Point 2zz
Point 3zz
Point 4zz

zz For the demonstration part, these features are one set that would be 
appropriate.The minimum is three ##

points. For best results use four or 

more points that are not in the same 

plane. 
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ACTIVITY:  Executing a Move Device Position

Show the 1.	
Feature window 
for Point 1

On the Features panel, click Point 1. 

On the View menu, click Show Feature Window.
or press the ☛☛ D hotkey.

Verify the 2.	
Point 1 
measurement

Look in the Feature window for Point 1 by moving 
the SMR to that location.

Has the relationship between the device and the part changed?

Keep in mind that Point 1 was measured earlier. At that time, the values ☛☛
were “0”.)

If the values have not changed, move either the part or device slightly 
and re-check the Feature window for Point 1 again. Notice that the values 
are no longer “0” , and it is now necessary to realign the device and part. 
Whether the relationship between the part and the device changes 
intentionally or unintentionally, the process for realigning the device to the 
part is the same.

Execute the 3.	
Move Device 
command

On the Device menu, click Move Device.

or press the M hotkey.
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Switch to 4.	
Measure Mode

If necessary, click the Measure/Template Mode icon 
so that you are in Measure mode. 

Select 5.	 Points 1 
through 4

On the Features panel, select Points 1 through 4. 
(CTRL + click Point 1, Point 2, Point 3, Point 4)

Remeasure all 6.	
features

On the Device Manager window’s Properties 
section, click Add Features, then click Remeasure All.

You will then be prompted to remeasure Points 1 through 4, which allows 
the software to re-position the device.

Make sure to re-measure the points in the correct order (i.e. when the ☛☛
software prompts you to measure Point 1, make sure it is Point 1 you are 
measuring). Measuring in the wrong order will result in inaccurate re-
positioning of the device.

Solve the new 7.	
device position

Click Solve. The software mathematically realigns the 
device to the part.
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Save the file as 8.	
Move Device.
fcd

On the File menu, click Save As. Browse to your 
folder.

Name the file Move device.fcd and click Save.

Reviewing Device Positions

If you just need to review and edit existing device positions, use the Device > 
Device Manager command. Using the Device > Move Device command will 
open the Device Manager panel AND add a new device position. 
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Module 5: 
Coordinate Systems

So far, you have learned the basic strategy to follow when performing a 
measurement job: Measure, Construct, Dimension, and Report. You have also 

learned about some of the environmental and calibration considerations when you 
measure.

Now, we will cover creating coordinate systems. Using the features that you construct, 
a coordinate system gives your measurements a framework for defining location. Using 
the appropriate coordinate system as you measure parts plays a critical role in the 
interpretation of the data. Creating coordinate systems on a part requires analyzing the 
part and determining where the coordinate system or systems should originate. In this 
module, we will also determine the best features with which to create your coordinate 
system.

Prerequisite: Basic Measurement.

ModuleXX  Objectives
You will be able to:

List at least two reasons for creating coordinate systemszz
Analyze requirements to determine effective coordinate system locationzz
Identify the effect on the data of the chosen primary axis for the coordinate systemzz
Identify the attributes of a repeatable coordinate systemzz
Recognize the impact of feature selection on the datazz
Create a coordinate system using any of three techniqueszz
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Scenario: Adding Coordinate Values

The boss says, “ The report is great. Thanks for your hard work; the customer 

will be pleased with how quickly we provided the data. Can we add coordinate 

values?”

Strategy: Coordinate Systems

What are the dimensions, lengths, and feature positions of the zz
part that I need to report?

Where is the most logical placement for the coordinate system?zz

Which features do I need to measure and/or construct to create zz
the coordinate system?

Are multiple coordinate systems required?zz

What is a Coordinate System

A coordinate system is a frame of reference that allows you to find the unique 
position of a point in a plane or in space, and to see the relationship between 
two points in space.

Why Use a Coordinate System

Placing a part into a coordinate system enables you to:

Effectively report measured features – Since you have a unique zz
position identified for each point and feature, your report can very 
clearly and specifically describe the location and dimensions of the 
features and part.

Establish a reference for all part measurements so the data on the zz
part ia aligned to the same reference points in a blueprint or CAD 
file. This enables straightforward comparisons between feature 
measurements and nominals.

Accurately report the condition of a part to someone analyzing your zz
measurement file who does not have access to the physical part. 

I need a coordinate system on my part to provide a framework for my 

measurements. Where should I position my X, Y, and Z axes?  Do I need 

more than one coordinate system for reference?
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Think of a three dimensional coordinate system as a three dimensional map:

N
W

E
S

Imagine that you want to give someone directions from the train station to 
the 3rd floor of the tall building in the map above. 

If you add three dimensional coordinates to the map, you can use those 
coordinates to describe how many streets to go in the “X” direction (4); then 
how many streets to go in the “Y” direction (3); and finally and how many 
floors to go up in the “Z” direction (3).

N
W

E
S

y

z

x

5

4

3

2

1

0

1

2

3

4

Right-Hand Rule

Cartesian coordinates describe the position of points in space relative to 
three mutually perpendicular axes X, Y, & Z.  The intersection of these axes 
form the origin, or zero of the system.

Each axis emanates from the origin according to the right-hand rule.  The 
right-hand rule defines the positive direction of each axis, such that when 
the hand is positioned according to the figure below, the + Z points along 
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the thumb, the + X axis points along the index finger, and the + Y axis points 
along the middle finger.

CAM2 Q does not support left-hand rule coordinate systems. ☛☛

Feature Selection

The accuracy of the measurements you take in your coordinate system relies 
heavily on the consistent accuracy of the machined features you use to 
define your coordinate system.

For repeatability, look for the following when selecting features to define 
your coordinate system:

Surfaces that have a smooth finish:zz  These provide the most 
consistent repeatable measurements. 

Features critical to part machining:zz  These generally will be more 
carefully controlled than those not critical to machining and therefore 
will be consistent. 

Features that are relatively large compared to the part size.zz

Features that have a low measured Form value.zz
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Defining Coordinate Systems Using 3-2-1

You can define coordinate systems in a variety of ways. The simplest is the 
3-2-1 or Plane-Line-Point method. 3-2-1 describes the minimum number of 
points that you use to define the base features of a coordinate system – a 
Plane (3 points), a Line (2 points) and a Point (1 point).

Standard construction diagrams of plane, line and point showing how they 
create a coordinate system: 

Plane

Line

Point

(Center point of the Circle)

+Z

+Y

+Y

+X

+X
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PRE-ACTIVITY:

Option 1
If training files are available

Option 2
If starting with a new file

Open Advanced 1.fcd Open a new file

Measure all features Add and measure/construct:

Plane 1zz
2D Line 1 (across the front of the zz
part on the handle side)
Circle 1zz
Circle 3zz
Circle 5zz
Circle 7zz
Cylinder 9zz
Sphere Azz
Bolt Circlezz
Intersection Point (of Plane 1 and zz
Cylinder 9)
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ACTIVITY:  Create A Coordinate System

For this activity, you will construct a coordinate system using 3-2-1 (plane, line, point).

Start 1.	
Coordinate 
Systems 
command

On the Coordinate Systems menu, click Create Using 
the Wizard.

or press the ☛☛ C hot key.

Dialog box2.	 The Construct Coordinate System Using The Wizard 
dialog box appears.

Enter feature 3.	
name

In the Name box, enter 3-2-1.

Basic4.	  tab Click the Basic tab.
Choose a plane 5.	
for +Z

In the Plane Feature list, select Plane 1. In the Axis list, 
select +Z.

Choose a line 6.	
for +X

In the Line Feature list, select 2D Line 1. In the Axis 
list, select +X.

You have now selected what will be the Z and X axes of your parts 
coordinate system. 

Choose a circle 7.	
for the origin

In the Point Feature list, select Bolt Circle.

This identifies your origin, or the point where your X, Y, and Z will all be “0”.

Align with 8.	
World

Select the Align with box. From the Align with list, 
select World.

This aligns the coordinate system you are creating on the part with 
coordinate system of the device. From now on, any measurements you take 
will use the part coordinate system as a reference.

OK9.	 Click OK.

Notice the Active Coordinate System toolbar at the top of the screen. Your 
coordinate system, 3-2-1, now shows in the drop-down list and replaces 
World as the active coordinate system.  When you work with multiple 
coordinate systems, this is where you will control which coordinate system is 
active. 

Save As10.	 On the File menu, click Save As.
Your folder11.	 Using the drop-down menu, click My Documents,  

CAM2 Q, and then double-click on your folder.
Enter name12.	 In the File name box, type in CS1.
Save13.	 Click Save.

If necessary, set the SW Isometric View and Zoom All to see your complete 
file by pressing the E and 8 hot keys. These commands are also available in 
the View menu. 
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Create A Coordinate System

Using a Line as Primary

If the longest, most important feature on your part is a line, you can use the 
Line as Primary option for creating your part coordinate system.

As you choose features   
for each of these coordinate systems, 

notice the difference between the 

Measured and Constructed features 

by the geometry icon to the left of the 

feature name.

ACTIVITY:  View Report

For this activity, you will view a report.

Report1.	  tab Click the Report tab.
Choose report 2.	
list

On the Features panel’s, Active Report List, select My 
Report. 

Or, you may add the features to the In Report section.☛☛
View report3.	 Observe the feature data on the report. The X, Y, and 

Z values are now relative to the coordinate system 
origin you created for the part. 

CAD4.	  tab Click the CAD tab.
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ACTIVITY: Create A Coordinate System Using A Line As Primary

For this activity, you will construct a coordinate system using a Line as Primary.

Start 1.	
Coordinate 
Systems 
command

On the Coordinate Systems menu, click Create Using 
the Wizard.

or press the ☛☛ C hot key.

Dialog box2.	 The Construct Coordinate System Using The Wizard 
dialog box appears.

Enter feature 3.	
name

In the Name box, enter Line as Primary.

Advanced4.	  tab Click the Advanced tab.
Choose a line 5.	
for +Z

In the Primary section, select the Line button. In the 
first feature list, select Cylinder 9. In the Axis list, select 
+Z.

Choose a line 6.	
for +X

In the Secondary section, select the Line button. In 
the first feature list, select 2D Line 1. In the Axis list, 
select +X.

Choose a point 7.	
for the origin

In the Origin section feature list, select Circle 3. 

Align with 8.	
World

Clear the Align with box.

OK9.	 Click OK.

ACTIVITY:  View Report

For this activity, you will view a report.

Report1.	  tab Click the Report tab.
Choose report 2.	
list

On the Features panel, in the Active Report List, select 
My Report.

View report3.	 Observe the feature data on the report. The X, Y, Z 
values have changed because your coordinate system 
has changed. 

X

Y
Z

X

Y
Z

X

Y
Z

X

Y
Z

X

Y
Z

CAD4.	  tab Click the CAD tab.
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ACTIVITY: Create A Coordinate System (Origin Options)

For this activity, you will construct a coordinate system using different origin options.

Start 1.	
Coordinate 
Systems 
command

On the Coordinate Systems menu, click Create Using 
the Wizard.

or press the ☛☛ C hot key.

Dialog box2.	 The Construct Coordinate System Using The Wizard 
dialog box appears.

Enter feature 3.	
name

In the Name box, enter Origins.

Advanced4.	  tab Click the Advanced tab.
Primary5.	 In the Primary section, select the Plane button. 

Select Plane 1. In the Axis list, select +Z.
Secondary6.	 In the Secondary section, select the Line button. 

Select 2D Line 1. In the Axis list, select +Y.
Choose origin7.	 In the Origin section feature list, select Sphere A. 

Select Hold Position.  Clear the Align with box.

OK8.	 Click OK.

You now have a coordinate system with the origin at the center of the 
sphere. Now, let’s modify the origin.

Origins9.	  
properties

On the Features Panel, select Origins, double-click to 
edit the feature properties.

Choose origin10.	 Select Hold to Primary.
Modify11.	 Click Modify and move the window so you can see 

the coordinate system location on the screen.

You now have a coordinate system with the origin at the closest point on 
the plane to the sphere. Press Hot Key 6 for a top view. Now, let’s modify the 
origin again.

Create A Coordinate System (Origin Options)

Origin Options

There are several origin options when creating a coordinate system.

Hold Position: the coordinate system is at the center of the feature.zz

Hold to Primary: the coordinate system is at the closest point on the zz
primary feature from the origin feature.

Hold to Secondary: the coordinate system is at the closest point on zz
the secondary feature from the origin feature.

Hold to Key-In: the coordinate system corresponds to the location zz
(primary, secondary and origin) keyed-in.
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Choose origin12.	 Select Hold to Secondary.

Modify13.	 Click Modify and then click Close.

You now have a coordinate system with the origin at the line.

ACTIVITY:  View Report

For this activity, you will view a report.

Report1.	  tab Click the Report tab.
Choose report 2.	
list

On the Features panel’s Active Report List, add all 
features to the In Report section.

View report3.	 Observe the feature data on the report.
CAD4.	  tab Click the CAD tab.

ACTIVITY:  Saving The File

For this activity, you will save a CAM2 Q file.

Save As1.	 On the File menu, click Save As.
Your folder2.	 Using the drop-down menu, click My Documents, 

CAM2 Q, then double-click your folder.
Enter name3.	 In the File name box, type in CS2.fcd.
Save4.	 Click Save.
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Module 6: 
Nominals and Tolerances

You have just created a coordinate system. Now, you will learn how to compare 
your part’s actual measurements to the design specifications. 

Prerequisite: Coordinate Systems.

Module XX Objectives
You will be able to:

Incorporate nominals and tolerances into the measurement process and report any zz
variances.
Identify the appropriate XYZ values of the nominals.zz
Identify the change in tolerance due to feature size or decimal places.zz
Change and save tolerance options.zz
Use alternative reporting options.zz
Use alternative nominal association and automatic feature construction workflow.zz
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Scenario: �Nominals and Tolerances 

You gave the report to your boss and he says, “ This looks great, but how 

does this compare to the customer’s blueprint? How can I tell if the part is 

manufactured according to the specifications on the blueprint? 

I now have to add nominals and tolerances in order to compare actual 

measurements with design specifications. How can I incorporate nominals 

and tolerances into my measurement and reporting process?

Strategy: Nominals and Tolerances

What are the best methods for entering nominals and tolerances for zz
this part?

How will nominals and tolerances help me report the data? zz

Definitions: Nominals & Tolerances

Nominals are the designed values of the part. The numbers specified on a 
blueprint are nominal values. 

Tolerances are the acceptable difference between the actual measured value 
and the nominal value of a feature.

You determine the quality of a part by comparing your actual values to the 
nominal values within a tolerance range. 

Entering Nominals:  Circle Example

Prior to entering nominals, it is necessary to select the appropriate coordinate 
system for referencing the nominals.

There are three nominals that you can key-in for a circle:

Center: A positional element defining the location of the 
circle relative to the coordinate system;

The Normal: The orientation of the circle relative to the 
coordinate system; and

Diameter: The size of the circle.
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You can type a value in any unit, and CAM2 Q will convert the value to the ☛☛
default unit value. For example, the measurement file’s unit of measurement 
is millimeters but the diameter is 10inches. Type 10in and CAM2 Q will 
automatically convert the value to 254 millimeters.

PRE-ACTIVITY:

Option 1
If continuing from the 
previous module with 

no device or part setup 
changes

Option 2
If your device or part 
setup has changed

Option 3
If starting with a new 

file

Open CS1.fcd Open Advanced 1.fcd Open a new file

Measure:

Plane 1zz
Circle 1zz
Circle 3zz
Circle 5zz
Circle 7zz

Create CS1 from 
ACTIVITY: Create 
Coordinate System 
in the Coordinate 
Systems module.

Add and measure/
construct:

Plane 1zz
Circle 1zz
Circle 3zz
Circle 5zz
Circle 7zz
Bolt Circlezz

Create CS1 from 
ACTIVITY: Create 
Coordinate System in 
the Coordinate Systems 
module.
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The Feature Information Panel

The Feature Information panel displays nominal (or target) values, actual 
values, and variations for a variety of positional and statistical elements. Key 
values are:

X, Y, Zzz

3D Distancezz

Diameterzz

Form (GD&T tolerance)zz

The OOT (Out of Tolerance) column indicates whether the feature measured 
is within acceptable tolerance limits.

Passzz  (1) and the color green indicate that the feature is within tolerance.

A zz number (2) (indicating how much out of tolerance the value is) and 
a red or blue color indicates how much the value is out of tolerance. 
If the feature is out of tolerance on the high side (3) the color is red; if 
the feature is out of tolerance on the low side (4) the color is blue. 
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ACTIVITY:  Entering Nominal Data

For this activity, you will select a coordinate system and key in Nominals.

Highlight 1.	 Circle 1 On the Features panel, click Circle 1.
Expand Feature2.	 To the left of the feature name, click the right 

arrow to expand Circle 1. You now see the actual 
and nominal features of Circle 1. Notice that the 
nominal feature is gray because it does not exist yet. 

Open the 3.	 Feature 
Information panel

Click the Feature Information tab.

Key In nominals for 4.	
Circle 1

In the Center x Nominal cell, enter 0.00mm

In the Center y Nominal cell, enter 70.00mm.

In the Center z Nominal cell, enter 0.00mm

In the Diameter Nominal cell, enter 20.00mm.
Highlight 5.	 Circle 3 On the Features panel, click Circle 3.
Key In nominals for 6.	
Circle 3

In the Center x Nominal cell, enter 70.00mm

In the Center y Nominal cell, enter 0.00mm.

In the Center z Nominal cell, enter 0.00mm

In the Diameter Nominal cell, enter 20.00mm.
Highlight 7.	 Circle 5 On the Features panel, click Circle 5.
Key In nominals for 8.	
Circle 5

In the Center x Nominal cell, enter 0.00mm

In the Center y Nominal cell, enter -70.00mm.

In the Center z Nominal cell, enter 0.00mm

In the Diameter Nominal cell, enter 20.00mm.
Highlight 9.	 Circle 7 On the Features panel, click Circle 7.
Key In nominals for 10.	
Circle 7

In the Center x Nominal cell, enter -70.00mm

In the Center y Nominal cell, enter 0.00mm.

In the Center z Nominal cell, enter 0.00mm

In the Diameter Nominal cell, enter 20.00mm.

You have just keyed in the nominals for the four circles that you used to 
construct the bolt circle in an earlier exercise.  Now, you will key in the 
nominals for the Bolt Circle you created in the earlier exercise.

Highlight 11.	
Bolt Circle

On the Features panel, click Bolt Circle.
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Changing Tolerances Settings

The Out of Tolerance (OOT) values you see are the result of default tolerances. 
You can manually change these tolerances or they can be set prior to taking 
any measurement.

On the zz Edit menu, click Preferences, and then click Tolerance and 
Geometries tab. 

ACTIVITY:  Changing Tolerance Settings 

For this activity, you will change tolerance settings in the Feature Information panel.

Highlight the 1.	
Bolt Circle

On the Features panel, click Bolt Circle.

Open the 2.	 Feature 
Information 
panel

Click the Feature Information tab.

Enter an Up 3.	
Tolerance of 
.00001 

On the Feature Information panel’s Circularity row, 
enter .00001 in the Up Tol column, and press Enter.

Notice that the cell in the OOT column is displaying a color and a number. 
Since you set the tolerance limit very low, the value is beyond the tolerance 
limit. The color red indicates that the form value is higher than the tolerance 
you specified and the number indicates how far the value is out of form 
tolerance.

Change the Up 4.	
Tolerance to .5

In the Circularity row, in the Up Tol column, enter .5 
and press Enter.

Notice that the cell in the OOT column is displaying the color green and the 
word Pass. Since you set the tolerance limit very high, the value is well within 
the tolerance limits.

Save your file 5.	
with a new name

On the File menu, click Save As.

Enter Nominals 1.fcd as the file name.

Key In nominals for 12.	
Bolt Circle

In the Center x Nominal cell, enter 0.00mm

In the Center y Nominal cell, enter 0.00mm.

In the Center z Nominal cell, enter 0.00mm

In the Diameter Nominal cell, enter 140.00mm.
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ACTIVITY:  Copying Tolerances 

For this activity, you will change tolerances for a feature and copy them to other similar 
features. 

Edit the tolerances 1.	
a circle

Select Circle 1 in the Features panel.

In the Feature Information panel, clear the 
Z dimension and 3D Distance checkboxes.

Edit the X dimension, Y dimension, and Diameter 
tolerances as follows:

Lower Tolerance ❐❐  -0.25 mm.

Upper Tolerance  ❐❐ +0.25 mm.

Now you can copy the tolerances to the other three circles.

Copy the 2.	
Tolerances 

Select Circle 1 in the Features panel.

Right-click and select Copy Tolerances. 
Paste the 3.	
Tolerances

Select Circle 3 in the Features panel.

Right-click and select Paste Tolerances.
Paste to remaining 4.	
circles

Repeat for circles 5 and 7.

Setting Tolerances in a Measurement File

The default tolerances for each feature type are a preference in the 
measurement file. Use the Preferences command to change tolerance values 
for future features or apply a set of tolerances to all existing features. CAM2 Q 
also supports DIN/ISO tolerance schemes.

You can also use the Copy Tolerances and Paste Tolerances commands from 
the Edit menu to copy tolerances from a feature and paste to another similar 
feature. For example, modify the tolerances of a circle, copy, and paste to 
other circles in your drawing file. 

Save time by setting the ##
feature tolerances before adding any 

features to the measurement file. 
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PRE-ACTIVITY:

Option 2
If your device or part setup has 

changed

Option 3
If starting with a new file

Open Advanced 3.fcd Open a new file

In Template Mode: 

Add the following nominal zz
features from the Key-In menu:

Circle 1 (0, 70, 0)zz
Circle 3 (70, 0, 0)zz
Circle 5 (0, -70, 0)zz
Circle 7 (-70, 0, 0)zz

Construct the nominal Bolt Circle zz
using Circles 1,3,5,7.

Add the following actual features zz
from the Measure menu:

Plane 1zz
Line 1zz
Circle 9zz

Create a Coordinate System using zz
Plane 1, Line 1 and Circle 9.

An Alternative Workflow

In the previous activities, you added nominal values to existing measured 
features. However, you can also set up the measurement file with all of the 
nominal features before connecting the measurement device. Then use the 
Add Measurement function to create measured (actual) features from the 
existing nominal features.  
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ACTIVITY:  Adding Measurements To Nominals

For this activity, you will add a measurement to the nominal bolt circle which 
automatically creates and associates a measured feature to each nominal circle.

Add readings to 1.	
coordinate system 
features

Select Plane 1, Line 1 and Circle 9 in the Features 
panel. From the Measure menu, select Add 
Readings. 

You can also right-click the selected features and ☛☛
select the Add Readings command from the 
menu. 

Measure the 2.	
features

Watch the prompt area of the Measurement 
Window for instructions to measure the plane, line 
and circle. 

Add a 3.	
measurement to 
the Bolt Circle

Select Bolt Circle. Right-click and select Add 
Measurement from the menu.

Add Measurement automatically adds actual features to all of the nominal 
features that construct the Bolt Circle. Each of the four circles (1,3,5,7) now 
have an actual feature associated to its nominal, and the Add Readings 
command automatically starts.  

Measure each 4.	
circle

Watch the prompt area of the Measurement 
Window for instructions to measure each of the four  
circles.

Now that each of the circles has solved, the Bolt Circle solves.

Save your file with 5.	
a new name

On the File menu, click Save As.

Enter Nominals 2.fcd as the file name.

Review results6.	 Select the Bolt Circle and look at the results in the 
Feature Information panel. 

Select other circles and review the results of the 
measurement.

Change tolerance settings for any of the circles as 
you did earlier in this module.
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Module 7: 
Review Activities

Complete each of the Review Activities. When you are finished, have your instructor 
review and initial your work. If you have any questions, first refer to the previous 

modules, next use the Help menu. If neither of these provide the information you need, 
ask the instructor. 

Prerequisite: Basic Measurement, Coordinate Systems, Nominals and Tolerances.

Module XX Objectives
You will be able to:

Demonstrate ability to use Measure, Construct, Dimension, and Report software zz
menus, add nominals, set tolerances, identify variations between nominals and 
actual measurements, create and configure a final report. 
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ACTIVITY:  Coordinate System

Open a new file (make sure mm is the current measurement unit).zz

Create the coordinate system in the figure below.  Measure the features needed and align to the zz
part. (Hint:  Pay attention to the origin location and direction of the ‘x’ axis)

x

y

E

2

4

7

8
9

10
F

A

C D

B

11 12

6
5

G

H

P1 P2

P3 P4

Final Review Activities 
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ACTIVITY:  Nominals, Tolerances, And Constructions

Measure and then enter the following nominals for circles 1, 3, 5, and 7:zz

You can also add the nominals first, and then add measurements to the nominals.☛☛

1 = “0,70,0”;  Diameter = “20mm”

3 = “70,0,0”;  Diameter = “20mm”

5 = “0,-70,0”; Diameter = “20mm”

7 = “-70,0,0”; Diameter = “20mm”

Enter a +/- tolerance of zz .25 mm.

Create a bolt hole circle using circles 1, 3, 5, and 7.zz

The Bolt Hole Circle diameter nominal is zz 140 mm.

Bolt Hole Circle Diameter = ________________mm.zz

Bolt Hole Form = _____________mm.zz

Are the form and diameter within tolerance? How do you know?zz

ACTIVITY:  Constructions And Tolerances

Construct a circle at the intersection of zz Cone E and the top plane of the part.

The circle diameter nominal is zz 29.99 mm.

Enter a +/- tolerance of zz .25 mm.

Circle Diameter = _________________mm.zz

Is it in tolerance?  How do you know?zz

ACTIVITY:  Dimensions

Dimension the angle between circles 1, 5, and 7 using 5 as the apex.zz

Angle = ___________________degrees.zz

ACTIVITY:  Reports

View the report.zz

Report all elements measured and constructed above.zz

Save the report as a PDF titled “zz Final Review Activities” in your folder.

All Activities Complete

Instructor Initials: _____________

Date: _____________



08m13e15 - CAM2 Q v1.5 - FARO Laser Tracker Training Workbook - October 2010.pdf  Part# 12053-001

8 . 1

M
o

d
u

l
e

 
8

:
 

W
o

r
k

i
n

g
 

w
i

t
h

 
C

A
D

Module 8: 
Working with CAD

In this module, you will become familiar with using a CAD file as nominal data for your 
part inspection.

Prerequisite: none 

Module XX Objectives
You will be able to:

Import a CAD modelzz
Identify the translatable CAD model file formats zz
Prepare a CAD model for easy use in inspectionzz
Define nominal features and surfaces from the CADzz
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Scenario: Working with CAD

The boss says, “These results are great, but it has taken a lot of time to key-in all of the 

nominal information for the features. We need to measure a bigger part and we need 

the results quickly. You are going to have to import and prepare a CAD model to use in 

the inspection process. This is going to reduce the inspection time and get the results 

to the customer more quickly. If you need help, try looking for the information in the 

CAM2 Q Help menu or on FARO’s web site.”

Strategy: Working with CAD

How do you decide if you should use CAD?zz

What is the file format of the CAD? zz

Can I get the CAD into a translatable file format?zz

Have I prepared the CAD to be inspected?zz

The use of a CAD model can help decrease inspection time and reduce error, 
making the inspection process easier and more accurate.

The workflow improves and inspection time is reduced by having the 
nominal information for each feature already calculated in the CAD file. The 
nominal information is extracted from the CAD model and automatically 
associated to the measured feature.  Eliminating the need to manually key-in 
information increases operator productivity and reduces the risk of error.  

Types of CAD Data

There are three types of CAD data: wireframe, surface, and solid. 

Wireframe: These entities define the outline of a part. They can include 
points, circles, arcs, lines, polylines and splines. A polyline is a group of line 
segments stitched together to approximate a curve. A spline is a simple 
curve.

Surface: A surface is used to define the outer boundary of a part. Surfaces are 
typically used for complex curved parts such as automotive and aerospace 
sheet metal parts. Surfaces are very popular for creating cutting paths for 
CNC cutting tools.

“I have the CAD model. What are the things I need to think about before 

beginning the inspection process? Is the model ready for use in the 

inspection process? If not, what steps do I have to perform in order to use 

the CAD model?”
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Solid: A solid model is also used to define the outer boundary of a part, but 
solids have a thickness or mass. Solid modeling is popular for the design of a 
variety of parts. Many CAD systems start with a solid model then create the 
2D drawings and 3D surfaces from the solid.

Standard CAD Data File Formats

CAM2 Q is built with the Parasolid file format (*.x_t). You should always try to 
export from your CAD system to this file format. 

If the Parasolid file format is not available, the following CAD data file formats 
are included with CAM2 Q. Translators for other CAD data file formats are 
available and must be purchased from FARO.

IGES:  IGES (Initial Graphics Exchange Standard) was created to standardize 
data transfer between different CAD systems. IGES works very well for surface 
and wireframe entities, but not for text and dimensions.

VDA:  VDA is similar to IGES in that it is a standard used to translate data 
between different CAD systems. VDA is particularly prevalent in Europe.

When To Use CAD

When inspecting only simple features, use a wireframe CAD model.zz
When inspecting surfaces, use a solid or surface CAD model.zz
When the part is complex and/or has many surfaces and features that zz
need to be inspected, use a solid or surface CAD model.  

Using CAD with CAM2 

CAM2 Q translates a CAD file into a Parasolid (.x_t) file format that can be 
imported to a CAM2 Q measurement file using the following methods: 

CAM2 Q automatically translates and adds most CAD files using the 1.	 Open 
command from the File menu. 

Translating multiple CAD files with CAM2 Q is a two-step process: 2.	

First, translate the CAD file using the zz FARO CAD Translator command 
from the File menu. 

Once translated, add the file using the zz Import CAD command from 
the File menu. 

Currently, this is the only method to translate SolidWorks files. 

If the features on the CAD are not drawn appropriately for inspection, they ☛☛
need to be constructed and relabeled before importing into CAM2 Q. 

Another time saver is preparing nominals before measurement. This results in ☛☛
a smoother and easier workflow for the end operator by saving time (use of a 
prepared CAD model) and eliminating the opportunity to enter an incorrect 
nominal value (use of Pick from CAD nominal vs. Key-In nominal).  
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ACTIVITY: Import CAD Files

In this activity, you will import a translated CAD file:

New file1.	 From the File menu, select New.
Import CAD2.	 From the File menu, select Import, then select CAD. 
Select file3.	 From the \CAM2 Q v1.5 Training Files folder, select 

Demo Part Q.x_t. Click Open.

Features on the CAD model may not be drawn appropriately for inspection. 
For example, some drafters and CAD programs will use two arcs and two 
lines to define a round slot. Because the nominal geometry is not a slot, the 
nominal will not automatically associate to the measured round slot. In order 
to auto associate the nominal slot to the measured slot, we need to first 
create a nominal round slot on the CAD geometry.

Defining nominals prior to inspection can decrease inspection time.  

ACTIVITY: Define Nominal Features And Surfaces From The CAD

In this activity you will pick features from CAD model and rename Circle 1, Circle 3, 
Circle 5, Circle 7 and Circle 9 from the Demo Part Q.x_t CAD file. Use the map of the 
training part to determine the locations of the circles.

Pick from CAD1.	 On the Feature Creator, click Pick From CAD.
Circle2.	 Click Circle.
Add 3.	 Circle 1 On the Pick Circle from CAD window, check the 

name for Circle 1 and click on the circle’s edge on the 
CAD model. Circle 1 appears in the Features panel.

If clicking the edge does not return a circle, continue ☛☛
clicking at least two more points on the edge to 
define a circle. 

Add other 4.	
circles

With the Pick Circle from CAD window remaining 
open, first rename and then click on the edge for 
Circle 3, Circle 5, Circle 7 and Circle 9.

Close5.	 Click Close.

Pick Round Slot 1 and rename it as Round Slot F from the .x_t CAD file. Use the map of 
the training part to determine the location of the slot.

Pick from CAD1.	 On the Feature Creator, click Pick From CAD.
Round Slot2.	 Click Round Slot.
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Add 3.	 Round Slot From the Pick Round Slot from CAD window, click 
on the round slot’s edge. Round Slot 1 appears in the 
Features panel.

If clicking the edge does not return a round slot, ☛☛
continue clicking three points that define the arc 
edge on one end of the slot and on three points that 
define the arc edge on the other end of the slot.

Close4.	 Click Close.
Rename feature5.	 From the Features panel, right click on Round Slot 1 

and select Rename. Backspace and rename the 
feature as Round Slot F.

Save the CAD file that you have prepared for inspection:

Save As1.	 From the File menu, select Save As.
Your folder2.	 Browse to your folder and type WWCAD.fcd.
Save3.	 Click Save.
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Module 9: 
QuickTools Programming

In this module, you will become familiar with recording, editing, and playing a 
QuickTools program. You will create this program with and without the measurement 

device connected to your computer.

Prerequisite: Basic Measurement, Coordinate Systems, Nominals and Tolerances

Module XX Objectives
You will be able to:

Build a repeatable measurement routine using measurements, constructions, zz
dimensions, and reporting
Save, open, edit, and run a repeatable measurement routinezz
Design a program that performs an accurate metrological inspection of a partzz
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Scenario: QuickTools Programming

A typical QuickTools program takes an operator through the steps of a part program 

with digital pictures of the part and color-coded targets to make the program operator-

friendly.  QuickTools programming while recording allows you to create a program 

by automatically capturing measurement commands using a measurement device. 

QuickTools programming while not recording allows you to create a program by 

selecting features from the available menus without using a measurement device. 

“I can create a QuickTools program which contains a set of measurement 

commands for repetitive part measurement. What are the things I need to 

think about to make the QuickTools program as effective and user-friendly 

as possible? 

Strategy: Working with QuickTools

QuickTools allow you to save a set of CAM2 Q commands in a list to run 
anytime the drawing file is open, facilitating repeatable part measurement. 
You can create multiple QuickTools programs in a single measurement file 
and play them whenever you choose.

QuickTools Program Commands

QuickTools programs may contain many CAM2 Q commands; however, 
Construction, Dimension, Coordinate System, Alignment, and Device Position 
commands are not added to programs since these features are dependent on 
data to solve. 

QuickTools Program Context and Usability

You can increase usability of the QuickTools program for all operators by 
including pictures of the part to be measured (including depictions of the 
precise locations at which to take measurements), and important textual 
information for any command in the program.  The more detail you provide, 
the easier your QuickTools program will be to use.



08m13e15 - CAM2 Q v1.5 - FARO Laser Tracker Training Workbook - October 2010.pdf  Part# 12053-001

9 . 3

M
o

d
u

l
e

 
9

:
Q

u
i

c
k

T
o

o
l

s
 

P
r

o
g

r
a

m
m

i
n

g 

QuickTools Panel Commands

At the bottom of the QuickTools panel is the QuickTools toolbar.

! The New Program button creates a new QuickTools program.

" The Delete button erases a specific command in the list of commands (or 
erases a program entirely).

# The Play button executes the sequence of commands in the current 
program.

$ The Pause button pauses the current program.

% The Stop button stops the current program.

& The Record button allows you capture all future commands into the 
QuickTools program (until you click the Stop button).

' The Lock QuickTools button allows you to secure the QuickTool from 
being edited, overwritten, or deleted from the measurement file. This lock 
uses a unique password.

Caution: If you forget a password there is no way to recover it. Consider 
keeping a backup copy of the measurement file with a QuickTool that is 
not password-protected.

( The Help button launches the QuickTools section of the CAM2 Q help file. 

) The Tools drop-down menu has special commands to add to a program.

View Reportzz  - Displays an existing report template and report list.
Add Commentzz  - Adds a text message. 
Change Adapterzz  - Changes an SMR adapter on the FARO Laser 
Tracker.



9 . 4

M
o

d
u

l
e

 
9

:
Q

u
i

c
k

T
o

o
l

s
 

P
r

o
g

r
a

m
m

i
n

g 

Programming in Measure and Template Modes

You may add commands to QuickTools programs while in either Measure 
mode or Template mode. This gives you the flexibility of creating a 
QuickTools program while simultaneously performing live measurements 
(Measure mode), or creating a QuickTools program without using a 
measurement device (Template mode). 

This chart highlights the differences between recording QuickTools programs 
in Measure or Template mode.

Recording a QuickTool in Measure Mode Recording a QuickTool in Template Mode

Insert 
Measurement 
Feature

Adds feature to measurement filezz

Adds measurement command to the zz
QuickTool

Prompts operator to measure featurezz

Adds feature to measurement filezz

Manually Invoke 
“Add Readings”

Adds measurement command to the zz
QuickTool

Prompts operator to measure featurezz

Adds a measurement command to the zz
QuickTool

PRE-ACTIVITY:

Option 1
If using CAD

Option 2
If not using CAD

Open a new file. Open a new file.

Import the CAD file: 
\CAM2 Q\
CAM2 Q v1.4 Training Files\
Demo Part Q.x_t
Pick From CAD:

Circle 1zz
Circle 3zz
Circle 5zz
Circle 7zz

Key-In nominal features in Template 
Mode:

Circle 1zz
Circle 3zz
Circle 5zz
Circle 7zz
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ACTIVITY: Creating A New QuickTools Program

In this activity, you will create a new QuickTools program using the QuickTools panel.  

Open the 1.	
QuickTools panel

Click the QuickTools tab in the lower right side of 
the screen to open the QuickTools panel. 

Create a 2.	
QuickTools 
program

Click New Program. A new (blank) QuickTools 
program will appear as New Program 1.

Rename the 3.	
QuickTools 
program

Rename the QuickTools program by selecting 
New Program 1 and typing Practice Program.

ACTIVITY: Adding Features To A QuickTools Program In Measure 
Mode 

In this activity, you will add measurement commands to the “Practice Program” 
QuickTools program in Measure mode.

Begin recording1.	 Click the Record button.
Measure a Plane2.	 On the Measure menu, select Plane. Measure  

Plane 1. Cancel the Plane command. 
Rename the 3.	
plane

Select the feature name and type Datum A.

Expand 4.	
QuickTool

In the QuickTools panel, click the Plus Sign to expand 
the QuickTool program and see the commands.

Measure a 2D 5.	
line

Press the F4 hot key. Measure the edge across the 
front of the part. Cancel the 2D Line command. 

Rename the line6.	 Select the feature name and type Datum B.
Measure a circle7.	 Press the F10 hot key. Measure Circle 9. Cancel the 

Circle command.
Rename the 8.	
circle

Select the feature name and type Datum C.

An alternative method to add one or more commands to a QuickTools 
program is to select measured features in the Features panel and drag 
them onto the program. 

Create using 9.	
wizard

On the Coordinate Systems menu, click Create 
Using the Wizard. 

Add features10.	 Choose Datum A as the Plane Feature, Datum B as 
the Line Feature, and Datum C as the Point Feature.

Align11.	 Select the Align With checkbox and choose World.
Create12.	 Click OK.
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Stop recording13.	 In the QuickTools panel, click the Stop button.

Save the measurement file:

Save As14.	 From the File menu, select Save As.
Your folder15.	 Browse to your folder and type Quicktools.fcd.
Save16.	 Click Save.

ACTIVITY: Playing The QuickTools Program

In this activity, you will complete the QuickTools program and play it.

Play the 1.	
QuickTools 
program

Click Play to run the program.

Skip Document 2.	
Header 
Information

Enter a part name. Click OK.

Measure the 3.	
part

Follow the Measurement Window panel and measure 
Datum A, Datum B, Datum C. Notice that the current 
feature highlights red in the Main Window.

ACTIVITY: Adding Features To A QuickTools Program In 
Template Mode

In this activity, you will add measurement commands to the “Practice Program” 
QuickTools program in Template mode.

Template Mode1.	 If necessary, click the Measure/Template Mode icon 
so that you are in Template mode.

Begin recording2.	 Click the Record button.
Add Measurement3.	 On the Features panel, right-click the four circles 

(1,3,5,7) and select Add Measurement.

Note that the measurements were added to the Features panel, but nothing 
has been added to the QuickTools panel. The “Add Measurement” is not a 
QuickTools program command. You will use the actual circles later in this 
module.

Add readings to 4.	
the circle

On the Features panel, right-click Circle 1 and 
select Add Readings.

Note that the Add Readings command has added the “Add Readings to 
Circle 1” command to the QuickTools program.
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Add readings to 5.	
the circles

On the Features panel, select Circle 3, Circle 5, and 
Circle 7. Right-click and select Add Readings.

Stop recording6.	 Click the Stop button.

ACTIVITY:  Constructions And Dimensions

In this activity, you will create a bolt circle and a length dimension.

Construct a 1.	
Circle by Best Fit

On the Construct menu, select Circle, and then 
select By Best Fit.

Rename the 2.	
Best Fit circle

Select the feature name and type Bolt Circle.

Select Datum A 3.	
as the plane for 
the measured 
circles

If not already selected, select Circle 1 - Actual, 
Circle 3 - Actual, Circle 5 - Actual, and Circle 7 - Actual.

Check the Use Plane checkbox and select 
Datum A - Actual from the drop-down list.

Click Create and then click Close.

Because Bolt Circle Actual uses measured (actual) circles (1,3,5,7) in 
the By Best Fit construction, the nominals of the measured circles 
are automatically used to construct the nominal by best fit circle 
(Bolt Circle - Nominal).   

Create a 4.	
dimension

On the Dimension menu, click Length From 
Features.

Select Circle 3 - Actual treat as a point, and 
Circle 7 - Actual treat as a point.

Click Create and then click Close.

Since Constructions, Dimensions, Tolerancing, and Reporting are not 
recorded in a QuickTools program, all of this can be done before or after 
creating the Quick Tools program. Remember, these save as a part of the 
measurement file.



9 . 8

M
o

d
u

l
e

 
9

:
Q

u
i

c
k

T
o

o
l

s
 

P
r

o
g

r
a

m
m

i
n

g 

A nominal length is automatically created and associated.

ACTIVITY: Playing The QuickTools Program

In this activity, you will complete the QuickTools program and play it.

Play the 1.	
QuickTools 
program

Click Play to run the program.

Document 2.	
Header 
Information

Enter a part name. Click OK.

Measure the 3.	
part

Follow the Measurement Window panel and measure 
Datum A, Datum B, Datum C and the four circle 
features. 
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ACTIVITY: Editing Tolerances

In this activity, you will edit tolerances for some features that you want to view on the 
report. 

Edit the tolerances 1.	
for each circle

Select Circle 1 in the Features panel.

In the Feature Information panel, clear the 
Z dimension and 3D Distance checkboxes.

Edit the X dimension, Y dimension, and Diameter 
tolerances as follows:

Lower Tolerance ❐❐  -0.25 mm.

Upper Tolerance  ❐❐ +0.25 mm.

Now you can copy the tolerances to the other three circles.

Copy the 2.	
Tolerances 

Select Circle 1 in the Features panel.

Right-click and select Copy Tolerances. 
Paste the 3.	
Tolerances

Select Circle 3 in the Features panel.

Right-click and select Paste Tolerances.
Paste to remaining 4.	
circles

Repeat for the other two circles.

ACTIVITY: Reporting The Results

In this activity, you will make a report of the measurement results.

Before clicking the Report tab, make sure the view on the Main Window is what you want ☛☛
to appear on the report. Zoom in on the entire part or the area of the part you want to 
include in the report. A good way to zoom in on and orient the part is to use the hot keys. 
The, 6 hotkey orients the part to a top view, E hotkey zooms all, I zooms in, O zooms out 
and  the arrow keys pan around the window.

Switch to the 1.	
Report view

Click the Report tab.

You can automatically switch to Report view when running the Quicktools 
program by adding the View Report command into the program. On the 
QuickTools  toolbar, select Tools and select View Report while recording your 
QuickTools program.
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QuickTool Program Properties

There are three properties that may be enabled for each QuickTools program. 
When enabled, these properties activate special commands when the 
QuickTools program is started.

Prompt for Session Datazz  prompts the operator to update the contents 
of the Document Header Information dialog box before starting the first 
command.

The Document Header Information dialog contains information such as ☛☛
Part Name, Session Name, and Operator, which may be used to provide 
unique information for facilitating repeatable part measurement.

Clear Existing Measurement Datazz  removes all readings from the 
measurement file before starting the first command, providing for 
a “fresh” set of measurements each time the operator begins the 
QuickTools program.

Maximize Measurement Windowzz  maximizes the Measurement Window 
panel to fill the entire computer screen when the program plays.

Add each circle to 2.	
the report

Add the four circles to the In Report list.

CAD tab3.	 Click the CAD tab to return to the Main Window.  
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Command Properties

Each measurement command is listed as a single line item in the QuickTools 
panel. You can modify certain parameters of each measurement command 
using the Properties panel below the list of commands. Click a measurement 
command to access the command’s parameters in the Properties panel.

CAD View Commands

Use the CAD View buttons to assign, preview, or delete a specific view of the 
features in the Main Window for any QuickTools command.

Save CAD View for Stepzz : Manipulate the view of the Main Window, and 
click this button to save this view to the QuickTools command.

Clear Saved CAD Viewzz : Click this button to delete an associated view of 
Main Window from the QuickTools command. If no CAD View has been 
saved to this command, this button is grayed out.

Preview Saved CAD Viewzz : Click this button to preview an associated view 
of the Main Window from the QuickTools command. If no CAD View has 
been saved to this command, this button is grayed out.
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ACTIVITY: Modifying QuickTools Program Command Properties

In this activity, you will modify the properties of some of the measurement commands 
we’ve added to the QuickTools program.

Modify the 1.	
Add Readings 
to Circle 1 
command to 
take 7 readings

in the QuickTools panel, select the Add Readings to 
Circle 1 command.

On the Basic tab, clear the Use Range checkbox, and 
change the number of Readings to 7.

Modify the 2.	
Add Readings 
to Circle 5 
command to 
take readings 
every .10 mm

Select the Add Readings to Circle 5 command and 
click the Advanced tab.  

Select Distance Interval from the Sample Mode drop-
down list, and enter 0.10 in the Distance field.

Modify the 3.	
Add Readings 
to Circle 7 
command to 
take readings 
every .5 mm

Select the Add Readings to Circle 7 command and 
click the Advanced tab.  

Select Distance Interval from the Sample Mode drop-
down list, and enter 0.5 in the Distance field.  

Command Parameters

For each QuickTools command, the Properties panel is divided into two tabs, 
Basic and Advanced.

Basic Tab

The Basic tab has 3 main parameters:  Feature, Device, and Readings.

Featurezz  contains the name of the selected feature.

Devicezz  Chooses which device will measure the feature (assuming there’s 
more than one measurement device to be used).  

Readingszz  Sets a low and high limit to the number of readings the user 
will add to each feature. Uncheck the Use Range check box to establish a 
high limit only.

Advanced Tab

The Advanced tab controls scanning functionality.

Sample Modezz  Sets an interval parameter, a distance parameter, or both.  
An interval parameter takes a point over a specified time; a distance 
parameter takes a point over a specified distance.

Replace Existing Readingszz  removes any existing reading from the 
feature.
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ACTIVITY: Adding Comments To A QuickTools Program 
Command

In this activity, you will add a comment, and a View Report command in the QuickTools 
program.

Start Recording1.	 On the QuickTools panel, click Record.
Select 2.	
command

Select the Add Readings to Circle 1 command

Add Comment3.	 On the QuickTools panel, click the Tools menu, and 
select Add Comment.

Input text4.	 In the Add Comment dialog box, enter: 
Begin measuring the 20mm circles on 
the top face. 

Click OK.

When the QuickTools program is run, the operator will be presented with a 
text box containing your comment before continuing with the command list.

View Report 5.	
command

On the QuickTools panel, click the Tools menu, and 
select View Report. On the Report View Settings 
panel, Click OK.

This command always adds to the end of the 
QuickTools program.

The Tools menu also has the Change Adapter command for the FARO Laser 
Tracker.  When executing this step of a QuickTools program, the operator 
is guided through the process of changing the adapter. When the adapter 
change is successful, the operator can continue running the QuickTools 
program.

Comments

A comment is a textual message that an operator will see when playing the 
QuickTools program, must acknowledge by clicking OK, and can thus be used 
to help guide the operator through the program by providing important 
information at key points.

You can add a comment to any QuickTools program command. 
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Reordering Program Commands

After you’ve finished recording commands to the QuickTools program, you 
can easily change the order of the commands by dragging the command to 
another location in the list (clicking a command and holding the left mouse 
button, dragging the command to a new location within the QuickTools 
program, and releasing the left mouse button).

Reordering Program Commands

Deleting QuickTool commands from a program is simple, just select the 
command and click the Delete button (X icon) on the QuickTools panel. 

Image Creator

Now that you have created your QuickTools program, you may add pictures 
to the measurement commands with Image Creator. Including pictures of the 
part with each command will show an operator exactly where to place the 
probe for recording measurements and where to record end-clicks.

ACTIVITY: Finishing And Playing The QuickTools Program

In this activity, you will complete the QuickTools program and play it.

Click1.	  Stop On the QuickTools panel, click Stop. CAM2 Q stops 
recording commands and the QuickTools program is 
complete.

Save the file2.	 From the File menu, Click Save to update your 
Quicktools.fcd file.

Play the 3.	
QuickTools 
program

On the QuickTools panel, click Play to run the 
program.
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Click the Image Creator tab to access Image Creator.

Picture Options

Picture options include:

Photographs taken with a digital camera (*.jpg, *.png, *.bmp format)zz

*.jpg, *.png, *.bmp files of your part from a CAD programzz

Screen captures of your CAD model made with the CAM2 Q zz
File < Export < Picture to File command (this may be the easiest option if 
you don’t have access to a digital camera.)

When taking pictures of your part, include as many features in a shot as 
possible without sacrificing space, picture clarity, and quality. Capturing a 
big cluster of features from a long distance will not provide enough detailed 
information for the operator. 

The ideal image size is 640x480 pixels; most cameras have an adjustable 
setting for the size of a picture. However, you should first add one image to 
a QuickTools program command, then play the command and look at the 
picture in the Measurement Window panel. One image can be used as many 
times as needed.
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ACTIVITY: Adding Pictures With Image Creator

In this activity, you will add pictures to your QuickTools program using Image Creator.

Access Image 1.	
Creator

Click the Image Creator tab to access Image Creator.

Import a base 2.	
image into 
Image Creator

Click Import. Browse to My Documents\
CAM2 Q\ v1.4 Training Files\Part Photographs\.

In the Open dialog box, select all the images for the 
QuickTools program and click Open. The images now 
appear in the Base Images box.

Assign the 3.	
base image 
to the first 
measurement 
command

In the QuickTools panel, select the first measurement 
command, Add Readings to Datum A.

In the Image Creator panel, click New Image.

Drag an appropriate image for the first command from 
the Base Images box onto the Images screen.

Green and Red Target Points (Probes)

After you’ve added pictures of the part into Image Creator, you can overlay 
green target points to identify the places to record readings and red target 
points to specify end clicks.

During the execution of a program, each reading and end click requires its 
own picture and target point (where the user should place the Probe/SMR).
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ACTIVITY: Adding Green And Red Target Points To The Images

In this activity, you will add green and red target points (signifying Probe/SMR positions) 
to the pictures you’ve uploaded.

Add a green target 1.	
point to the base 
image

Drag a green target point from the Probes box 
onto the image in the Images screen.

Rotate, resize, and 2.	
position the green 
target point

Hover the mouse over the target point to view the 
target point’s positioning menu.

The arrow icon at the top rotates position ❐❐

of the target point.

The X icon at the upper right deletes the ❐❐

target point form the Images screen.

The extend icon in the lower right ❐❐

increases/decreases the size of the target 
point.

Add and move 3.	
green target points 
for each reading

Once the first target point is in location, click New 
Image.

Repeat steps 1 - 3 until all the readings needed 
have images and target points for each feature 
type. For this plane you should add seven green 
target points. 

After you indicate the location of the readings, you will indicate the location 
to record an end click.

Add red target point4.	 Drag a red target point from the Probes box onto 
the image in the Images screen.

Rotate, resize, and 5.	
position the red 
target point

Rotate, resize, and position the red target point
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Continue to add the appropriate images and target points for all of the 
remaining measurement commands. 

When you run the QuickTools program, the Measurement Window panel ☛☛
will include the images you’ve created.

Save the measurement file, which now includes all of the modifications to 
the QuickTools program.

Save the file6.	 From the File menu, Click Save to update your 
Quicktools.fcd file.

The QuickTools program, base images, and 
target point locations are saved with the *.fcd 
measurement file.

   
Number of readings 

for optimal results: 
Plane - seven
Line - five
Circle - seven

Editing a QuickTools Program

Click any measurement command in the zz QuickTools panel to view and 
edit the properties in the Properties panel. 

You may add new commands by clicking zz Record in Measure or Template 
mode.  Click Stop to cease recording new commands.

You may also change the order of the commands by dragging the zz
commands to another location within the program. If you have added a 
Comment command before a measurement command, make sure to also 
move the Comment.

You may also delete commands from the program by selecting the zz
command and clicking Delete (trashcan icon).

You may also delete the entire QuickTools program by selecting the ☛☛
program name and pressing the Delete key. 
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Module 10: 
Iterative Alignments

In this module, you will become familiar with iterative (best-fit) alignments to align and 
compare measured features to nominal features. 

Prerequisite: Basic Measurements, Nominals and Tolerances.

Module XX Objectives
You will be able to:

Create Iterative alignments using the default settings, using weights, and using zz
material temperature considerations
Report the alignment resultszz
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Scenario: Iterative Alignments

You are familiar with measuring features and viewing the results using a Coordinate 

System alignment, but now we will use a “best fit” alignment between the measured 

and the nominal features. 

Iterative Alignments

An Iterative alignment uses point reducible features to best-fit them to their 
corresponding nominal values. You can create an Iterative alignment using 
three or more point-reducible features with associated nominals. You may 
add nominals to features that have already been measured, or you may 
create nominals and add measurements to the nominals.

Preferences for Iterative Alignment

Before you create your Iterative alignment, access the Measurement 
preference (Edit > Preferences > Measurement > General tab) and ensure 
that the Use Last Plane check box is selected. 

If the Use Last Plane check box is clear, each measured circle will have a ☛☛
separate projection plane.

I need to make sure the features I measure on my part are comparable 

to their nominals. How do I perform an Iterative alignment to best-fit 

measured features to their corresponding nominals?

ACTIVITY: Creating Nominals For An Iterative Alignment

In this activity, you will create nominal circles from a CAD file for use in creating an 
Iterative alignment.

Open a new file1.	 On the File Menu, click New. 
Import CAD2.	 Click the Import CAD icon on the toolbar. Browse 

to the \My Documents\CAM2 Q v1.5 Training Files 
folder and select Demo Part Q.x_t

Pick from CAD 3.	
menu

On the Feature Creator, select Pick From CAD.

Circle4.	 Select Circle.
Pick from CAD5.	 Click the Circle 1 edge. Circle 1 appears in the 

Features panel.
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ACTIVITY: Adding Measurements To The Nominals

In this activity, you will add measurements to the nominal circles you created in the last 
activity.

Add 1.	
Measurement

Select Circle 1, Circle 3, Circle 5, and Circle 7. Right-
click select Add Measurement. Since there is no 
active projection plane, CAM2 Q automatically adds 
a plane feature. 

Measure Plane2.	 Add readings to Projection Plane 1.
Measure Circles3.	 Add readings to Circle 1, Circle 3, Circle 5, and 

Circle 7.

 

Zoom Out (use the O hot key) so that you can see your measurements and 
your CAD file. Notice that they are not aligned yet.

Repeat for other 6.	
features

With the Pick Circle from CAD window remaining 
open, check the name and click the edge  for Circle 3,  
Circle 5, and Circle 7.

Close7.	 Click Close. 

Now that you’ve created the nominal features, you can add measurements to 
them.
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ACTIVITY: Creating An Iterative Alignment

In this activity, you will create an Iterative alignment using the nominals and 
measurements you’ve created.

Alignment 1.	
command

From the Alignments menu, select Iterative 
Alignment.

Select 2.	
Circle 1 - Actual

Click the [Select a Feature] drop-down and select 
Circle 1 - Actual.

Select other 3.	
features

Repeat step 2 for Circle 3 - Actual, Circle 5 - Actual, 
and Circle 7 - Actual.

You can also add these features to the Alignments dialog box by selecting 
them in the Features panel and clicking the Add Selection button.

Enter name4.	 Enter Iterative in the Name box. 

Apply/Solve5.	 Click Apply/Solve to create the Iterative alignment.

Note that the “Iterative” alignment is now active.  The X, Y, Z, and 3D 
columns show the calculated deviation of each feature in the best fit.

Close6.	 Click Close.

You should now be able to see that your measurements are aligned to 
the CAD file. Also notice that your alignment now shows active in the 
Alignments toolbar.

 ##
You can also 

press the A hot 

key to start the 

Alignments 

command. 

Measurement and Nominal Association

You have just created nominal features and added measurements to those 
features.  By doing so, your measurements and nominals are automatically 
associated and a feature group is created. To verify this association, click each 
circle feature group in the Features panel and view the Nominal Feature 
column in the Feature Information panel.

You now have the measurements, nominals, and feature associations you 
need to create an Iterative alignment.
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Weights

You can apply weights to the X, Y, and Z coordinates of each feature in 
the alignment. A weight ensures a higher priority for that feature in the 
calculation.

In the Alignments dialog box, select the Set Weights checkbox to add the 
Weights columns to the Alignments dialog box, then enter a value for the X, Y, 
and Z coordinate for each feature.

The default value is 1; input a number greater than 1 to emphasize a weight.

ACTIVITY: Adding Weights To An Iterative Alignment

In this activity, you will add weights to Iterative.

Alignment 1.	
command

Press the A hot key.

Set weights2.	 Select the Set Weights checkbox to view the Weights 
columns.

Enter values3.	 In the Weights column, double-click the X 
coordinate of Circle 1 - Actual and enter 5.

Apply/Solve4.	 Click Apply/Solve and note the differences in the 
Results area (lower right).

Close5.	 Click Close.

Fit Scale

You can scale the measured features during the best fit calculations. The scale 
is the ratio of the measured features to their nominal features.

Select the Fit Scale check box to scale measured features during best fit 
calculations.

If the Fit Scale check box is not selected, no scaling is used in the calculations 
and the scale of the part is:1.

Material Temperature

Scaling for temperature allows you to measure parts in areas that are 
either warmer or cooler than the nominal temperature of 20°C (68°F). The 
measurement results are adjusted for thermal expansion or contraction.

You can adjust calculations for both the material and the current temperature 
of the part. To scale for material temperature changes: 

After creating an Alignment, in the zz Details section of the Alignment 
dialog box, click the Material drop-down arrow and select a material 
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ACTIVITY: Material Temperature - Iterative Alignment

In this activity, you will add material and temperature considerations to My Iterative 
Alignment.

Alignment 1.	
command

From the Alignments menu, select Create/Edit to view 
Iterative.

Fit Scale2.	 Select the Fit Scale checkbox.
Select Material3.	 Click the Material drop-down (upper right) and 

choose Aluminum Alloy 2011.
Enter 4.	
Temperature

Enter 40 in the Temperature box.

Apply/Solve5.	 Click Apply/Solve and note the differences in the 
Results area (lower right).

Close6.	 Click Close.

from the library. You will see the coefficient of thermal expansion (CTE) 
next to the material name. You cannot change this value. 

Enter the temperature of the part, and select Celsius (°C) or Fahrenheit zz
(°F) from the drop-down list. 

To create a new material, click the Plus (+) button next to the Materials 
drop-down arrow. In the Create New Material dialog box, enter a name and 
coefficient of thermal expansion value for the new material. Click OK to add 
this material to the library.

Now that you’ve created your Iterative alignment, you can create a report of 
the results.
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ACTIVITY: Reporting The Results Of The Iterative Alignment

In this activity, you will view the results of the Iterative alignment using CAM2 Q’s reports.

Before clicking the Report tab, make sure the view on the Main Window is what you want ☛☛
to appear on the report. Zoom in on the entire part or the area of the part you want to 
include in the report. A good way to zoom in on and orient the part is to use the hot keys. 
The 6 hotkey orients the part to a top view, E zooms all, I zooms in, O zooms out and  the 
arrow keys pan around the window.

Select the 1.	
Circles

In the Features panel, select Circle 1, Circle 3, Circle 5, 
Circle 7.

Report tab2.	 Click the Report tab.
Add features to 3.	
the report

The four circles automatically add to the Active Report 
List.

 

Review the measurement results of the four circles. 

ACTIVITY: Save The Measurement File

In this activity, you will save your work in the measurement file.

Save As1.	 From the File menu, select Save As.
Your folder2.	 Browse to your folder and type Iterative.fcd.

Save3.	 Click Save.
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Auto Nominal Association

Auto Nominal Association is a CAM2 Q preference which controls the 
automatic association of the nearest nominal to a measured feature - 
providing it falls within a set of tolerance zones. This preference is enabled by 
default. To enable or disable auto nominal association:

On the zz Edit menu, click Preferences. In the Preferences dialog box, 
select Measurement and the Auto Nominal tab.

Select the zz Automatically Associate Nominal check box:

 ##
This function is not active until an 

alignment has solved.

ACTIVITY: Measure Additional Features

In this activity, you will measure the remaining circle on the part. The Auto Nominal 
preference will automatically find and associate the nominal circles after the measured 
circle has solved.

Main Window1.	 Click the CAD tab to return to the CAD screen. 
Circle command2.	 From the Measure menu, select Circle.
Measure circles3.	 Measure circles 2, 4, 6, 8. You can rename the features 

if you wish.
Review the 4.	
report

Click the Report tab. Add these new circles to the 
report and review the results.
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Module 11: 
Wireframe CAD Inspection

In this module, you will become familiar with using the wireframe data of a CAD model 
to facilitate inspection of your part. 

Prerequisite: Working with CAD module.

Module XX Objectives
You will be able to:

Identify proper alignment using the blueprint designzz
Employ a wireframe CAD model with a Coordinate System Alignmentzz
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Scenario: comparing measurements to CAD

The core principle of wireframe CAD inspection is the comparison of physical part 

measurements to nominal CAD features. When you align the measurements and 

nominals, the differences between them can be identified and analyzed.

The coordinate system on the physical part relates to the coordinate system 
of the part’s CAD model. in CAM2 Q, you can align these coordinate systems 
and associate the measured features to the nominal features contained in the 
CAD model.

Wireframe CAD Inspection Workflow

Import the CAD file.1.	

Measure the part and create a coordinate system.2.	

Align the measurement coordinate system to the wireframe CAD model.3.	

Measure other features for comparison to the CAD model. 4.	

Associate measured features to nominal features, or add measurement 5.	
commands to nominal features.

Adjust positional and form tolerances for the holes, round slots, etc.6.	

Create and view a report.7.	

I have to inspect the part and compare the measurements to the “perfect 

world” features in my CAD file.  Should I create a coordinate system based 

on my measurements and align with the CAD’s coordinate system? What’s 

the best way to compare my measurements to my CAD nominals?

ACTIVITY: Measured Coordinate System And Aligning To CAD

In this activity, you will measure features, create a coordinate system with those features, 
and align the coordinate system with the CAD coordinate system for proper alignment.

Open a new file1.	 Hold down the Ctrl key on the keyboard and press the 
N key.

Import CAD file2.	 Import the Demo Part Q.x_t file. Then, press the S hot 
key to view the different shaded and wireframe views.
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Measure Mode3.	 If necessary, click the Measure/Template Mode icon 
so that you are in Measure mode.

Measure top 4.	
plane

Measure the plane on the top of the demo plate. On 
the Measure menu, click Plane.

Measure front 5.	
line

Measure the front edge of the part from left to right. 
On the Measure menu, click 2D Line.

Measure Circle 96.	 Measure Circle 9. On the Measure menu, click Circle. 
(You will need to rename the circle as Circle 9).

Coordinate 7.	
Systems

Press the C hot key.

Select Plane 18.	 In the Plane Feature list, select Plane 1. In the Axis 
list, select +Z.

Select 2D Line 19.	 In the Line Feature list, select Line 1. In the Axis list, 
select +X.

You have just selected the Z and X axes of the new ☛☛
coordinate system.

Select Circle 910.	 In the Point Feature list, select Circle 9.

You have just established the center of Circle 9 as the ☛☛
origin.

Align to World11.	 Check the Align with box and select World

This aligns your measured coordinate system to the ☛☛
nominal (or World) coordinate system.

Create and 12.	
Close

Click OK.



1 1 . 4

M
o

d
u

l
e

 
1

1
:

W
i

r
e

f
r

a
m

e
 

C
A

D
 

I
n

s
p

e
c

t
i

o
n 

Now that you’ve aligned your measured coordinate system with the nominal 
(World) coordinate system, you can compare your measured features to the 
nominal features of the CAD model.

If you create nominal   
features and add measurements 

to them, your measurements 

and nominals are automatically 

associated.
ACTIVITY: Nominal Features And Comparing To Measurements

In this activity, you will check the automatic nominal of Circle 9 and review the 
measurement results.

Feature 1.	
Information tab

Click the Feature Information tab. Check to see if a 
nominal was automatically created and associated.

View results2.	 Use the Feature Information panel to compare the 
measured circle’s measurements, positioning, and 
other GD&T statistics with its nominal.

Circle 9 results

Center.x Actual: _____________

Center.y Actual: _____________

Center.z Actual: _____________

Diameter Actual: _____________

3D Distance Actual: _____________

Circularity Actual: _____________
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Scenario: Sub-assemblies with Local coordinate 
systems, assemblies with global coordinate systems

Parts that are sub-assemblies (or “piece parts”) may have a part (local) coordinate 

system that relates to an assembly (global) coordinate system on the final assembly. 

For example, one automobile part may report its features based on a coordinate 

system established from the fully assembled automobile.

The part I am inspecting is a sub-component of a larger assembly.  The 

CAD file of the sub-component has a coordinate system, and the larger 

assembly has a global coordinate system. How do I inspect using multiple 

coordinate systems?

ACTIVITY: Offsetting A Coordinate System

In this activity, you will apply an offset to translate to the coordinate system you’ve 
created to a known position based on the final assembly.

For this example, let’s assume the origin of the assembly coordinate system is located at 
X 500, Y 220, Z 0.

Edit Coordinate 1.	
System 1

Select Coordinate System 1. Right-click and select 
Properties.

Offset 2.	 Select the Offset check box and enter the following 
translation for X, Y, and Z:  (500, 220, 0).

Modify3.	 Click Modify and Close.
View results4.	 Click Circle 9 and check the Feature Information 

panel to compare the differences in the X position, 
Y position, and the 3D Distance to the previous 
results.

If you know the relationship of the part coordinate system to the assembly 
coordinate system, you can apply an offset and rotation to align the part 
coordinate system with the assembly coordinate system. If you need smaller, 
more manageable dimensions, you can inspect the entire part from the part 
coordinate system. Then, apply an offset and rotation to the part coordinate 
system to move into the larger assembly coordinate system. 
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The best option is to ask the CAD file’s drafter to move the file’s coordinate 
system to the appropriate position and orientation for your inspection. If this 
is not feasible, you may import the model into a CAD program and perform 
changes; however, problems may arise with the CAD model type when 
importing the file into a different CAD program.

CAM2 Q gives you the ability to move the CAD file’s coordinate system using 
nominal features defined from the CAD model. In other words, you can make 
a new nominal coordinate system from the features of the CAD model, which 
you can then use to align your measurement device.

The CAD file that I’m to use for inspection has the coordinate system in 

the wrong place!  What if I can’t contact the supplier of the CAD file and 

convince them to send me an updated CAD file?  How can I create the 

correct coordinate system using CAM2 Q?

Scenario: The CAD File’s coordinate system is in the 
Incorrect location

When inspecting with wireframe CAD files, you may occasionally find that a CAD file’s 

coordinate system is in the incorrect (or not optimal) location.
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ACTIVITY: Creating A Nominal Coordinate System

In this activity, you will use the Pick from CAD commands to create a new coordinate 
system for your part.

New file1.	 Open a new file.
Measure Mode2.	 If necessary, click the Measure/Template Mode icon 

so that you are in Measure mode.
Import CAD file3.	 Click the Import CAD icon.
Select file4.	 In the Add CAD Model window, browse to CAM2 Q\

v1.5 Training Files\ folder, select Demo Part Q.x_t 
and click Open.

Pick from CAD5.	 On the Feature Creator, select Pick From CAD.
Plane6.	 Select Plane.
Pick points on 7.	
plane

The Pick Plane from CAD window appears. Click on 
the part’s top surface.

Create8.	 Plane 1 appears in the Features panel.
Close9.	 Click Close.

Pick from CAD10.	 On the Feature Creator, select Pick From CAD.
Line11.	 Select Line.
Pick points on 12.	
line

On the Pick Line from CAD window, click on the top 
front edge of the part.

Create13.	 Line 1 appears in the Features panel.
Close14.	 Click Close.

Pick from CAD15.	 On the Feature Creator, select Pick From CAD.
Line16.	 Select Line.

Pick points on 17.	
circle

On the Pick Circle from CAD window and click on top 
edge of the part above Circle 11.

Create18.	 Line 2 appears in the Features panel.
Close19.	 Click Close.

Note that with some CAD files you may have to click the minimum number 
of points on the CAD to create the feature.

Create 20.	
coordinate 
system

On the Coordinate Systems menu, click Create Using 
the Wizard.

Advanced tab21.	 Click on the Advanced tab.
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ACTIVITY: Aligning To The Nominal Coordinate System

In this activity, you will measure the part, create a coordinate system from the part 
measurements, and align the part’s coordinate system to the nominal coordinate system 
(Coordinate System 1). 

Make sure you are in ☛☛ Measure mode.

Measure top 1.	
plane

On the Measure menu, click Plane. Measure the 
plane on the top of the demo plate. Cancel the Plane 
command.

Measure front 2.	
line

On the Measure menu, click 2D Line. Measure the 
front line of the part from left to right. 

Measure side 3.	
line

Measure the side line of the part from front to back. 
Cancel the Line command.

Select primary 22.	
feature

In the Primary Feature list, select Plane 1 - Nominal. 
In the Axis list, select +Z.

Select 23.	
secondary 
feature

In the Secondary Feature list, select 
Line 1 - Nominal. In the Axis list, select +X.

Select origin24.	 In the Origin Feature list, select Line 2 - Nominal.
Do not align 25.	 Clear the Align with check box.
Create and close26.	 Click OK.

You have just created a new nominal coordinate system for the CAD model using 
CAM2 Q’s Construct from CAD and Coordinate Systems commands. In the next activity, 
you will measure the physical part, construct a part coordinate system, and align that 
coordinate system to the new nominal coordinate system.
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Create 4.	
coordinate 
system

Press the C hot key.

Advanced tab5.	 Click on the Advanced tab.
Select primary 6.	
feature

In the Primary Feature list, select Plane 2 - Actual. In 
the Axis list, select +Z.

Select 7.	
secondary 
feature

In the Secondary Feature list, select Line 3 - Actual. In 
the Axis list, select +X.

Select origin8.	 In the Origin Feature list, select Line 4 - Actual
Align with 9.	
Coordinate 
System 1

Select the Align with check box and select 
Coordinate System 1.

OK10.	 Click OK. 

The CAD coordinate system has moved to the correct orientation and the part is aligned. 
Notice that the measured features are now in a feature group with the nominal features. 
The feature group always uses the name of the nominals by default.

A quicker method to completing this measurement activity is to select the nominal ☛☛
features in the Features panel, right-click, and use the Add Measurement command. 
This also creates measurement features (-Actual) with the same name as the nominal 
features.
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ACTIVITY: Reporting The Results Of The CAD Inspection

In this activity, you will view the results of the wireframe CAD inspection using CAM2 Q’s 
reports.

Before clicking the Report tab, make sure the view on the Main Window is what you ☛☛
want to appear on the report. Zoom in on the entire part or the area of the part you 
want to include in the report. A good way to zoom in on and orient the part is to use 
the hot keys. The 6 key orients the part to a top view, E key zooms all, I zooms in, O 
zooms out and the arrow keys pan around the window.

Report tab1.	 Click the Report tab.
Add features2.	 On the Features panel, on the Active Report List, click 

the Add all features to the list. You can also select the 
arrow to the left of the feature to move it.

A quicker method is to select the features in the ☛☛
Features panel and then click the Report tab. 

View results3.	 Compare the actual data to the nominal data.
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Module 12: 
Surface Measurement for Inspection or 
Reverse Engineering

In this module, you will become familiar with measuring surface features for 
both surface inspection and reverse engineering. You will use surface inspection 

commands in CAM2 Q to inspect a part with free-form surfaces, edit complex 
measurement data, and create a report of the surface measurements. You will use the 
surface information in a CAD file as nominal data for the inspection of your part, and 
also create a CAD model of your part for export.

Prerequisite: Basic Measurement, Coordinate Systems, and Working with CAD modules.

Module XX Objectives
You will be able to:

Inspect surfaces at any location (Inspect Surface Point, Inspect Surface)zz
Inspect surfaces at a specific location (Home In Point, Vector Point)zz
Inspect surfaces at any location with the data filtered to display at specific cross-zz
sectional planes (Polyline, Polyline Group) 
Edit the surface datazz
Report the surface datazz
Measure to reverse engineer a partzz
Output the data to an appropriate file formatzz

LessonsXX
Lesson 1: Surface Inspection with CAD................................................................. 12.3
Lesson 2: Scanning for Reverse Engineering.....................................................12.13
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Measurement Mode Options

Measurement Mode options let you specify whether to add single or multiple 
readings. This is beneficial whether you are measuring a large feature or a 
free form surface. The addition of multiple readings over a specified time or 
distance is often called “scanning”. 

In the Measurement Window panel, use the Mode drop-down list to switch 
the reading collection mode. 

Single Pointzz : press the Front button, or the G key, to collect a single 
reading.  

Time Intervalzz : press the Front button, or the G key, to start the time 
interval. Collect a single reading over time.  

Distance Intervalzz : press the Front button, or the G key, to start the 
distance interval. Collect a single reading when the probe moves a 
distance.  

To configure any Measurement Mode, click the Measurement Mode Setting, 
or Settings, button in the FARO Device Control panel.  

 ##
See the CAM2 Q chapter in the 

user manual of your current 

measurement device for more 

information.
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Lesson 1: Surface Inspection with CAD

Lesson Objectives

Using the specialized surface measurement commands, you will be able to:

Inspect surfaces at any location (Inspect Surface Point, Inspect Surface)zz
Inspect surfaces at a specific location (Home In Point, Vector Point)zz
Inspect surfaces at any location with the data filtered to display at specific zz
cross-sectional planes (Polyline, Polyline Group) 
Edit the surface datazz
Report the surface datazz

PRE-ACTIVITY:

Option 1
If training files are available

Option 2
If starting with a new file

Open Advanced 2.fcd Open a new file

Select all of the features, then 
select Add Readings.

Measure the features as prompted.

Add Demo Part Q.x_t to the 
measurement file.

Add and measure:

Plane 1zz
Line 1 (across the front of the part zz
on the handle side)
Circle 9zz

Up to this point, you have compared and reported the condition of simple 
features at their center point. With surface measurement, you can compare 
and report the condition of the surface at multiple locations. These measured 
to nominal results are more complex than simple feature results, and 
determine the exact location of out of tolerance conditions on the surface. 
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ACTIVITY: Adjust Tolerances For Surface Points

In this activity, we will adjust tolerances for surface points using the Preferences 
command.  

Adjust 1.	
tolerances for 
surface points

On the Edit menu, click Preferences, click Tolerance, 
Geometries tab, then select Surface Point.

Expand the Surface Point group.

3D Distance2.	 In the 3D Distance parameters, change the Lower 
tolerance to -0.25mm and the Upper tolerance to 
0.25mm.

ACTIVITY: Align To A Surface CAD Model Using A Coordinate 
System Alignment

In this activity, we will align using a coordinate system alignment in a measurement file 
containing a CAD model.  

Create 1.	
coordinate 
system from 
measured 
features

On the Coordinate System menu, select Coordinate 
System Wizard.

Enter the name Measured CS for the measured 
coordinate system.

Select Plane 1 as the Plane Feature.

Select Line 1 as the Line Feature.

Select Circle 9 as the Point Feature.

Click OK.

Auto Nominal Association

Auto Nominal Association is a CAM2 Q preference which controls the 
automatic association of the nearest nominal to a measured feature - 
providing it falls within a set of tolerance zones. This preference is enabled by 
default. To enable or disable auto nominal association:

On the zz Edit menu, click Preferences. In the Preferences dialog box, 
select Measurement, then select Auto Nominal tab. 

Select the Automatically Associate Nominal check box. zz

 ##
Auto Nominal Association is not 

active until an alignment has 

solved.
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ACTIVITY: Inspect A Surface

In this activity, we will measure and inspect a surface. 

Inspect Surface1.	 On the Measure menu, select Inspect Surface.
Measure the 2.	
surface

Take multiple points on the top of the part in different 
locations. Cancel the command. 

View the surface 3.	
points

Open the Readings panel and look at the individual 
surface measurements. 

ACTIVITY: Inspect a Surface Point

In this activity, we will measure and a inspect surface point. 

Inspect Surface1.	 On the Measure menu, select Inspect Surface Point.
Measure the 2.	
surface

Take one point on the top of the part. Cancel the 
command.

Review feature3.	 On the Features panel, expand the Point 1 feature. 
Note that this feature has a nominal feature that was 
automatically created and associated.

Inspect Surface Commands

There are two commands to measure a surface at random locations.

Inspect Surface Pointzz : measure a single point on a surface at any 
location.

Inspect Surfacezz : measure a single point or multiple points (point cloud) 
on a surface at any location.

Each reading for these features automatically creates a nominal point 
on the closest surface of your CAD model. The end click determines the 
compensation vector of the digitized point(s).

A disk represents each reading. The disk color is predetermined by the 
tolerance condition. The size of the disk is a Display preference. 

ACTIVITY: Customize Labels

In this activity, we will review and customize the label options. 

Turn labels on1.	 Select the all the features, except World, in the 
Features panel. Right-click and select Label until all of 
the labels are visible on the Main Window.
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ACTIVITY: Home In Points and Nominal Vector Points

In this activity, we will define nominal locations for surface measurement. 

Vector Point1.	 From the Pick From CAD menu, select Vector Point.
Select points2.	 Select two points on top of part. Click Close. 

Now that you have the two nominal vector points, you can use each (as 
target points) in the Home In Point command, and measure the surface. 

Measure Home 3.	
In Point

On the Measure menu, select Other, then Home In 
Point.

Home In Point 4.	
settings

For Approach Type, select Key In.

For Target Point, select Vector Point 1.

Change the Zone Diameter to 5.00mm.

Change the Approach Vector to I 0.00, J 0.00,  
K 1.00.

Create and 5.	
Close.

Click Create, then click Close.

Customize 2.	
labels

On the Edit menu, click Preferences. Click Display and 
the CAD View tab. 

Customize 3.	
labels

Change some of the label settings and then click OK 
to view the changes.

Home In Points 

Home In Points differ from Inspect Surface Points, in that you can measure 
a surface at a specific nominal location. This command will guide you, with 
graphics and sound, to the location of the nominal point, and will not accept 
a reading until the Probe/SMR is in the home in zone. The Probe/SMR must be 
inside the home in zone to record a reading - pressing the Front button (or 
the G key) outside the zone has no effect. Before starting this command, you 
must create a nominal point or nominal vector point to use as the Home In 
target.
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Inspect vector 6.	
point

You now see the nominal point, the Home In Zone, 
and the current position of your probe.

Move the probe to find the nominal point on the top 
surface of the part. Watch the graphic in the Main 
window and listen to the sound to help determine if 
you are in the Home In Zone. 

When you are in the Home In Zone, click the Front 
button (or the G key) to take a point, then pull away 
from the surface and click the Back button (or the H 
key).

Measure Home 7.	
In Point

On the Measure menu, select Other, then Home In 
Point.

Home In Point 8.	
settings

For Approach Type, select Select Surface.

For Target Point, select Vector Point 2.

For Surface, select Demo Part Q.x_t.

Change the Zone Diameter to 5.00mm.
Create and 9.	
Close.

Click Create, then click Close.

Inspect vector 10.	
point

You now see the nominal point, the Home In Zone, 
and the current position of your probe.

Move the probe to find the point as with Home In 
Point 1.
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Polylines

Polylines differ from an Inspect Surface point cloud, in that they display the 
measured points in the order they were taken, along a “line”. This “line” is 
actually a series of straight-line connected surface points that approximate 
a curved path. CAM2 Q treats a polyline as one feature regardless of the 
number of points, the shape, or direction of the polyline. Each point in the 
polyline is compared to the nominal surface. 

Polylines need a minimum of two points in order to solve.

Polyline Groups

Polyline Groups are multiple polylines, or cross-sectional, measurements.
CAM2 Q treats a polyline group as one feature regardless of the shape or 
direction of the polylines.  

With Polyline Groups, a cross-sectional plane and distance is required to 
define each polyline in the group. A reading automatically records each time 
the Probe/SMR crosses one of the cross-sectional “lock” planes, and all of the 
readings on each plane are then used to create each of the polylines in the 
group.  

Each polyline in the group needs a minimum of two points in order to solve.

ACTIVITY: Reporting The Surface Measurements

In this activity, we will create a report with the two measured surface (Home In) points we 
inspected in the previous activity.

Select Report 1.	
Features

In the Features panel, select all the surface 
measurement features (created after the alignment).

Access the 2.	
Report view

Click the Report tab. 

Review the measurement results. Notice the 3D deviation between the 
measured point and the surface. 

ACTIVITY: Save The Measurement File

In this activity, you will save your work in the measurement file.

Save As1.	 From the File menu, select Save As.
Your folder2.	 Browse to your folder and type 

Surface Inspect.fcd.
Save3.	 Click Save.
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ACTIVITY: Configure a Measurement Mode

In this activity, we will select the Measure Mode for the next few activities. 

Device Control 1.	
panel

Press the P hot key.

Settings2.	 Click the Measurement Mode Setting, or Settings, 
button.

Distance Based 3.	
Mode

Select the Distance Based Mode and change the 
distance to 0.50mm. Click OK. 

These are the available measurement modes:☛☛
Single Point Modezz : The measurement device takes a single point. 
Distance Interval Modezz : The measurement device takes points 
at a specified distance interval (specify the distance in the device 
settings). 
Time Interval Modezz : The measurement device takes points at a 
specified time interval (specify the time in milliseconds). 

Close4.	 Click the Close (X) button in the upper right corner of 
the Device Control panel. 

Polyline Group Examples

Parallel Lock Planes Radial Lock Planes

ACTIVITY: Parallel Lock Plane Surface Measurement

In this activity, we will set up a parallel lock plane measurement, then “scan” a cross-
section of the model. 

Measure mode1.	 Make sure that you are in Measure mode.

Measure a Plane2.	 Measure the plane perpendicular to arc G as Plane 2.

Try switching to ☛☛ Distance Interval Mode and 
“scanning” this plane feature by adding readings 
every time the Probe/SMR moves  0.5mm .

Measure 3.	
polyline group

On the Measure menu, select Other, then Polyline 
Group.
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We must configure the polyline group properties before we can see any 
data.

Polyline Group 1 4.	
properties

Select the Project to Surface check box, and select 
CAD Assembly from the drop-down list.

Select the Automatically Create Nominal check box.

Select the Polyline Lock check box and select Parallel 
Planes from the drop-down list. 

Base Plane: Plane 2 - Actual.

Base Distance: 0.00mm.

Distance Between Planes: 5.00mm.

Number of Planes: 20.

Click Create and Close
Measure the 5.	
surface

Make sure that the Measurement Mode is set to 
Distance Interval.

Touch the Probe/SMR to curved surface “G”, press 
the Front button, or G key, and “scan” the curved 
surface in a front to back direction perpendicular to 
Plane 2 - Actual.  

Press the Back button, or H key, to complete the scan.

Feature Whiskers

Whiskers are single lines that visually represent distance data of a feature. 
There are two types of whiskers: 

Whiskers - The Whisker shows the deviation of each reading to the zz
feature. 
Nominal Whiskers - The Whisker shows the deviation of the zz
measured feature to its nominal. 
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ACTIVITY: View And Adjust Polyline Whiskers

In this activity, we will view and adjust the polyline you created in the prior activity.

Select Polyline 1.	
Group 1

In the Features panel, select Polyline Group 1.

View feature 2.	
whiskers

On the View menu, select Feature Whiskers, then 
select Whiskers.

Increase the 3.	
size of feature 
whiskers

On the View menu, select Feature Whiskers, then 
select Increase.

You can also press the ☛☛ + (Plus Sign) key.
Rotate CAD4.	 Click on the screen and drag the mouse to rotate the 

Main window view to see the Whiskers. Press the 8 
hot key to reset the isometric view.

Decrease the 5.	
size of feature 
whiskers

On the View menu, select Feature Whiskers, then 
select Decrease. 

You can also press the ☛☛ - (Minus Sign) key.

ACTIVITY: Reordering Feature Data

In this activity, we will put deviations in order, from lowest to highest, remove readings 
on the outliers, and re-calculate the feature using the remaining readings.

Select 1.	
Point Cloud 1

On the Features panel,  select Point Cloud 1.

Readings tab2.	 Click on the Readings tab.
Click on column 3.	
heading

Click on the DevFrom Fit column heading to reorder 
the readings.

Uncheck 4.	
readings

In the On column, clear the check box for the outlier 
(larger deviation) readings to remove them from the 
calculation.

Recalculate5.	 Click Apply to recalculate the remaining readings.
Repeat with 6.	
Polyline Group 1

On the Features panel,  select Polyline Group 1 and 
repeat this activity.

Select a feature from the Features panel, or the Main Window, and on the 
View menu select Feature Whiskers to access either Whisker command. You 
can also access these commands by right-clicking a feature. The whiskers 
change color according to tolerance condition:

Green - feature is in tolerance zz
Red - measurement is above the upper tolerance zz
Blue - measurement is below the lower tolerance zz
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ACTIVITY: Creating And Saving A Report

In this activity, we will create a measurement report and save it to a .csv file.

Access Report 1.	
view

Click the Report tab.

Add features2.	  to 
the report

On the Features panel, on the Active Report List, 
double-click on the features to add to the report in the 
Not In Report section. You can also select the check 
box to the left of the feature to move it.

Save Report3.	 Click the Export Document icon and select CSV 
Document. Click OK to accept all the default export 
options, and save the report with the name  
My Report 2 in your folder.

ACTIVITY: Save The Measurement File

In this activity, you will save your work in the measurement file.

Save1.	 From the File menu, select Save.
Your folder2.	 This updates your Surface Inspect.fcd file.



08m13e15 - CAM2 Q v1.5 - FARO Laser Tracker Training Workbook - October 2010.pdf  Part# 12053-001

1 2 . 1 3

M
o

d
u

l
e

 
1

2
:

S
u

r
f

a
c

e
 

M
e

a
s

u
r

e
m

e
n

t
 

f
o

r
 

I
n

s
p

e
c

t
i

o
n

 
o

r
 

R
e

v
e

r
s

e
 

E
n

g
i

n
e

e
r

i
n

g 

Lesson 2: Scanning for Reverse Engineering

Lesson Objectives

Using the specialized surface measurement commands you will be able to:

Measure to reverse engineer a partzz
Output the data to an appropriate file formatzz

Reverse Engineering, once stigmatized as a method to “copy” or “steal” 
a product, now has many positive applications in manufacturing. The 
primary functions of Reverse Engineering are to create data to refurbish or 
manufacture a part for which there is no CAD data, or for part inspection 
(comparing a fabricated part to its CAD model or to a standard item). Outside 
of the manufacturing world, Reverse Engineering is widely used to document 
and measure historical artifacts, create models for animation in games and 
movies, reproduce crime scenes, and generate data for use in a wide array of 
medical applications.

ACTIVITY: Create A New Coordinate System

In this activity, we will measure features to put a coordinate system on the demo part.  

Attach the bracket to the top of the training part.1.	
New file2.	 Open a new file.
Measure plane3.	 On the Measure menu, select Plane. 

Measure the top of the base part as a plane. Cancel 
the command. 

Measure front 4.	
edge

On the Measure menu, select 2D Line. 

Measure the front edge of the bracket as a line.
Measure left 5.	
edge

Measure the left edge of the bracket as a line. Cancel 
the command.

Create 6.	
coordinate 
system

On the Coordinate Systems menu, select Create 
Using the Wizard.

Advanced tab7.	 Click on the Advanced tab.
Plane, Line, Line8.	 Create a coordinate system using Plane 1, Line 1, and 

Line 2. Click OK.
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ACTIVITY: Measure Features and Export Data

In this activity, we will measure multiple polylines to define the free form surface of the 
bracket. 

Measure 1.	
polyline group

On the Measure menu, select Other, then select 
Polyline Group. 

Configure the 2.	
properties of 
Polyline Group 1

Polyline Lock: Parallel Planes

Base Plane: YZPlane_World

Base Distance: 30.00mm.

Distance Between Planes: 5.00mm.

Number of Planes: 30.

Click Create, then click Close.
Measure the 3.	
surface

Place the Probe/SMR on the surface and press the 
Front button, or G key, to scan the surface. Cover the 
part from top to bottom, moving left to right.

S1

S2

Press the Back button, or H key, to complete the scan.
Increase point 4.	
size

On the Edit menu, click Preferences. In the 
Preferences dialog box, click Display and CAD View 
tab. Change the Size and Scale: Point size to Large. 

Click OK.
Check Polyline 5.	
Group

Zoom in and look at the points in the Polyline Group, 
and check for large gaps between the points.

Add additional 6.	
readings

On the Feature panel, select Polyline Group 1, right-
click and select Add Readings.

Place the Probe/SMR on the surface. Press the Front 
button, or G key, to scan the surface again to fill the 
large gaps in the polylines. Press the Back button, or H 
key, to complete. 

You can repeat this command as often as you need.
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You need to measure more features to completely reverse engineer this part; 
however, not all of them are free-form surfaces that you measure with the 
Polyline Group command. You should be able to see planes, circles, round 
slots, etc. that you measure using simple feature commands. 

Measure back 7.	
face

On the Measure menu, select Plane. Measure the 
back face of the bracket part.

Measure the 8.	
hole

On the Measure menu, select Circle. 

Change the Measure Mode to Single Point. Measure 
one, or all, of the circles on the back face of the 
bracket part.

If you prefer, continue measuring the remaining features on the bracket part.

Save As9.	 From the File menu, select Save As.
Your folder10.	 Browse to your folder and type RE_Bracket.fcd.
Save11.	 Click Save.
Export file12.	 From the File menu, select Export, Measurement 

Data, To CAD File.
Export Wizard13.	 In the Export CAD wizard, select and move all the 

features you created ( - Actual) to the right window.  

Click Next.
Export Format: IGES

Export Unit: Millimeter

Click Next.
Click the Browse button

Browse to your folder and type RE_Bracket.igs.

Click Save.
Close the Wizard14.	 Click Finish.
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Module 13: 
Data Import/Export

In this module, you will become familiar with exporting your measurement results to 
different file formats, and importing a data file into a measurement file.  

Prerequisite: Review Activities.

Module XX Objectives
You will be able to:

Locate the different import and export optionszz
Export/Import Points to a text filezz
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PRE-ACTIVITY:

Option 1
If training files are available

Option 2
If starting with a new file

Open Nominals 2.fcd Open a new file

Add and measure/construct features. 
Add/associate their nominals:

Plane 1zz
2D Line 1 (across the front of the zz
part on the handle side)
Circle 1zz
Circle 3zz
Circle 5zz
Circle 7zz
Cylinder 9zz
Bolt Circlezz
Intersection Point (of Plane 1 and zz
Cylinder 9)
Coordinate System using:zz

Plane 1zz
Line 1zz
Bolt Circlezz
Align to Worldzz
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ACTIVITY: Export Features To Saved Files

In this activity, we will export some actual (measured) points, nominal points, and all 
other features to three separate .txt file. 

Access the 1.	
Export Point 
Data Wizard

On the File menu, click Export, then select Points. The 
Export Point Data wizard appears.

Select features2.	 Select all of the “- Actuals” features, and move them 
to the right side of the wizard window by clicking the 
single arrow button. Then click Next.

Export 3.	
configuration

Take note of the current Export Configuration options, 
column order, and separators. Click Next.

The export configuration information is important to ensure you import the 
points properly.

Export file name4.	 Click Browse. Select your file folder. Name the file 
Actuals.txt and click Save. Click Finish.

The text file saves to the computer and automatically opens in Notepad. 

Close Notepad5.	 Click the Close button (X) in the upper right corner of 
the Notepad window.

Access the 6.	
Export Point 
Data Wizard

On the File menu, click Export, then select Points.  The 
Export Point Data wizard appears.

Select features7.	 Select all of the “- Nominal” features, add move them 
to the right side of the wizard window by clicking the 
single arrow button.  Then click Next.

Export 8.	
configuration

Take note of the current Export Configuration options, 
column order, and separators. Click Next.

The export configuration information is important to ensure you import the 
points properly.

Export file name9.	 Click Browse. Select your file folder. Name the file 
Nominals.txt and click Save. Click Finish.

The text file saves to the computer and automatically opens in Notepad. 

Close Notepad10.	 Click the Close button (X) in the upper right corner of 
the Notepad window.

Access the 11.	
Export Point 
Data Wizard

On the File menu, click Export, then select Points.  The 
Export Point Data wizard appears.

Select features12.	 Move all of the features to the right side of the wizard 
window by clicking the Select All button.  Then click 
Next.
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Export 13.	
configuration

Take note of the current Export Configuration options, 
column order, and separators. Click Next.

The export configuration information is important to ensure you import the 
points properly.

Export file name14.	 Click Browse. Select your file folder. Name the file 
Features.txt and click Save. Click Finish.

The text file saves to the computer and automatically opens in Notepad. 

Close Notepad15.	 Click the Close button (X) in the upper right corner of 
the Notepad window.

Save your file 16.	
with a new 
name

On the File menu, click Save As.

Enter Data Export.fcd as the file name.

ACTIVITY: Import Points From A Saved File

In this activity, we will import some nominal points from a .txt file.  

New File1.	 On the File menu, click New.

Access the 2.	
Import Point 
Data Wizard

On the File menu, click Import, then select Points. The 
Import Point Data wizard appears.

Select file3.	 Click Browse and locate Features.txt, select the file 
click Open. Click Next to continue.

Import 4.	
Configuration

Make sure that Import Configuration is the same as 
the Export Configuration and click Next.

Select features5.	 Select all of the “- Nominal” features and click the 
single arrow button to move the features to the right 
side of the wizard window. 

Select the Import as nominal option. 
Import the 6.	
Points

Click Finish.

The nominal information from the text file imports directly to features and adds to your 
measurement file.  Now you are ready to measure coordinate system features and add 
measurements to these nominal features.
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Module 14: 
Iterative Alignment Using Surfaces

In this module, you will become familiar with creating an Iterative Alignment using 
surface point measurements and nominal surfaces. 

Prerequisite: Iterative Alignments.

Module XX Objectives
You will be able to:

Create specific Nominal points on a CAD surface for use in an alignment.zz
Measure and remeasure the surfaces of the part to  refine the results of an alignment. zz
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Using Surfaces Instead Of Features

If your part has fewer than three point-reducible features, you will likely have 
enough nominal CAD surface data in a CAD model to create an alignment. 
Use Surface Point measurements and CAD surface data to align the part with 
your measurement device.

Previously, you used point-reducible features with associated nominals 
to create an iterative alignment. These measured features were the same 
geometry type as the nominal features (circles, slots, spheres, etc.). Now, 
instead of a point-reducible feature, we will use a surface point measurement 
feature and a nominal surface feature to create a best fit iterative alignment.

ACTIVITY: Performing An Alignment Using Surfaces

In this activity, we will perform an alignment by picking nominals from CAD and 
associating them to nominal surfaces. 

New file1.	 Open a new file.
Import CAD2.	 From \CAM2 Q v1.5 Training Files, import 

Demo Part Q.x_t.
Define nominals3.	 On the Pick from CAD menu, click Vector Point.
Points on the 4.	
top of the CAD

Click on the top of the CAD model surface near P1. 
Click three more points near P2, P3 and P4.

Points on the 5.	
left of the CAD

Click on the left side of the CAD model surface near 
Circle 11. Click one more point on the left side.

Points on the 6.	
front of the CAD

Click on the front of the CAD model surface to the 
right of Arc G. Click Close.

Select the 7.	
features

In the Features panel, select the vector point features.

Add 8.	
measurements

Right-click and select Add Measurement.

Measure the 9.	
surfaces

Measure the surfaces with a single reading for each 
vector point as shown in the Measurement Window 
panel. Place the probe on the correct surface in the 
general area of the nominal point.

Select the 10.	
vector point 
features

In the Features panel, select all vector points.

Align to the part11.	 On the Alignments menu, click Iterative Alignment. 
Click the Add Selection button to add the vector 
points.
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Set Weights12.	 Select the Set Weights check box to set the vector 
direction for each point.

Notice that each weight value automatically 
corresponds to the location of each point on the 
surface. For example, the weight values for Vector 
Points 1-4 are 0,0,1 and control the Z axis of the 
alignment. 

Solve13.	 Click the Apply/Solve button. 

Note the high value of the Max Error, or the error between the measured 
points, and the nominal surfaces. Now we will remeasure the vector points 
and automatically refine the alignment, with the goal of improving it by 
reducing the Max Error. 

Close14.	 Click the Close button.
Select the 15.	
features

In the Features panel, select all vector points.

Remeasure the 16.	
surfaces

From the Measure menu, click Remeasure.

Inspect vector 17.	
point

You now see the nominal point, the Home In Zone and 
the current position of your probe.

Move the probe to find the nominal point on the top 
surface of the part. Watch the screen and listen to the 
sound to help determine if you are in the Home In 
Zone. 

When you are in the Home In Zone, click the Front 
button (or the G key) to take a point, then pull away 
from the surface and click the Back button (or the H 
key).

Reset the view18.	 Press the E hotkey to Zoom All, and 8 to set the 
Isometric view. 

Check the 19.	
alignment

Press the A hot key and review the Max Error value - 
it should be lower than before. If it is, you have just 
improved your alignment by remeasuring the surfaces 
while being guided to the exact nominal surface 
location.

Click Close.
Save20.	 On the File menu, click Save As.

 Name the file Iterative2.fcd.
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Module 15: 
Tool Building

In this module, you will become familiar with using your measurement device to 
properly position a part in an assembly. 

Prerequisite: none.

Module XX Objectives
You will be able to:

Use the Feature Window to position a part correctly in space relative to another CAD zz
surface.
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PRE-ACTIVITY:

Option 1
If training files are available

Option 2
If starting with a new file

Open Advanced 2.fcd Open a new file

Select all of the features, then 
select Add Readings.

Measure the features.

Import zz Demo Part Q.x_t

Add and measure:
Plane 1zz
2D Line 1 (across the front of the zz
part on the handle side)
Circle 9zz

ACTIVITY: Positioning The Bracket

In this activity, you will accurately position the bracket relative to the part and verify the 
accuracy with part measurements.

Construct a 1.	
measured 
coordinate 
system

On the Coordinate Systems menu, click Create Using 
the Wizard.  

Select Plane 1 as the Plane Feature.

Select Line 1 as the Line Feature.

Select Circle 9 as the Point Feature.

Check the Align with: World box.

Click OK

Feature Window - Digital ReadOut

In addition to the Measurement Window panel that includes a Digital 
ReadOut (DRO) for the current measurement, CAM2 Q also has a Feature 
window that shows the distance of the Probe/SMR to a specific feature. Use a 
Feature window to: 

See the live deviations of a specific feature based on the current location zz
of the Probe/SMR. 
Guide a part into position using the position of a feature. zz

You can have multiple Feature windows open in a measurement file, or a 
single window which shows the distance values for the closest feature. The 
values in the Feature window change color based on tolerances. You can also 
show/hide the individual values of the DRO to view only the important values 
of your feature.  
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Position the 2.	
bracket

Position the bracket on the demo part, slot side down 
and lightly fasten it using the set screws.

Key-In Point3.	 On the Key-In menu, select Point. Type in the 
following values:

x:  -50.85mm - FaroArm
x:  -50.85mm - FARO Laser Tracker

y:  -40.64mm - FaroArm
y:  -40.64mm - FARO Laser Tracker

z: 13.26mm - FaroArm
z: 8.20mm - FARO Laser Tracker (1.5” SMR)
z: 16.12mm - FARO Laser Tracker (0.875” SMR)

Key-In Point4.	 On the Key-In menu, select Point. Type in the 
following values:

x:  50.85mm - FaroArm
x:  50.85mm - FARO Laser Tracker

y:  -40.64mm - FaroArm
y:  -40.64mm - FARO Laser Tracker

z: 13.26mm - FaroArm
z: 8.20mm - FARO Laser Tracker (1.5” SMR)
z: 16.12mm - FARO Laser Tracker (0.875” SMR)

Feature Window 5.	
for Point 1

On the Features panel, select Point 1, then from the 
View menu select Show Feature Window.

You can also press the ☛☛ D hot key.
Tolerance tab6.	 With Point 1 still selected on the Features panel, click 

the Feature Information tab.

Change all of the Lower and Upper tolerances to 
-0.500mm and 0.500mm.

Place Probe/7.	
SMR

Place the Probe/SMR on the bracket’s left-front set 
screw.

For the next step, you want the d3D and X,Z,Y values in the Feature window 
DRO to be green and as close to 0.00 as you can get them. You will now 
compare the numbers to the nominal position you specified when keying in 
the point.

Move bracket8.	 If necessary, move the bracket until the numbers are 
close to 0.00 and green.

Feature Window 9.	
for Point 2

On the Features panel, select Point 2, then press the 
D hot key.

You will need to move this second window if it opens ☛☛
on top of the first window.
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Feature 10.	
Information tab

With Point 2 still selected on the Features panel, click 
the Feature Information tab.

Change all of the Lower and Upper tolerances to 
-0.500mm and 0.500mm.

Place Probe/11.	
SMR

Place the Probe/SMR on the bracket’s right-front set 
screw.

Move bracket12.	 If necessary, move the bracket until the numbers are 
close to 0.00 and green.

Move back to Point 1, recheck the position, and adjust if necessary. Then 
recheck Point 2. Keep rechecking each point until you move the bracket part 
into the correct position. 

Close 13.	 Feature 
window

Close the Point 1 - Nominal Feature window.

Unlock from 14.	
Feature

Click the Lock to Feature (slanted push pin) button to 
unlock the Feature window from Point 2.

Recheck both 15.	
points

Move the Probe/SMR to each point and recheck the 
values. Notice that the Feature window automatically 
shows the values of the feature closest to the Probe/
SMR. 

ACTIVITY: Save The Measurement File

In this activity, you will save your work in the measurement file.

Save As1.	 From the File menu, select Save As.
Your folder2.	 Browse to your folder and type  

Tool Building.fcd.
Save3.	 Click Save.
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Module 16: 
Coordinate Systems Using Offset and 
Rotation

In this module, you will become familiar with constructing coordinate systems using 
advanced techniques. 

Prerequisite: Coordinate Systems.

Module XX Objectives
You will be able to:

Establish an XYZ coordinate system on a part that reflects the values on the blueprint zz

or CAD model.
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Rotations and Offsets

An inspection drawing with datum geometries usually requires a coordinate 
system alignment in which the part coordinate system is created using the 
measured datum features and aligned to the assembly (World coordinate 
system). The assembly coordinate system must be in the location defined by 
the datum features to correctly align the part to the assembly. 

For example, you have a part that has its own coordinate system and you 
need to report the measurement results of the part in the coordinate system 
of the assembly. After you select the features for a coordinate system, you can 
enter Rotation and Offset values. This creates the part coordinate system and 
then automatically moves and/or rotates that coordinate system to match 
the assembly coordinate system. 

 ##
When you select both Offset and 

Rotation, you can also select whether 

to offset or rotate first.

ACTIVITY: Create And Offset A Coordinate System

In this activity, you will create a measured coordinate system and offset it from the part’s 
origin.

New file1.	 Open a new file.
Import CAD2.	 Import the Demo Part Q.x_t CAD file.
Measure3.	  or 
Template mode

Choose either Measure or Template mode.

Remember that in ☛☛ Measure mode the 
Add Readings command is automatically started 
after you add a feature from the Measure menu. In 
Template mode, you will need to select the features 
and then start the Add Readings command.

Add Features4.	 On the Measure menu, click Plane, 2D Line, and 
Circle. 

Add Readings5.	 Measure and rename the features as Plane 1, Line 1 
and Circle 9.

Construct a 6.	
measured 
coordinate 
system

On the Coordinate Systems menu, click Create Using 
the Wizard. On the Basic tab:

Select zz Plane 1 as the Plane Feature.
Select zz Line 1 as the Line Feature.
Select zz Circle 9 as the Point Feature.

Clear the Align with: check box.
Add offset7.	 Select the Offset check box and enter -150 for X,  

-65 for Y, and 0 for Z.
Create the 8.	
coordinate 
system

Click OK.

  
Hot Keys
F3: Plane
F4: 2D Line
F10: Circle 

   
You can also 

press the C hot 

key to start the 

Coordinate System 

Wizard. 
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Labels9.	 On the Features panel, select World and 
Coordinate System 1. Right-click and select Label to 
show their labels in the Main Window.

Zoom Out and look at the Coordinate System 1 icon to see that is not in the 
center of Circle 9. 

Alignment to 10.	
the part

On the Alignments menu, click Coordinate System 
Alignment. 

Select zz Coordinate System 1 as the Measured 
Coordinate System.
Select zz World as the Nominal Coordinate System.

Click Apply/Solve.

Click Close.

Notice that Coordinate System 1 and World are now aligned, origin to 
origin.  

   
You can also 

press the A hot 

key to start the 

Alignments 

command and 

then click the 

Coordinate System 

button. 

ACTIVITY: Create And Rotate A Coordinate System

In this activity, you will create a new coordinate system and apply rotation.

Construct a 1.	
measured 
coordinate 
system

Press the C hot key.  

Select zz Plane 1 as the Plane Feature.
Select zz Line 1 as the Line Feature.
Select zz Circle 9 as the Point Feature.

Clear the Align with: check box.
Add rotation2.	 Check the Rotation check box and enter 0 for  X, 0 for  

Y, and 90 for Z.
Create the 3.	
coordinate 
system

Click OK.

Zoom Out and look at the Coordinate System 2 icon to see that is rotated 
around the center of Circle 9 (upper-right corner of the part). 

Alignment to 4.	
the part

On the Alignments menu, click Coordinate System 
Alignment. 

Select zz Coordinate System 2 as the Measured 
Coordinate System.
Select zz World as the Nominal Coordinate System.

Click Apply/Solve.

Click Close.
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ACTIVITY: Create An Offset And Rotated Coordinate System

In this activity, you will create a new offset coordinate system and apply rotation.

Construct a 1.	
measured 
coordinate 
system

Press the C hot key.  

Select zz Plane 1 as the Plane Feature.
Select zz Line 1 as the Line Feature.
Select zz Circle 9 as the Point Feature.

Clear the Align with: check box.
Add offset2.	 Select the Offset check box and enter -0 for X,  

70 for Y, and 0 for Z.
Add rotation3.	 Check the Rotation check box and enter 90 for X, 0 

for Y, and 0 for Z.
Create the 4.	
coordinate 
system

Select the Rotate then Offset option button.

Click OK.

Alignment to 5.	
the part

On the Alignments menu, click Coordinate System 
Alignment. 

Select zz Coordinate System 3 as the Measured 
Coordinate System.
Select zz World as the Nominal Coordinate System.

Click Apply/Solve.

Click Close.

Zoom Out and look at the Coordinate System 3 icon to see that is rotated 
and offset.  
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Module 17: 
GD&T

In this module, you will become familiar with inspecting your part using the Geometric 
Dimensioning and Tolerancing (GD&T) system. 

Prerequisite: Basic Measurement, Coordinate Systems, Nominals and Tolerances, 
Working with CAD modules.

Module XX Objectives
You will be able to:

Apply GD&T tolerances to check a part.zz
Assign datums and use them in specific GD&T tolerances.zz
Edit features to only report GD&T tolerance results. zz
Create a measurement report with GD&T tolerance results. zz
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GD&T in CAM2 Q

In CAM2 Q, you can add GD&T tolerance values to each feature to compare 
part measurements to one or more datum(s) and ensure that specific design 
and tolerance requirements are being met. 

Some GD&T tolerances, such as Orientation, Runout, and Position, require a 
datum, or a theoretically exact plane or line (axis) from which a dimensional 
measurement is made. Form and Profile GD&T tolerances do not require a 
datum because they use simple geometry for comparison. 

Some GD&T tolerances are only applicable to certain features; Therefore, the 
GD&T Tolerances panel only shows the available tolerances for a selected 
feature. The CAM2 Q help file details the steps to add GD&T tolerances to any 
feature.

When you add GD&T tolerances to features, other tolerance values are usually 
not necessary. In the Feature Information panel, you can clear, or not use, 
any unwanted tolerance value. 

ACTIVITY: Review GD&T Tolerances Help Topics

In this activity, we will review the GD&T tolerancing information contained in the CAM2 Q 
help file.  

New File1.	 On the File menu, click New.
Open the 2.	
CAM2 Q Help 
file

On the Help menu, click Contents. On the Contents 
tab, double-click the GD&T Tolerances topic.

Review GD&T 3.	
Tolerances

Review the GD&T Tolerances topic. To review the next 
topic, click on the Next (>) button at the top of the 
screen, or select another topic from the menu tree in 
the Contents tab. 

Notice the feature type in the first step of each topic, 
and whether a datum is required.

Close the 4.	
CAM2 Q Help 
file

Click the Close (X) button in the upper right corner of 
the CAM2 Q Help file.
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ACTIVITY: Establish Datums

In this activity, we will establish datums for use in GD&T calculations.  

New File1.	 On the File menu, click New.
Import CAD2.	 On the File menu, select Import, then select CAD. 
Select file3.	 From the \CAM2 Q v1.5 Training Files folder, select 

Demo Part Q.x_t. Click Open.
Measure4.	  or 
Template mode

Choose either Measure or Template mode.

Remember that in ☛☛ Measure mode the 
Add Readings command is automatically started 
after you add a feature from the Measure Menu. In 
Template mode, you will need to select the features 
and then start the Add Readings command.

Add Features5.	 On the Measure menu, click Plane, 2D Line, and 
Circle. 

Add Readings6.	 Measure and rename the features as Plane 1, Line 1 
and Circle 9. 

Assign Datums7.	 Right-click zz Plane 1, mouse-over Assign a Datum, 
select Plane A.
Right-click zz Line 1, mouse-over Assign a Datum, 
select Line B.
Right-click zz Circle 9, mouse-over Assign a Datum, 
select Plane C.

Construct a 8.	
measured 
coordinate 
system

On the Coordinate Systems menu, click Create Using 
the Wizard.  

Select zz Plane 1 as the Plane Feature.
Select zz Line 1 as the Line Feature.
Select zz Circle 9 as the Point Feature.

Select the Align with: check box.
Create the 9.	
coordinate 
system

Click OK.

Make   
sure to add the 

optimal, not the 

minimal, number 

of points for each 

feature.  Refer to  

Module 3, Lesson 1
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ACTIVITY: Determine Perpendicularity

In this activity, we will determine the perpendicularity of the left edge of the part to 
Datum B.  

Create and 1.	
Measure the left 
edge

On the Measure menu, click 2D Line. Measure the left 
edge of the part near Circle 11. Cancel the command.

Select the 2.	
feature

From the Features panel, select Line 2. 

GD&T Panel3.	 On the Edit menu, select GD&T... 
Create a new 4.	
GD&T tolerance

On the GD&T Tolerances panel, click the 

Perpendicularity icon  .
Tolerance to 5.	
Datum B 

Click in the right control frame and select B (Datum B).

ACTIVITY: Customize Labels

In this activity, we will review and customize the label options.

Hide Label1.	 On the Features panel, select Coordinate System 1. 
Right-click and clear the Label menu item to hide the 
label. 

Show Labels2.	 On the Features panel, select the plane, line, and 
circle. Right-click and select Label to show the 
feature’s simple label. Right-click again and select 
Detailed Label to show the feature’s detailed label. 

Select Feature3.	 On the Features panel, select Plane 1. 
Hide tolerances4.	 On the Feature Information panel, clear the check 

boxes in the first column for every value except 
Flatness. 

Select Feature5.	 On the Features panel, select Line 1. 
Hide tolerances6.	 On the Feature Information panel, clear the check 

boxes in the first column for every value except 
Straightness. 

Select Feature7.	 On the Features panel, select Circle 9. 
Hide tolerances8.	 On the Feature Information panel, clear the check 

boxes in the first column for every value except 
Diameter and Circularity. 

Preferences9.	  
command

On the Edit menu, select Preferences. Select Display 
and the CAD View tab. In the Label Style drop-down, 
select Show Detailed Label Only.  Click OK.
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For the remainder of this module, you will be using the GD&T Tolerances 
panel often. You may find it helpful to dock it to one of the Main window 
edges, or just close it and reopen it when you need it.  

Hide tolerances6.	 On the Feature Information panel, clear the check 
boxes in the first column for every value except 
Perpendicularity. 

ACTIVITY: Determine Parallelism

In this activity, we will determine the parallelism of the back edge of the part to Datum B.  

Create and 1.	
Measure the 
back edge

On the Measure menu, click 2D Line. Measure the 
back edge of the part. Cancel the command.

Select the 2.	
feature

From the Features panel, select Line 3.

Create a new 3.	
GD&T tolerance

On the GD&T Tolerances panel, click the 

Parallelism icon  .
Tolerance to 4.	
Datum B 

Click in the right control frame and select B (Datum B).

Adjust tolerance 5.	
values

On the Feature Information panel, clear the check 
boxes in the first column for every value except 
Parallelism. 

ACTIVITY: Determine Position

In this activity, we will determine the position of Circles 1, 3, 5, 7.  

Create and 1.	
Measure Circle 1

On the Measure menu, click Circle. Rename and 
measure Circle 1. Cancel the command. 

Select the 2.	
feature

From the Features panel, select Circle 1.

Create a new 3.	
GD&T tolerance

On the GD&T Tolerances panel, click the Position icon 

.
Material 4.	
Condition

Click in the far right control frame and select RFS.

Repeat on 5.	
Circles 3, 5, 7

Repeat the above steps for Circles 3, 5, 7.

Select circles6.	 On the Features panel, select Circles 1, 3, 5, 7.
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Adjust tolerance 7.	
values

On the Feature Information panel, clear the check 
boxes in the first column for every value except 
Diameter and Position.  Scroll down the Feature 
Information panel to edit the information for all four 
circles. 

ACTIVITY: Configure a Measurement Mode

In this activity, we will set up the Measurement modes for the next few activities. 

Device Control 1.	
panel

Press the P hot key.

Settings2.	 Click the Measurement Mode Setting, or Settings, 
button.

Distance Based 3.	
Mode

Select the Distance Based Mode and change the 
distance to 0.50mm. Click OK. 

These are the available measurement modes:☛☛
Single Point Modezz : The measurement device takes a single point. 
Distance Interval Modezz : The measurement device takes points 
at a specified distance interval (specify the distance in the device 
settings). 
Time Interval Modezz : The measurement device takes points at a 
specified time interval (specify the time in milliseconds). 

Close Device 4.	
Control Panel

Click the Close (X) button in the upper right corner of 
the Device Control panel. 
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ACTIVITY: Determine Profile of a Line

In this activity, we will determine the profile of a line, or curve.  

Measure a plane1.	 On the Measure menu, click Plane. 

Notice the ☛☛ Mode is set to now Distance Interval and 
the Distance is 0.500mm. You can change the mode 
back to single point before measuring, or “scan” the 
plane with these settings. 

Measure the plane perpendicular to G as Plane 1. 
Cancel the command. 

Create 2.	
Polyline 1

On the Measure menu, click Other, click Polyline.

Select the 2D Plane check box, and select 
Plane 2 - Actual from the drop-down list. 

Minimum Scan Distance: 0.50mm

Auto Nominal Max Distance: 1.00mm

Maximum Scan Distance: 5.0mm

Probe Compensation: Use Sampled End Click

Type: Free Hand

Measure on CAD Side: Selected

Select Surface: CAD Assembly

Click Create and Close.
Measure the 3.	
surface with a 
single line

Make sure that the Measurement Mode is set to 
Distance Interval.

Touch the Probe/SMR to curved surface “G”, press the 
Front button, or G key, and “scan” a single line on the 
curved surface from left to right.  

Select the 4.	
feature

From the Features panel, select Polyline 1.

Create a new 5.	
GD&T tolerance

On the GD&T Tolerances panel, click the Profile of a 

Line icon  .
Adjust tolerance 6.	
values

On the Feature Information panel, clear the check 
boxes in the first column for every value except Line 
Profile. 
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ACTIVITY: Creating A Report

In this activity, we will create a measurement report and save it to a .csv file.

Select Features1.	 On the Features panel, select the three datums, the 
two lines, the four circles, and the polyline.

Access Report 2.	
view

Click the Report tab.

Tabular layout3.	 At the bottom of the Report window, select Tabular 
from the drop-down list.

View results4.	 Use the scroll bar or the page navigation icons to view 
each page of the report, and see the measurement 
results in the GD&T format. 

ACTIVITY: Save The Measurement File

In this activity, you will save your work in the measurement file.

Save As1.	 From the File menu, select Save As.
Your folder2.	 Browse to your folder and type GD&T.fcd.

Save3.	 Click Save.
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Module 18: 
Using Multiple Devices

In this module, you will become familiar with inspecting a part using more than one 
measurement device. 

Prerequisite: Basic Measurement, Move Device modules.

Module XX Objectives
You will be able to:

Properly connect to and switch between multiple deviceszz
Add readings using multiple deviceszz



1 8 . 2

M
o

d
u

l
e

 
1

8
:

U
s

i
n

g
 

M
u

l
t

i
p

l
e

 
D

e
v

i
c

e
s 

You can connect and use multiple measurement devices simultaneously, with 
a single software license, without changing computers and merging data. 
You can connect any combination of FaroArms and/or FARO Laser Trackers. 

This procedure to connect and define multiple devices involves measuring a 
set of point-reducible features with each device, assigning features from the 
second device as nominals to the features from the first, and then using the 
Move Device command to define the position. 

ACTIVITY: Configuring Two Devices

In this activity, we will connect two FaroArms and measure with both of them.

New file1.	 On the File menu, select New. 
Review Help2.	 Press the F1 hot key. Click on the Index tab. Type 

multiple devices in the Type in the keyword to 
find box. Double-click multiple devices from the list. 
Review the procedure for using multiple devices.

If you are using two FARO Laser Trackers, you must ☛☛
assign two additional hot keys for the second Laser 
Tracker. These new keys will function the same as the 
G and H keys since G and H are currently assigned to 
the first device.  

After you locate the point-reducible features that you want to use, ensure 
that each device can reach each feature.

Connect both 3.	
devices

Connect all cables for each devices to your computer, 
power on your devices and computer, and start 
CAM2 Q.  

You may have to open the Device Control Panel 
and manually connect any device that has not 
automatically loaded.

Manage both 4.	
devices

On the Device menu, select Device Manager. If the 
second device is not in the Devices/Positions window, 
click the Add button and select the second device 
from the Serial Number drop-down list.

Select the first device and rename it zz Device 1.

Select the second device and rename it zz Device 2.

Click Close to exit the Device Manager dialog box. 
Measure 5.	
features with 
Device 1

Measure four points, one plane, and one circle. Use 
Device 1 to measure each feature.
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Measure 6.	
features with 
Device 2

On the Features panel, select all six features.

Right-click and select Add Readings From, Select 
Device 2.

Measure the features with Device 2.
Solve Device 7.	
Positions

From the zz Device menu, select Device Manager. 
The Device Manager panel opens and displays all 
of the connected devices. 

In the zz Devices/Positions window, select Device 2’s 
Device Position 1.

Click the zz Add Features button to add all of the 
features to this dialog box. 

Click the zz Solve button. CAM2 Q fits the two device 
positions together and reports the fit error. Look 
at the fit error (Error) for each feature and the 
maximum error (Max Error) for the results.  

When you are analyze the fit error and the maximum error, both of these 
numbers should be within you part’s fit tolerance. If necessary, you can 
remeasure any of the features with Device 2 directly from this dialog 
box. Select individual features and click the Remeasure Selected or the 
Remeasure All button. 

Special Conditions with Multiple Devices

When you have multiple devices connected to CAM2 Q, there are additional 
commands and options that are available.

Default Devicezz
In the Device Manager panel, select a device and click the Make 
Default button. Measurement commands and the Add Readings 
command will always use the default device. 

Add Readings Fromzz
On the Features panel, right-click a feature. The Add Readings 
From command will now list all available devices. 

QuickTool command propertieszz
Each QuickTool command can be assigned to a any device. On the 
QuickTools panel, select a command and then in the Basic tab 
of the Properties section choose a device from the Device drop-
down. When playing the QuickTool, the first command for each 
device is started and multiple Measurement windows open. 
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Appendix I: 
Laser Tracker Device Setup Checklist

Temperature Effect On A Part

Part has been allowed to soak in the inspection environment to adjust to the ❐❐

air temperature.

Measurements will be taken where the air temperature is relatively constant.❐❐

Software is set to appropriately adjust for part expansion/contraction (see ❐❐

software user guide). 

The part is evenly exposed to light.❐❐

Measurements are being taken away from heating/ventilation ducts or any ❐❐

other potential source of air turbulence.

Temperature Effect On The Device 

The device temperature has been allowed to stabilize.

Movement

The device and part are fastened and stationary.❐❐

Vibration Effects

Vibrations (forklifts driving by, stamping machine movement etc.) have been ❐❐

avoided.

Mounting Stability

Detailed instructions provided with mount (tripod, magnetic) were carefully ❐❐

followed.

If mounting the device horizontally, the side mounting bracket has been used.❐❐

The part being measured is supported in the same manner as it would be in its ❐❐

intended function.
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Appendix II: 
Hot Keys

The following is a list of Hot Keys, or keyboard shortcuts, that you can use to quickly 
start some CAM2 Q commands.

Hot Key Function

Enter Repeat the Last command

Arrow keys 
2,4,6,8 on numeric keypad

Pans the view in the specified direction. 

F1 Help

F2 Measuring a Point

F3 Measuring a Plane

F4 Measuring a 2D Line

F5 Measuring an Inspect Surface

F10 Measuring a Circle

F11 Measuring a Cylinder

F12 Measuring a Sphere

Insert Add Readings

G Record a Measurement Reading

H Record an End Click Reading

Backspace Delete the Last Measurement Reading

SHIFT + A Measure All

SHIFT + R Remeasure

Alt + Enter Edit Properties

4 Front View 

5 Side View 

6 Top View 

7 Isometric View SE
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Hot Key Function

8 Isometric View SW

9 Isometric View NE

0 Isometric View NW

I 
Plus Sign (+) on numeric keypad

Zoom In

CTRL + = Zoom In (Fine)

O 
Minus Sign (-) on numeric keypad

Zoom Out

CTRL + - Zoom Out (Fine)

E Zoom All

W Zoom To Window

7 on numeric keypad Rotate Around X Counterclockwise

9 on numeric keypad Rotate Around X Clockwise

1 on numeric keypad Rotate Around Y Counterclockwise

3 on numeric keypad Rotate Around Y Clockwise

0 on numeric keypad Rotate Around Z Counterclockwise

Period (.) on numeric keypad Rotate Around Z Clockwise

S Switch between the three shaded and 
wireframe views

Shift + Alt + Enter Full Screen

Number Sign (#) Grid

R Reset View

L Arrange Labels

ESC Cancels the Current Measurement

SHIFT + R Mouse 
Mouse Wheel

Dynamic Zoom

R Mouse Dynamic Pan

L Mouse Dynamic Rotate

ESC Cancels the Current Measurement
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Hot Key Function

P Device Control Panel

D Show Feature Window

A Create and Edit Alignments

C Coordinate System

M Move Device

Delete Delete any selected item

Enter Repeat Last Command

Home Home (Tracker Only)

T Motor On Off (Tracker Only)

B Set Backsight (Tracker Only)

V Drive Beam (Tracker Only)

CRTL + N New file

CRTL + O Open file

CRTL + S Save file

ALT + F4 Exit CAM2 Q
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Appendix III: 
Glossary of Terms
TERM FARO Definition

3D Three dimensional

3D distance The distance between a nominal feature's center and a 
measured/constructed feature's center.

3D dynamic Refers to the rotation of a computer model of a part in virtual 
space.

3D image The three dimensional representation of an object

3D modeling The creation of a three dimensional mathematical model of an 
object; typically performed using digitizing devices.

3D surface The three dimensional representation of the boundary of a 
region in space

A

Accuracy The deviation between the measured value and the nominal or 
actual value. 

Actual A feature or measurement that exists and is not merely potential 
or theoretical.

Alignment The establishing of a coordinate system on a part, typically in 
reference to a coordinate measurement machine.

Angle The figure defined by two lines extending from the same point

Apex In reference to an angle, the point from which the two lines of 
the angle emanate. Vertex.

Arc A segment of a circle

B

Basic Measurement 
Strategy, CAM2 Q

Look at what you need to measure and consider the zz
following questions:
What should you include in the formal Report?zz
Which features (geometric elements) do you need to zz
capture?
Which features can you Measure directly (i.e. planes, circles, zz
cylinders, lines, etc)?
Which features do you need to Construct (e.g. bolt hole zz
circle) 
Which Dimensions do you need? (e.g. circle center to circle zz
center)
What logical sequence should you use to move around the zz
part and capture the features? For example, left to right, top 
to bottom, or measure all planes first, then circles, etc.
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TERM FARO Definition

Best fit Creating a feature that fits a set of points so each point is the 
shortest distance to the feature.

Bisect To divide into two equal parts

Bisector A feature (line or plane) which is created and equidistant at all 
points from two existing features.

Bolt hole pattern A group of holes which is intended to accept bolts from a 
mating part in an assembly.

Button Refers to the switches on the FaroArm

C
CAD Computer-Aided Design

CAD/CAM
CAD refers to computer-aided design. CAM refers to computer 
aided modeling. Some software packages perform both 
functions and are referred to as CAD/CAM.

CAE Computer-Aided Engineering

Calibration

The procedure by which the FaroArm is optimized to perform 
accurate measurements. Thousands of data points are captured 
to determine the true geometry and kinematics of each 
FaroArm. This electronic “finger print” is stored on a chip in the 
base of the device.

CAMM (CAM2) Computer-Aided Manufacturing Measurement

Capture (of data) Digitizing. Storing data points in the computer system.

Circle A closed planar curve in which every point on the curve is 
equidistant from the center.

Circularity The quantity that refers to the fit of the input data points to the 
resultant circle.

CMM Coordinate Measuring Machine

Coincident Points Points that have the same XYZ value.

Collinear Data points which lie on the same line.

Compensated 
points

Refers to the compensation for the radius of the ball probe on 
the FaroArm.

Computer aided 
design (CAD)

Software which replaces or augments manual drafting and 
design. Allows parts to be designed using computer software, 
and stored in an electronic database.

Cone A basic or prismatic feature defined as a region generated by 
revolving a right triangle about one of its legs.

Conicity The deviation of measured data points from the resultant cone.

Construction A feature developed from measured features



08m13e15 - CAM2 Q v1.5 - FARO Laser Tracker Training Workbook - October 2010.pdf  Part# 12053-001

I I I . 3

A
p

p
e

n
d

i
x

 
I

I
I

:
G

l
o

s
s

a
r

y
 

o
f

 
T

e
r

m
s 

TERM FARO Definition

Coordinate 
Measuring Machine

CMM. These machines capture 3D data from objects to give the 
position (XYZ) of the object.

Coordinate System
A system of representing points in a space of given dimensions 
by coordinates, such as the Cartesian coordinate system or the 
system of celestial longitude and latitude.

Coplanar Points or features which lie in the same geometric plane.

Corner The point resulting from the intersection of three planes.

Counter-balance
The internal system which supports the weight of the FaroArm 
allowing for greater operator control and reduced operator 
fatigue.

Curvature The deviation of a feature from a straight line.

Curvature change The change in the slope of a curved feature.

Custom probes
Probes other than those that are supplied with the FaroArm as 
a standard. Customers can manufacture their own probes, and 
calibrate them using the 1” reference sphere.

Cylinder A geometric feature formed by extruding a circle along its 
centerline in a direction normal to its plane.

Cylindrical A part which is similar to a cylinder in shape.

Cylindricity The deviation of measured data points from the resultant 
cylinder.

D 

Datum

A datum (plural datums or data) is a reference from which 
measurements are made. In engineering and drafting, a datum 
is a reference point, surface, or axis on an object against which 
measurements are made.

Datum Coordinate The XYZ values of a feature used to establish an alignment.

Degrees of 
Freedom (DOF)  

The FaroArm is termed to have 6 or 7 degrees of freedom. Each 
axis of rotation is defined as a degree of freedom.

Device
A piece of equipment or a mechanism designed to serve a 
special purpose or perform a special function. Measurement 
device; FaroArm or FARO Laser Tracker.

Dial indicator
Dial indicators are instruments used to accurately measure a 
small distance. They may also be known as a Dial Gauge, Dial 
Test Indicator (DTI), or as a “clock”.

Diameter The width of a circular of cylindrical featre.

Dimension The relationship (distance or angle) between two geometric 
features.

Dimensioning The function of determining the relationship between 
geometric features.
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TERM FARO Definition

Distance The degree of separation between geometric features.

Drawing The engineering documentation that indicates how a part is to 
be manufactured, assembled, or installed.

DRO Digital ReadOut. The display of XYZ coordinates on the screen.

E
Edge points Data points which lie on the edge or border of a part.

Elbow Refers to the joint of the FaroArm at the intersection of the two 
long tubes.

Ellipse A geometric feature resulting from the intersection of a plane 
with a cylinder at an angle other than 90 degrees.

End Click To accept collected readings by either clicking the FaroArm 
BACK button or for the Laser Tracker pressing the H hot key.

Entity A feature or object in a CAD database.

Evaluation / to 
evaluate

The review of a product or process for suitability for its intended 
purpose.

External shape The boundary which encloses a geometric form.

F
Fabrication 
drawing

An engineering drawing that specifies how a part is to be 
manufactured.

Feature Refers to an attribute of a product or a geometric object.

Fit How easily two mating parts can be assembled.

Flatness The deviation of the measured data points from the resultant 
plane.

Form
The maximum bandwidth (Max. Error added to the Min. Error) of 
error that a set of measured points deviates from the true form 
of the resultant feature calculated from that set of points.

G

GD&T
Geometric Dimensioning and Tolerancing. A system of 
specifying engineering design and drawing requirements with 
respect to actual function and relationship of part features.

Geometric features A shape that can be expressed using standard shapes i.e. circle, 
line, and arc.

H
Handle Refers to the pistol style handgrip of the FaroArm.

Hardware Refers to the mechanical portion of a computer-based system. 
Opposite of software.
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TERM FARO Definition

Hardware lock
Dongle or port lock. Provides software security using a 
computer chip that attaches to the parallel (printer) port on a 
computer.

Hot Keys One keystroke commands which invoke a software function.

I 
Inputting Refers to the keying in of data.

Intersection A meeting or crossing at a point.

Isometric A “3D” view of a part from a direction which is equiangular from 
each coordinate axis.

Iterative Alignment A means of aligning measured data to CAD data by best fitting 
through many iterations.

J

Joint The meeting place of two adjacent articulating units. Refers 
specifically to the transfer cases on the FaroArm.

K
Key-in To manually enter data using a keyboard.

Key-in alignment
The software function that creates a new coordinate system 
based upon translation and rotation relative to an existing 
coordinate system.

L
Layer A software tool used to group features and entities.

Line intersect A type of alignment based upon a plane and two lines.

Line-to-plane A type of angular dimension.

M
Max. (maximum) 
Error

The largest distance from a reading above or outside a best-fit 
feature. 

Maximum Material 
Condition

(MMC) Maximum material condition is that condition of a part 
feature wherein it contains the maximum amount of material 
within the stated limits of size. For a hole, the MMC is defined 
as the condition when the diameter is at the lowest end of its 
tolerance band. For a stud, the MMC is defined as the condition 
where the diameter is at the highest end of its tolerance band.

Measure To capture data points to determine the size, position, and form 
of feature.

Mid-Point A point which is equidistant from two other points.

Min. (minimum) 
Error

The largest distance from a reading below or inside a best-fit 
feature. 

MT Material Thickness
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TERM FARO Definition

N
NIST National Institute of Standards and Technology

Nominal The theoretical value for a feature.

Normal The vector which defines a direction perpendicular to a curve or 
surface at a specific point.

O

Off-line Any function which does not require a specific device to be 
connected.

Offset To create a feature that is equidistant by a specified distance at 
all points.

On-line A function which indicates that a specific device must be 
connected to perform a specific function.

Orientation

In reference to Geometric Dimensioning and Tolerancing, it 
is the type of dimension that pertains to the orientation of 
one feature relative to a datum feature. Such as Parallelism, 
Perpendicularity and Concentricity.

Origin The point from which the axes of a coordinate system emanate.

Orthogonal 
coordinates Coordinates which are perpendicular.

P

Pan In CAD, to change the position of the viewing window relative 
to the model.

Parallel Two lines or planes which are equidistant at all points.

Perpendicular 
intersect

A type of alignment which requires a plane, line and point, 
where the origin is defined at the projection of the point on to 
the line.

Plane A geometric feature defined by a point and a vector. A flat 
surface.

Plane-to-Plane
A type of distance dimension which yields the perpendicular 
distance between the centroid of the second plane and the first 
plane.

Point reducible 
feature

A feature that has a repeatable center point such as a circle or 
sphere.

Point-to-Line A dimension type which yields the perpendicular distance 
between the point and the line.

Point-to-Point A dimension type which yields the 3D distance between two 
points.

Polyline A multi-segmented line.

Position The location of a feature in a Cartesian coordinate system.
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TERM FARO Definition

Prismatic Taking the shape of a prism or 3 dimensional object whose faces 
are represented by regular geometric features.

Prismatic features A feature that can be represented by regular geometric shapes. 
The opposite of curves and surfaces.

Probe
End effector or stylus. The part of the FaroArm that touches the 
measurement piece. The FaroArm can use a variety of probes 
including hard probes, touch-trigger, and laser probes.

Probe 
compensation

The ability of the software to account for the radius of the 
probe. Gross errors can result if this is not done correctly.

Project to To reproduce in a prescribed direction.

Q, R
Readout The visual display of data on a computer screen.

Re-capturing In reference to digitizing, the re-measurement of erroneous data 
points.

Rectangular A polygonal shape whose corners intersect at right angles.

Repeatability

The ability of a device to obtain consistent results. Although 
the terms are generally used interchangeably, repeatability 
differs from accuracy in that a device can consistently obtain the 
wrong result. 

Resolution The number of decimal places that a measurement device can 
reliably display.

Reverse 
engineering

The creation of design or CAD data from an existing or 
prototype part.

Rotation Angular motion about a specified point or axis.

Roundness The deviation of the measured data points from the true form of 
the resultant circle.

S
Scanning To capture large quantities of data points quickly.

Slot An elongated hole with round or squared ends.

SMR Spherically Mounted Retroreflector

Solve, to To calculate the results of a problem.

Spherical A shape which is similar to that of a sphere.

Spherically 
Mounted 
Retroreflector 
(SMR)

The probe for the FARO Laser Tracker.

Sphericity The amount by which the measured data points deviate from 
the resultant sphere.
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TERM FARO Definition

Spline A smooth curve which cannot be represented by a simple 
mathematical function.

Straightness The amount by which the measured points deviate from the 
resultant line.

Stream A continuous input of data points.

Surface The outer boundary of an object.

Surface off-set An output surface that is equidistant from an input surface at all 
points.

Surfacing The technique of creating 3D models by defining the outer 
boundary of objects in virtual space.

T

Temperature 
Compensation

The ability of a measurement device to adjust to changes 
in ambient temperature. A measurement device that is 
temperature compensated will maintain its accuracy through 
a wide range of temperatures. A device that is not temperature 
compensated cannot.

Thread
A screw thread. A machined surface with a helical shape. 
Normally parts are fastened together with a screw and a 
threaded hole or a threaded bolt and nut.

Thread mount
A metal piece that is used as an interface between a mating 
thread and a tripod or a mating thread and a table mountable 
device.

Tolerance

A zone of accuracy in both size and placement of a feature. For 
example, a hole of a diameter of 1.00” +/- 0.01 located at the x, 
y, z of 1.000, 1.000, 0.000 +/- 0.005 means a 1 inch diameter hole 
can be between 1.01 and 0.99 in size and the location can be 
plus or minus 0.005 inches from the specified nominal location.

Touch trigger 
probes

An electro-mechanical device that has a hard ball probe on the 
end of a pivoting straight shaft. When any movement of shaft is 
sensed at the pivot, an electrical message is sent to command 
the CMM to take a data point.

Traditional CMM

There are many types of CMMs that fall into this category. These 
include the bridge type, cantilever type, gantry type, etc. These 
are floor-mounted machines that require you to bring the parts 
to the CMM, unlike FARO’s “portable” CMM, the FaroArm®.

True Position

Refers to a GD&T callout that specifies how a feature such as a 
hole is to be positioned on a part as well as toleranced. A true 
position callout may also specify additional tolerance or “bonus” 
if the hole is over-sized or if a shaft is under-sized (maximum or 
least material condition; MMC or LMC). 
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TERM FARO Definition

U

Unit Vector

A directional line with a non-dimensional magnitude of one. 
The line may be associated with the normal vector of a surface 
at a specific location. The vector is described in relation to the 
current alignment using the letters I, J, and K that are associated 
to X, Y, and Z.

USB

Universal Serial Bus (USB) is an external peripheral interface 
standard for communication between a computer and 
external peripherals over an inexpensive cable using biserial 
transmission. USB is intended to replace existing serial ports, 
parallel ports, keyboard, and monitor connectors and be used 
with keyboards, mice, monitors, printers, and possibly some 
low-speed scanners and removable hard drives.

V

Vector

A term used to describe the direction of a line or object that 
may or may not have a magnitude. The line may be associated 
with the normal vector of a surface at a specific location. The 
vector is described in relation to the current alignment using 
the letters I, J, and K that are associated to X, Y, and Z.

Vertex The point of intersection of two sides of an angle.

Volume The amount of space occupied in three dimensions.

W
Wrist Refers to the last grouping of joints on the end of the FaroArm.

X, Y

X, Y, Z Refers to the Cartesian Coordinate System for three-dimensional 
space.

Z

Zoom, to A command used to change the view of the design on the 
screen, specifically to show a closer view.
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Appendix IV: 
Technical Support

FARO Technologies, Inc. is committed to providing the best technical support to our 
customers. Our Service Policy is detailed in Appendix C: Industrial Products Service 
Policy of any FARO manual. If you have any problem using one of our products, please 
follow these steps before contacting our Technical Support Team:

Be sure to read the relevant sections of the documentation to find the help zz
you need.

Visit the FARO Customer Service area on the Web at www.faro.com to search zz
our technical support database. This is available 24 hours a day 7 days a week. 

Document the problem you are experiencing. Be as specific as you can. The zz
more information you have, the easier the problem will be to solve. 

If you still cannot resolve your problem, have your device’s Serial Number zz
available before calling.

Support Hours
North America:zz

8:00 a.m. to 8:00 p.m. Eastern Standard Time (EST).

Europe:zz
8:00 a.m. to 5:00 p.m. Central European Standard Time (CET).

Asia:zz
8:30 a.m. to 5:30 p.m. Singapore Standard Time (SST).

Japan:zz
9:00 a.m. to 5:00 p.m. Japan Standard Time (JST).

China:zz
8:30 a.m. to 5:30 p.m. China Standard Time (CST).

India:zz
9:30 a.m. to 5:30 p.m. India Standard Time (IST).

You can also e-mail or fax any problems or questions 24 hours a day.zz

Phone
North America:zz

800 736 2771, +1 407 333 3182 (Worldwide)

Europe:zz
+800 3276 7378, +49 7150 9797-400 (Worldwide)

Asia:zz
+65 6511 1350

Japan:zz
+81 561 63 1411
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China:zz
+86 21 6191 7600

India:zz
+91 11 4167 6330/1

Fax 

North America:zz
FaroArm +1 407 333 8056

Europe:zz
+800 3276 1737, +49 7150 9797-9400 (Worldwide)

Asia:zz
+65 6543 0111

Japan:zz
+81 561 63 1412

China:zz
+86 21 6494 8670

India:zz
+91 11 4167 6332

E-Mail
North America:zz

FaroArm support@faro.com

Europe:zz
support@faroeurope.com

Asia:zz
salesap@faro.com

Japan:zz
japan@faro.com

China:zz
chinainfo@faro.com

India:zz
infoindia@faro.com

E-Mails or Faxes sent outside regular working hours 

(8:00 a.m. to 5:00 p.m., Monday through Friday) usually are answered before 12:00 
p.m. the next working day. Should our staff be on other calls, please leave a voice 
mail message; calls are always returned within 4 hours. Please remember to leave a 
detailed description of your question and your device’s Serial Number. Do not forget to 
include your name, fax number, telephone number and extension so we can reach you 
promptly.
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For Technical Support

World Wide Web site: www.faro.com
E-mail: support@faro.com

Ph: 800.736.2771

For Sales Inquiries

Electronic Product Catalog on www.faro.com
E-mail: info@faro.com

Ph: 800.736.0234, extension 2265

For Training or Technical Services

World Wide Web site: www.faro.com
E-mail: training@faro.com

Ph: 800.736.0234, extension 1111

Contact Information
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